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GeneScan Analysis 
Software Overview 1

 

Introduction

 

In This Chapter

 

This chapter provides a general introduction to the ABI P

 

RISM

 

®

 

 
GeneScan

 

®

 

 Analysis Software. It provides information about the 
organization of this manual and instructions on how to get help from 
Applied Biosystems.

Topics in this chapter include the following:

 

Note

 

Already familiar with previous versions of the GeneScan Analysis 
Software and want to know what is new and different in this version? Turn to 
“What’s New in the GeneScan Analysis Software” on page 1-2.

 

Topic See page

 

What’s New in the GeneScan Analysis Software 1-2

About This Manual and Other Instruments 1-5

Using the Macintosh Computer 1-7

Registering the Software 1-11

Installing the Software 1-12

GeneScan Analysis Software Files 1-16

Technical Support 1-20
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What’s New in the GeneScan Analysis Software

 

BioLIMS Support

 

GeneScan Analysis Software version 3.1 supports the BioLIMS

 

™

 

 
Genetic Information Management System v. 2.0. In the BioLIMS mode, 
the GeneScan Analysis Software extracts sample data from gel files 
and writes it to the database. The contents of the gel file are not saved 
to the database.The GeneScan Analysis Software can read and write 
sequence-fragment to the database just as it writes sample files to the 
Macintosh

 

®

 

 hard disks.

Both Oracle

 

®

 

 and Sybase

 

®

 

 databases are supported.

For information about using the GeneScan Analysis Software in 
BioLIMS mode, see “Using the BioLIMS Database” on page E-1.

 

Fifth Dye

 

The GeneScan Analysis Software version 3.1 can display and analyze 
raw data from up to five dye colors. This feature has been implemented 
in the software to support future developments in the dye chemistries.

The current maximum number of dyes available is four. The availability 
of a fifth dye for the GeneScan Analysis Software is dependent on the 
progress made in the dye development chemistry and can not be 
accurately projected at this point. You can receive more information on 
the availability of additional dyes for the GeneScan Analysis Software 
when they become available through our web site (see “To Reach Us on 
the Web” on page 1-20).

 

Works with
96-Lane Gels

 

The GeneScan Analysis Software version 3.1 can open and analyze 
96-lane gels. For more information, refer to the 

 

ABI P

 

RISM

 

 377 DNA 
Sequencer 96-Lane Upgrade User’s Manual

 

 (P/N 4305423).
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Displaying
Off-Scale Data

 

A new feature has been added in version 3.1 to display offscale regions. 
By clicking the OS button on the tool bar when the gel image is 
displayed, if the gel contains offscale data, then this data appears as 
white bands on the gel image.Off-scale data can also be viewed while 
in Results Display by selecting Show Offscale Regions from the View 
menu.

 

Note

 

To see off-scale portions in the gel image, click the Vertical Expand 
button. The resolution of the full display is low and does not show the off-scale 
data.

 

Manual Tracker
Interface Changes

 

In version 3.1, the new tracker lines consist of control points. The new 
interface allows the selection and movement of multiple control points 
simultaneously, interpolation of tracker line shapes between two lanes, 
multiple lane selection, and movement.

 

Printing from
Sample File

Window

 

In version 2.1, only the electropherogram display is printed when 
printing from the Sample File window.

The following displays can now be printed also:

 

�

 

Sample Info View

 

�

 

Size Curve View

 

�

 

Raw Data View

 

�

 

EPT Data View

 

New Neural Net
Tracker

 

About the Neural Net Tracker

 

This was the most significant improvement in the version 3.1 release of 
GeneScan Analysis Software. 

 

�

 

The Neural Net Tracker program uses a neural net-based algorithm 
to automatically track gel lanes. The Neural Net Tracker has been 
taught how to recognize bands and how to track curved lanes.

 

IMPORTANT

 

Before auto-tracking the first time, you need to verify that the 
comb type is set correctly. The default comb type is Square.

 

�

 

The Neural Net Tracker program exists as a separate program 
within the GeneScan Analysis Software folder. Also associated with 
the Neural Net Tracker program are a set of Tracker settings files 
that have been optimized for number of lanes and comb-types. 
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�

 

The Neural Net Tracker program is “headless.” This means that 
although it stands as a separate program file, it does not have a 
user interface. The Tracker program is opened automatically from 
within the GeneScan Analysis Software. 

 

IMPORTANT

 

The gel file must be multicomponented using the correct 
matrix in order to be auto-tracked.

 

Table of Tracking Times 

 

Tracking times depend upon the number of lanes, channels, and scans 
in the gel file. Consult the table below to estimate gel tracking times for 
your GeneScan Analysis Software.

 

Lane Extraction

 

In version 3.1, you can extract lanes using weighted averaging or 
pre-averaging offscale detection. These options are available in the 
Lane Extraction section of the Gel Preferences dialog box.

For more information, see “Lane Extraction” on page 2-7.

 

Number of 
Lanes

Number of 
Channels

Number of 
Scans

Size of Gel 
(MB)

Time (min) for CPU/Speed

7200/90

 

a

 

4400/200

 

a

 

9500/200

 

b

 

G3/266

 

a

 

36 194 9152 21.6 15 9

 

c

 

5

36 194 11424 26.8 20 11

 

c

 

6

48 388 4516 21.5 26 10

 

c

 

5

48 388 7768 36.1 38 17

 

c

 

8

64 388 4565 21.7 26 10

 

c

 

6

64 388 5708 26.8 30 13

 

c

 

6

96 480 6840 39.5 46 24

 

c

 

13

 

a. 7200, 4400, G3:32MB + 10MB VM

 

b. 9500: 64MB + 10MB VM

 

c. Could not test this system
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About This Manual and Other Instruments

 

ABI 373

 

GeneScan Analysis Software works version 3.1 with ABI

 

™ 

 

 373 data in 
the same way as the it works with ABI PRISM® 377 data. 

If you use the GeneScan® 672 Software to collect data on the ABI 373, 
you must transfer your data to a Power Macintosh® computer, and 
perform certain extra steps. These extra steps are described in 
Appendix A, “Using GeneScan with the ABI 373.”

ABI 373 XL
Upgrade Users

The ABI™  373 DNA Sequencer with XL upgrade updates the data 
collection interface to match the ABI PRISM 377, increases the 
maximum image resolution to 388 channels, and increases the 
maximum number of lanes to 66.

Note ABI 373 with XL upgrade users do not need to follow the procedures 
described in this Appendix A, “Using GeneScan with the ABI 373.”

96-lane Upgrade
Kit

The ABI PRISM® 377 DNA Sequencer 96-lane upgrade kit enhances 
both the capabilities of the 377 DNA sequencer to support up to 96 
lanes for using the GeneScan Analysis Software.

Manual Text Manual Text Applies to other ABI PRISM Genetic Analysis Instruments 

The GeneScan Analysis Software and this manual apply to three 
different genetic analysis instruments supported by Applied 
Biosystems.

Instrument Description

ABI PRISM® 310 
Genetic Analyzer

Analyzes one sample at a time using capillary 
electrophoresis technology. This instrument provides 
automatic sample loading while using a minimal 
amount of sample.

ABI 373 DNA 
Sequencer

Performs slab gel electrophoresis, allowing the user 
to analyze multiple samples on a gel.

ABI PRISM 377 
DNA Sequencer

A high-throughput slab gel electrophoresis 
instrument, created to meet the needs of high-volume 
DNA sequencing or genetic analysis 
laboratories.Throughput is up to than four times that 
of the ABI 373.
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User Attention
Words

The text of this manual includes the following user attention words to 
draw your attention to specific details of the information presented in 
this manual.

User Attention word Description

Note Used to call attention to information.

IMPORTANT Indicates information that is 
necessary for proper operation of 
the software.
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Using the Macintosh Computer

Macintosh
Computer

Vocabulary and
Operations

To use the GeneScan Analysis Software, you should be familiar with the 
following basic Macintosh® computer vocabulary and operations:

If you do not understand some or all of these, refer to the Macintosh® 
System Software User Guide or the Owner’s Guide for more 
information.

Guidelines for
Optimal

Performance

Computers require regular attention and maintenance to operate 
efficiently and consistently. The ABI PRISM® software works with large 
files and accesses the hard disk often, so it is especially important that 
you follow maintenance procedures to minimize the occurrence of 
errors during operation.

Follow these general guidelines for optimal performance:

� Install only one Macintosh® computer system per hard disk.

� Back up all programs and files regularly.

� Remove nonessential files from the hard disk.

� Use a hard disk maintenance program regularly.

� Use discretion when adding software programs, especially Control 
Panel (CDEV) and Extension (INIT) files.

Refer to the ABI PRISM Instrument User Manual for more detail. 

Vocabulary and operations Description

Using the mouse Clicking and double-clicking, 
selecting and dragging.

Choosing commands Using pull-down and pop-up menus, 
dialog boxes, radio buttons and 
checkboxes.

Working with windows Opening and closing, resizing and 
repositioning, scrolling, 
understanding the active window.

Using the Macintosh computer 
hierarchical file system

Finding files and creating folders.
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Macintosh
Computer Terms

Used in This
Manual

The following Macintosh® computer terms are used frequently in this 
manual to describe how to use GeneScan Analysis Software.

Macintosh computer terms used in this manual. 

Item Description

Dialog Boxes Appear when you must make a 
decision or enter information. 

All other actions on the monitor 
screen are suspended until you 
close the dialog box by clicking a 
button, such as Cancel, OK, or 
Done.

Menus Provide access to various functions 
you can perform with the software. 

A heavy arrow ( ) after a menu item 
indicates that a submenu appears 
when you click that choice and hold 
down the mouse button. 

When you choose a menu command 
followed by an ellipsis (…) a dialog 
box appears.

Pop-up menus Display a heavy arrow ( ) and are 
found in dialog boxes. 

When you click a pop-up menu and 
hold down the mouse button, a 
submenu appears. 

These menus allow you to choose 
dialog box entries from specific lists 
of items.

Menu

Submenu
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Windows Display information, and, in some 
cases, allow you to edit or enter 
additional information. 

The top border of an active window 
always has six horizontal lines and 
usually has a Close box in the 
upper-left corner. 

If many windows are open, click one 
window to make it active. 

When a window is active, you can 
click the top border, hold down the 
mouse button, and drag the window 
to another location on the screen. 

When you are finished working with 
a window, click the Close box to 
remove the window from the screen, 
or click another window.

Macintosh computer terms used in this manual. (continued)

Item Description

WindowClose box
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Entry fields Rectangular areas in which you can 
enter information. 

Click in an entry field to display a 
cursor, and use the keyboard to 
enter the information.

Checkboxes Boxes that you click to select certain 
options in a dialog box. 

When you click an empty checkbox, 
an “x” appears in it, indicating that 
you have selected that option. 

You can usually select multiple 
checkboxes.

Radio buttons Small circles that appear in front of 
choices. 

When you click a radio button with 
the cursor, a black dot appears in the 
center of the circle to indicate your 
choice. You can only select one at a 
time.

Buttons Rectangles with rounded corners 
that allow you to accept or cancel 
the contents of a dialog box or 
perform functions (such as printing) 
within the dialog box. 

A button with a heavy outline is the 
default button that applies if you 
press the Return key.

Macintosh computer terms used in this manual. (continued)

Item Description
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Registering the Software

License and
Warranty

Before you begin, please read Appendix G, “License and Warranty.” 
This appendix explains your rights and responsibilities regarding the 
software.

Registering Your
Software

To register your copy of the GeneScan Analysis Software, complete the 
registration card (included in this software package) and return it to 
Applied Biosystems. Registering the software enables us to send you 
notification of software updates and any other future information that 
may be specific to GeneScan Analysis Software owners.

IMPORTANT Your product registration number is located on the 
Registration card. Be sure to record this number here before you return the 
Registration card.

Registration Number:
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Installing the Software

System
Specifications

The following table lists the system specifications1.

Item Specifications

CPU A Power Macintosh® computer (PowerPC CPU). 

(You will benefit from using the fastest computer 
available.)

CD-ROM Drive Any

Operating System Mac OS version 8.0 with Open Transport 1.1 or later.

Disk Space A minimum of 15 MB free disk space.

Storage requirements depend primarily on the 
quantity of data to be generated and stored. Sample 
files are approximately 150—250 KB each and gel 
files are 20—70 MB each.

It is common to store many Sample files on the 
analysis computer. 

Gel files are usually stored on the computer that is 
connected to the instrument and are removed or 
archived frequently.

Memory (RAM) The minimum memory requirement is 32 MB total 
with at least 20 MB of this available to run the 
GeneScan Analysis Software.

Virtual Memory Virtual memory MUST be turned on and set to 16 
MB. Set the Memory control panel so that the 
memory available after restart is at least 48M.

For information on how, see “Turning On Virtual 
Memory” on page 1-13.

If your computer has 48 MB of physical RAM, virtual 
memory does not need to be turned on.

Monitor A 17-inch monitor or larger is recommended.

Although a monitor of 640 x 480 resolution can be 
used. you will benefit from having a monitor of higher 
resolution.

disk drive Hard disk with a minimum of 250 MB storage.

1. Call technical support for the latest system specifications.
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Turning On
Virtual Memory

To turn on Virtual Memory:

Printer The following printers are supported:

� HP DeskJet 1200C/PS

� HP DeskJet 1600C/PS

System software Macintosh computer system software version 8.0.

Item Specifications

Step Action

1 From the Apple menu (), choose Control Panels and from the list 
choose Memory. The memory dialog box appears.

2 Ensure that Virtual Memory is On and that the memory available is 
at least 48M.
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RAM Required to
Run the Software

The system requires approximately 32 MB of RAM available to have 
both the Data Collection software and the analysis programs open 
simultaneously. This does not include the RAM required by the 
Macintosh computer operating system.

The RAM required by each program is as follows:

How to Check the RAM Available

Choose About this Macintosh® from the Apple () menu in the Finder.

Installing the
Software

The following procedure describes how to install the GeneScan 
Analysis Software. Before beginning the installation, backup the copies 
of the older versions of the GeneScan Analysis Software.

IMPORTANT After installation, be sure to register your software.

Program Approximate RAM required

Data Collection software 5.5 MB

GeneScan Analysis Software 32 MB

To install the GeneScan Analysis Software: 

Step Action

3 Quit all currently running applications.

4 Hold down the Shift key and choose Restart from the Special menu 
to turn off all extensions. 

5 Continue to hold down the shift key until the message “Extension 
Off” appears.

6 Insert the GeneScan Analysis Software install disk.

7 Double-click the Installer icon. 

The GeneScan Analysis Software installer appears.

8 Choose a folder in which to install the software.

9 Choose either 310 GeneScan Analysis 3.0 or 373/377/XL 
GeneScan Analysis 3.0, depending on your instrument.

10 Click Install. Insert other disks as the Installer asks for them.

11 Click Quit at the end of the installation.
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Program Files
Installed Diagram

The following diagram shows the program files installed on the hard 
disk.

Contents of
Folders

The installation program creates an ABI PRISM GeneScan 3.0 folder on 
the hard disk containing the following.

ABI PRISM GeneScan 3.0

 ABI PRISM® GeneScan® 3.0 Folder Contents

GeneScan GS Parameters
folder

GS Standards
folder

GS Matrix
folder

GS Gel Tracker
folder

Folder Contents

GS Parameters folder Use to store user-defined analysis parameters 
files if you create your own files.

GS Standards folder Use for storing size standard files when you 
define them.

GS GelTracker folder GS Gel Tracker program, tracker settings file, and 
extensions. You may also see a set of 20 to 30 
matlab text files. You can ignore these files; if you 
throw them away new ones are created when 
you next track a gel.

Note Advise keeping the files because they 
are useful for troubleshooting auto-tracking 
problems.

Note Do not change the name of the folder, 
the location of the folder, or the files in the folder.

GS Matrix folder Use for storing the matrix file generated using the 
GeneScan Analysis Software. For more 
information about matrix files, see Chapter 6, 
“Making a Matrix File.”
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GeneScan Analysis Software Files

Table of Files The following table lists the files that the GeneScan Analysis Software 
reads, writes, and, in most cases, creates. The software does not create 
gel files, and creates Sample files only through lane extraction from a 
gel. For information on the files installed by the GeneScan Analysis 
Software, see “Program Files Installed Diagram” on page 1-15.

GeneScan Analysis Software files 

File type

Location on

Description

373XL, 
ABI PRISM 377, 
377XL, 377 
96-Lanes, or 
ABI PRISM 310 ABI 373

GeneScan 
Analysis 
Software

GeneScan 3.0 
folder

GeneScan 3.0 
folder

The GeneScan 
Analysis Software 
analyzes data sent 
from the ABI PRISM 
instrument after a 
run. 

The gel file 
(373 or 377 
only) 

Run folder 
created by 
ABI PRISM 377 
Data-Collection 
during run

Run folder 
created by 
ABI 373 
Data-Collection 
during run

A large file created 
by the Data 
Collection software. 

The gel file contains 
the raw data 
collected during the 
instrument run. 

It also contains the 
Sample Sheet and 
run information. 

For a typical run, this 
file can be very large. 
More than 20 MB for 
194 channels, more 
than 40 MB for 388 
channels, and more 
than 50 MB for 96 
lanes (up to 70 MB 
for long runs).
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The Project 
File

Run folder 
created by the 
Data Collection 
software during 
run

Sample file 
folder created by 
GeneScan 
during run

Organizes, displays, 
and analyzes 
Sample files and 
results. 

Projects contain 
references to Sample 
files.

Project files can 
contain references to 
Sample files from 
more than one run.

Sample 
Files

Run folder 
created by 
data-collection 
software during 
run

Sample file 
folder created by 
GeneScan 
during run

Created by 
ABI PRISM 310.

For ABI 373 and 
ABI PRISM 377, 
GeneScan extracts 
sample information 
from the gel file to 
create Sample files. 

Each file contains 
data for a single lane 
or injection. 

Size 
Standard 
Files 

GS Standards 
folder or other 
specified folder

GS Standards 
folder or other 
specified folder

Identify peak sizes 
for specified size 
standards run under 
certain conditions. 

Define the standards 
after running them on 
the instrument. 

Tracker files 
and 
extensions

GS GelTracker 
folder in the GS 
3.0 folder 
(ABI PRISM 377 
and ABI 373 XL)

GS Tracker 
folder in the GS 
3.0 folder

GeneScan Analysis Software files (continued)

File type

Location on

Description

373XL, 
ABI PRISM 377, 
377XL, 377 
96-Lanes, or 
ABI PRISM 310 ABI 373
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Analysis 
Parameters 

GS Parameters 
folder or other 
specified folder

GS Parameters 
folder or other 
specified folder

Specify certain 
ranges and methods 
used during 
GeneScan analysis. 

You can also create 
and save custom 
parameters files for 
future use.

Matrix files ABI folder, GS 
Matrix folder or 
other specified 
folder

ABI folder, GS 
Matrix folder or 
other specified 
folder

Contains 
mathematical 
matrices that correct 
for spectral overlap. 

They are applied to 
data based on the 
chemistry run.

Analysis 
Log

GeneScan 
folder

GeneScan 
folder

Contains a running 
record of analysis 
performed by the 
GeneScan Analysis 
Software.

Sample 
Sheet

GeneScan or 
specified folder

GeneScan or 
specified folder

Sample information 
in spreadsheet form. 

Used for attaching to 
gel file.

GeneScan Analysis Software files (continued)

File type

Location on

Description

373XL, 
ABI PRISM 377, 
377XL, 377 
96-Lanes, or 
ABI PRISM 310 ABI 373
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Sample File
Database Support

GeneScan Analysis Software Sample files can be written to and read 
from the BioLIMS database. The BioLIMS Genetic Information 
Management System (BioLIMS database) provides a relational 
database for storage and retrieval of DNA fragment data.

If you have obtained the GeneScan Analysis Software as part of the 
BioLIMS Client package, you can use the program in either of two 
modes:

Mode Description

Sample File mode Fragment data extracted from gel 
files is written to individual sample 
files. 

Extracted fragment data viewed and 
processed within the GeneScan 
Analysis Software is read from and 
saved to sample files.

BioLIMS mode Fragment data extracted from gel 
files is written directly to a BioLIMS 
database that resides on a UNIX 
Server.

Extracted fragment data viewed and 
processed within the GeneScan 
Analysis Software is read from and 
written back to the same BioLIMS 
database.

For more information on using the 
BioLIMS database, see Appendix E, 
“Using the BioLIMS Database.”
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Technical Support

To Reach Us on the
Web

Applied Biosystems web site address is:

http://www.appliedbiosystems.com/techsupport

We strongly encourage you to visit our web site for answers to 
frequently asked questions, and to learn more about our products. You 
can also order technical documents and/or an index of available 
documents and have them faxed or e-mailed to you through our site 
(see the “Documents on Demand” section below).

Hours for
Telephone

Technical Support

In the United States and Canada, technical support is available at the 
following times.

See the “Regional Offices Sales and Service” section below for how 
to contact local service representatives outside of the United States and 
Canada. 

To Reach Us by
Telephone or Fax
in North America

Call Technical Support at 1-800-831-6844, and select the appropriate option 
(below) for support on the product of your choice at any time during the call. (To 
open a service call for other support needs, or in case of an emergency, press 1 
after dialing 1-800-831-6844.)

Product Hours

Chemiluminescence 9:00 a.m. to 5:00 p.m. Eastern Time

LC/MS 9:00 a.m. to 5:00 p.m. Pacific Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time

For Support On This 
Product Dial 1-800-831-6844, and...

ABI PRISM® 3700 DNA 
Analyzer

ABI PRISM® 3100 Genetic 
Analyzer

DNA Synthesis

Press FAX

8 650-638-5981

Press FAX

26 650-638-5891

Press FAX

21 650-638-5981
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Fluorescent DNA 
Sequencing

Fluorescent Fragment 
Analysis (includes 
GeneScan® applications)

Integrated Thermal Cyclers

BioInformatics (includes 
BioLIMS™, BioMerge™, and 
SQL GT™ applications)

PCR and Sequence 
Detection

FMAT

Peptide and Organic 
Synthesis

Protein Sequencing

Chemiluminescence

For Support On This 
Product Dial 1-800-831-6844, and...

Press FAX

22 650-638-5891

Press FAX

23 650-638-5891

Press FAX

24 650-638-5891

Press FAX

25 505-982-7690

Press FAX

5, or call

1-800-762-4001, 
and press 1 for 
PCR, or 2 for 
Sequence 
Detection 

240-453-4613

Telephone FAX

1-800-899-5858, 
and press 1, then 
press 6

508-383-7855

Press FAX

31 650-638-5981

Press FAX

32  650-638-5981

Telephone FAX

1-800-542-2369 
(U.S. only), or

1-781-271-0045 
(Tropix)

781-275-8581 
(Tropix)

9:00 a.m. to 
5:00 p.m. ET
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LC/MS

For Support On This 
Product Dial 1-800-831-6844, and...

Telephone FAX

1-800-952-4716 650-638-6223 

9:00 a.m. to
5:00 p.m. PT
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Documents on
Demand

Free 24-hour access to Applied Biosystems technical documents, 
including MSDSs, is available by fax or e-mail. 

You can access Documents on Demand through the internet or by 
telephone:

If you want to 
order... Then...

through the 
internet

Use http://www.appliedbiosystems.com/techsupport

You can search for documents to order using keywords. 

Up to five documents can be faxed or e-mailed to you 
by title.

by phone from the 
United States or 
Canada

a. Call 1-800-487-6809 from a touch-tone phone. Have 
your fax number ready. 

b. Press 1 to order an index of available documents 
and have it faxed to you. Each document in the 
index has an ID number. (Use this as your order 
number in step “d” below.)

c. Call 1-800-487-6809 from a touch-tone phone a 
second time.

d. Press 2 to order up to five documents and have 
them faxed to you.

by phone from 
outside the 
United States or 
Canada

a. Dial your international access code, then 
1-858-712-0317, from a touch-tone phone.

Have your complete fax number and country code 
ready (011 precedes the country code).

b. Press 1 to order an index of available documents 
and have it faxed to you. Each document in the 
index has an ID number. (Use this as your order 
number in step “d” below.)

c. Call 1-858-712-0317 from a touch-tone phone a 
second time.

d. Press 2 to order up to five documents and have 
them faxed to you.
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To Reach Us by
E-Mail

Contact technical support by e-mail for help in the following product 
areas.

Regional Offices
Sales and Service

If you are outside the United States and Canada, you should contact 
your local Applied Biosystems service representative.

For this product area Use this e-mail address

Chemiluminescence info@appliedbiosystems.com

Genetic Analysis galab@appliedbiosystems.com

LC/MS apisupport@sciex.com

PCR and Sequence Detection pcrlab@appliedbiosystems.com

Protein Sequencing, Peptide and 
DNA Synthesis

corelab@appliedbiosystems.com

The Americas

United States
Applied Biosystems
850 Lincoln Centre Drive
Foster City, California 94404

Tel: (650) 570-6667
(800) 345-5224

Fax: (650) 572-2743

Latin America (Del.A. Obregon, 
Mexico)

Tel:(305) 670-4350
Fax: (305) 670-4349 

Europe 

Austria (Wien)

Tel: 43 (0)1 867 35 75 0

Fax: 43 (0)1 867 35 75 11

Hungary (Budapest)

Tel:  36 (0)1 270 8398
Fax:        36 (0)1 270 8288

Belgium 

Tel: 32 (0)2 712 5555
Fax: 32 (0)2 712 5516

Italy (Milano)

Tel: 39 (0)39 83891
Fax: 39 (0)39 838 9492

Czech Republic and Slovakia 
(Praha)

Tel: 420 2 61 222 164
Fax: 420 2 61 222 168

The Netherlands (Nieuwerkerk a/d 
IJssel)

Tel: 31 (0)180 331400
Fax: 31 (0)180 331409

Denmark (Naerum)

Tel: 45 45 58 60 00
Fax: 45 45 58 60 01

Norway (Oslo)

Tel: 47 23 12 06 05
Fax: 47 23 12 05 75
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Finland (Espoo)

Tel: 358 (0)9 251 24 250
Fax: 358 (0)9 251 24 243

Poland, Lithuania, Latvia, and 
Estonia (Warszawa)

Tel: 48 (22) 866 40 10
Fax: 48 (22) 866 40 20

France (Paris)

Tel: 33 (0)1 69 59 85 85
Fax: 33 (0)1 69 59 85 00

Portugal (Lisboa)

Tel: 351 (0)22 605 33 14
Fax:  351 (0)22 605 33 15

Germany (Weiterstadt)

Tel: 49 (0) 6150 101 0
Fax: 49 (0) 6150 101 101

Russia (Moskva)

Tel: 7 095 935 8888
Fax: 7 095 564 8787

Spain (Tres Cantos)

Tel: 34 (0)91 806 1210
Fax: 34 (0)91 806 1206

South Africa (Johannesburg)

Tel: 27 11 478 0411
Fax: 27 11 478 0349

Sweden (Stockholm)

Tel: 46 (0)8 619 4400
Fax: 46 (0)8 619 4401

United Kingdom (Warrington, 
Cheshire)

Tel: 44 (0)1925 825650
Fax: 44 (0)1925 282502

Switzerland (Rotkreuz)

Tel: 41 (0)41 799 7777
Fax: 41 (0)41 790 0676

South East Europe (Zagreb, Croatia)

Tel: 385 1 34 91 927
Fax: 385 1 34 91 840

Middle Eastern Countries and North 
Africa (Monza, Italia)

Tel: 39 (0)39 8389 481
Fax: 39 (0)39 8389 493

Africa (English Speaking) and West 
Asia (Fairlands, South Africa)

Tel: 27 11 478 0411
Fax: 27 11 478 0349

All Other Countries Not Listed
(Warrington, UK)

Tel: 44 (0)1925 282481
Fax: 44 (0)1925 282509

Japan

Japan (Hatchobori, Chuo-Ku, Tokyo)

Tel: 81 3 5566 6100

Fax: 81 3 5566 6501

Europe 
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Eastern Asia, China, Oceania

Australia (Scoresby, Victoria)

Tel: 61 3 9730 8600
Fax: 61 3 9730 8799

Malaysia (Petaling Jaya)

Tel: 60 3 758 8268
Fax: 60 3 754 9043

China (Beijing)

Tel: 86 10 6238 1156 
Fax: 86 10 6238 1162

Singapore 

Tel: 65 896 2168
Fax: 65 896 2147

Hong Kong

Tel: 852 2756 6928
Fax: 852 2756 6968

Taiwan (Taipei Hsien)

Tel: 886 2 2698 3505
Fax: 886 2 2698 3405

Korea (Seoul)

Tel: 82 2 593 6470/6471
Fax: 82 2 593 6472

Thailand (Bangkok)

Tel: 66 2 719 6405
Fax: 66 2 319 9788
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How to Process and 
Edit the Gel File 2
Introduction

In This Chapter This chapter contains information about how to view and edit the gel 
file, and how to generate Sample files or BioLIMS™ database records 
after editing the gel file.

Note This section does not apply if you are analyzing Sample files 
generated on the ABI PRISM® 310 instrument.

IMPORTANT Refer to Appendix A, “Using GeneScan with the ABI 373,” 
before using the GeneScan program to analyze data collected on the ABI 373.

Topics in This
Chapter

Topics in this chapter include the following:

Topic See page

About Gel Files 2-2

How to Set Gel Processing Preferences 2-3

How to Display the Gel File 2-11

About the Gel File Window 2-12

How to Adjust the Gel Image 2-18

Verifying Gel Information 2-26

Displaying the Sample Sheet 2-29

About the Sample Sheet 2-31

Working with the Sample Sheet 2-34

About Displaying Regions of Off-Scale Data 2-38

Working with Lane Markers 2-43

Marking and Unmarking Lanes for Extraction 2-50

Working with Tracker Lines 2-53

Interpolating Tracker Lines 2-57

Tracking Lanes and Extracting Data 2-59

2
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About Gel Files

Instruments
Producing Gel File

The gel file, which is generated only by the ABI™  373 DNA Sequencer 
instrument, the ABI 373 with XL upgrade, the ABI PRISM® 377 DNA 
Sequencer instrument, and the ABI PRISM® 377 with XL upgrade, stores 
the raw data collected during the entire run of the instrument. A gel file 
can be 10 MB to 60 MB.

96-Lane Gels
Capability

The GeneScan® Analysis Software can open and analyze 96-lane gels. 

Gel File Contents Initially, the file contains the following:

� Raw data collected during the run.

� Gel image, which is similar to an autoradiogram, but in color.

� Copy of the Data Collection software sample sheet.

� Copy of the matrix file.

After lane tracking and editing, the file also contains the lane tracking 
information and any changes you make to the original information in the 
file.

How GeneScan
Tracks a Gel File

When the GeneScan Analysis Software tracks the gel file, it creates a 
tracker line for each lane in the gel. Each tracker line is trying to find the 
center of the bands, not the brightest part of the band. The tracker will 
only track if a matrix is attached to the gel file.

During data extraction, the software generates a Sample file for each 
tracked lane by averaging the data from the tracked channel and the 
number of channels you specify on either side of it. The software also 
copies to each new Sample file all the information required to identify 
and analyze the sample.

How the GeneScan Analysis Software Names Sample Files 2-67

Saving Gel Files After Editing Tracking 2-68

Topic See page
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How to Set Gel Processing Preferences

Introduction Use the Gel Processing dialog box to define the parameter values to 
use for gel file processing. The following procedure applies to the 
ABI 373 and the ABI PRISM 377 instruments.

Displaying the Gel
Preferences Dialog

Box

To display the Gel Preferences dialog box:

Step Action

1 If the GeneScan Analysis Software is not running, then double-click 
the program icon.

2 Choose Gel Preferences from the Settings menu.

The Gel Preferences dialog box appears.

There are three Gel Preferences parameters:

� Auto-Launch Processing.

� Image Generation Defaults.

� Lane Extraction.
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Auto-Launch
Processing

Select or de-select the checkboxes to specify whether or not the gel is 
to be automatically tracked and extracted at the end of a data collection 
run. 

IMPORTANT Before auto-tracking the first time, you need to verify that the 
comb type is set correctly. The default comb type is Square.

Note Select both checkboxes to analyze samples automatically after 
data-collection.

Image Generation
Defaults

In the Image Generation Defaults options enter values that determine 
how the GeneScan Analysis Software processes the gel file when it 
generates the initial gel image from data collected after electrophoresis.

Image Generation options: 

Item Description

Scan Range Enter the scan numbers at which you want to display 
the gel image. Use a trial run to determine the scan 
range since the time frame in which fragments are 
detected may vary from run to run.

During analysis, the GeneScan Analysis Software 
ignores all scans outside the specified scan range, 
and only includes the scans with the designated 
ranges when it generates Sample files. 

See “Regenerating the Gel Image” on page 2-23 to 
change the number of scans displayed.

Determining the Start and Stop Scan Numbers:
a. Determine the start number by multiplying the 

applicable number from the table below by the 
number of hours it takes for the peaks to appear.

b. Determine the stop number by multiplying the 
applicable number from the above table by the 
number of hours that pass before the last peak is 
detected.

Instrument & Type of Run
Scans per 
hour

ABI 373 600

ABI PRISM 377 and ABI™  373 
with XL upgrade

1,200 to 2,400a

a. Depending on which module is used during data collection
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Multicomponent 
Gel Image

Note This option affects only the gel image.

Select this checkbox to use the spectral separation 
algorithm in conjunction with a predefined matrix file 
to resolve the spectral overlap between dyes. 

Matrix files are specific to a particular set of run 
conditions and to the instrument on which they are 
created.

In other words, you must create a different matrix file 
for each dye set, gel type, and set of running 
conditions you use. 

For more information, see Chapter 6, “Making a 
Matrix File.”

IMPORTANT If the gel does not have an 
associated matrix, you must attach a matrix to the gel, 
or the software will not multicomponent the gel image, 
even if you select this option. The tracker relies upon 
multicomponent images for accurate tracking.

IMPORTANT To attach a matrix, see “Installing 
New Matrix Information” on page 2-24.

Note You must always attach a matrix to the 
ABI 373 Collection file in order to multicomponent the 
gel image. ABI 672 Data Collection software is not 
capable of pre-installing a matrix. 

See Appendix A, “Using GeneScan with the ABI 373.”

Image Generation options: (continued)

Item Description
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Estimated 
Maximum Peak 
Height

In this text box, enter the maximum signal level you 
expect from samples in the run. This can be an 
approximate number, based on your typical run 
conditions and samples.

The default is 2000.

Note This option affects only the appearance of 
the gel image (not the raw data) when the image is 
generated the first time the gel file is opened. Use the 
Regenerate Gel Image command to change the 
appearance of an open gel window (See page 2-23).

The gel image can also be modified using the Adjust 
Gel Contrast command; see “Adjusting the Contrast” 
on page 2-20.

The Estimated Maximum Peak Height value:

� Affects the color brightness of the DNA fragment 
bands. 

All bands with a data value at or above the 
Estimated Maximum Peak Height value are 
assigned the brightest dye color. 

The dye colors for bands with values below that 
level are dimmed proportionally, unless 
multicomponented.

In general, the lower you set this value, the 
brighter the bands appear in the Gel File window. 
A value of 1000 is satisfactory for most gel files. If 
the gel image is very dim, try 500; if it is too 
bright, try 2000.

� Determines the scale of the peaks in the Slice 
view of the Gel File window. 

For the highest quality gel image, the highest 
sample peaks (not the Primer peak) should just 
reach the top of the scale in the Slice view. 

If you find that many of the peaks are cut off, you 
may want to readjust the Estimated Peak Height 
value to a higher number. 

Image Generation options: (continued)

Item Description
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Lane Extraction The following table lists the options in the Lane Extraction section.

Item Description

Use Weighted 
Averaging 
checkbox

Weighted channel averaging is a new feature in 
GeneScan v. 3.0. 

Weighted averaging is now possible because the new 
Tracker interface allows tracker line placement to 
within a tenth of a channel.

No Weighted Averaging

If the Use Weighted Averaging box is not checked, data averaging is done 
per channel the same as with earlier versions of the GeneScan Analysis 
Software. 

For example, if the tracker line falls within channel 10, and three-channel 
averaging is set:

Where I is the intensity for a given channel and scan number.

Weighted Averaging

If the Use Weighted Averaging box is selected, the tracker line falls 20% into 
channel 10 (see diagram below), and two-channel averaging is set:

channel average
Ich. 9 Ich. 10 Ich. 11+ +

3
---------------------------------------------------=
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Channel Number

9 10 11

Tracker line
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Use Channel 
Averaging text 
entry field

Averaging reduces the amount of noise in the sample 
file and allows for more accurate representation of the 
band as a peak. (See “Weighted Averaging” on 
page 2-7). 

The number of channels to be averaged for each lane 
when extracting data from the gel file is normally set 
to 3. 

Each tracker line in the Gel File window marks the 
channel where the GeneScan Analysis Software 
located the strongest fluorescent signal for that lane. 

If you use the default three-channel average (without 
weighted-averaging), the raw data in each sample file 
is an average of the data in the channel marked by 
the tracker line and one channel on either side of it. 

IMPORTANT When using multiple-channel 
averaging, ensure the tracker lines mark central 
channels of the bands. If they mark channels at the 
right or left edge of the bands, the empty channel 
between lanes is included in the average or the signal 
from an adjacent lane could be included, causing an 
erroneous value.

Item Description
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Altering the Channel Averaging

Pre-Averaging 
Offscale Detection 
checkbox

When you select this checkbox, if any of the channels 
that are used for averaging has a value of 
8191relative fluorescent units (rfu), then no averaging 
takes place and the value of 8191 rfu is written for that 
scan of that lane.

Note If you extracted a sample file with the 
Pre-Averaging Offscale Detection checkbox selected, 
then pre-averaging has a value of zero in the Sample 
Info View.

For information about off-scale data, see “About 
Displaying Regions of Off-Scale Data” on page 2-38.

The default is checkbox is not selected.

Item Description

If you choose... Then...

two-channel averaging data is taken from the 
tracked channel and the 
channel to the right of it 
(without weighted 
averaging). You can 
include data from up to 
nine channels. 

Three-channel 
averaging is 
recommended for most 
applications.

one-channel averaging 
(no averaging)

if the gel bands are 
severely tilted. For 
example, if the left lane 
of the gel ran faster than 
the right, a better result 
would be obtained by 
taking the center 
channel alone, rather 
than averaging three 
channels.
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Comb Type IMPORTANT Before auto-tracking the first time, you need to verify that the 
comb type is set correctly. The default comb type is Square.

The Neural Net Tracker uses special tracker setting files that are 
optimized according to the number of channels and lanes in the gel file 
and the comb type.

It is important that you set the correct comb type for the gel so that the 
Tracker applies the correct tracker setting files.

This value appears at the bottom of the gel window (see “Gel File 
Window Diagram” on page 2-13).

IMPORTANT The proper comb type needs to be selected in order to 
ensure proper tracker performance.

Stop extraction 
when below 
confidence value 
checkbox

If the Stop extraction when below confidence 
threshold box is checked, the lane extraction will not 
be carried out and a warning dialog box will appear 
when the lane assignment confidence level is below 
that specified in the Confidence Threshold. 

The dialog box gives you the option to cancel or 
continue the gel file extraction and analysis. 

Confidence 
Threshold text 
entry field

After a gel is auto-tracked, a lane assignment 
confidence value is written to the Analysis Log. 

This value indicates the Tracker’s confidence in how 
well the assigned lanes match the sample sheet. 
(This value is not an indication of how well the tracker 
lines follow the fluorescence intensity within the 
lanes.) 

Lane assignment confidence values tend to be 
extreme numbers: very low or very high. 

Although, a value of 70 or more generally indicates 
that the lane assignment for the gel is correct, it is 
recommended that you check the tracker lane 
assignment anytime the reported lane assignment 
confidence value is less than 100%.

Item Description
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How to Display the Gel File

Introduction Use the gel image to observe sample migration, lane tracking, and 
signal strength in the gel image. You can also use the window to adjust 
the image to improve visibility, re-align individual lane markers, or edit 
the position of the tracker lines.

Displaying the Gel
File

You can display a gel file as follows:

To display a gel file... Then...

automatically after automatic analysis, the Gel File window 
opens and displays the newly created gel file.

For more information, see “Setting Up for 
Automatic Analysis” on page 4-4.

manually you can either:

Double-click the Gel file, or

a. Choose Open from the File menu. 

The Open Existing dialog box appears.

b. Click the Collection Gel icon. 

A directory dialog box appears.

c. Locate and select the desired gel file and 
choose Open.
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About the Gel File Window

Differences
Between Gel File

Windows

The following table explains the differences between the GeneScan 
Analysis Software Gel File window and the Gel File window displayed 
by the Data Collection software during a run.

Application Shows New Data Gel Image

Data Collection 
software Gel window

Real-time data as it is 
being collected. 

New data appears at 
the bottom of the 
screen as it is 
collected, so the top of 
the screen shows the 
start of the run.

Gel image is not 
baselined or 
multicomponented

GeneScan Gel File 
window

An image of the gel 
after the Data 
Collection software is 
finished. 

This image is inverted. 

The bottom of the 
window displays the 
start of the run, that is, 
the smallest 
fragments appear at 
the bottom of the 
window, just as they 
would on an 
autoradiogram.

Gel image is 
baselined and may or 
may not be 
multicomponented.
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Gel File Window
Diagram

The following is an example of the Gel File window.

3

4

5

789 61011

1 2Buttons



2-14 How to Process and Edit the Gel File

Gel File Window
Buttons

The following table describes the buttons on the Gel File window.

Window tool Description

Color buttons—Turns on/off the display of one or 
more colors in the gel image and slice view (see 
also page 2-18). 

Sample Sheet button–Displays a copy of the 
Data Collection Sample Sheet associated with 
the gel file. 

You can use the sample sheet information to 
check that the lanes are correctly labeled for the 
gel image.

For more information, see “Displaying the Sample 
Sheet” on page 2-29.

Gel Info button–Displays the Gel Info dialog box.

For more information, see “Gel Info Window” on 
page 2-26.

Horizontal Shrink button—Compresses the gel 
image horizontally in order to see all the gel lanes 
in a standard-sized window.

Horizontal Expand button—Expands the gel 
image horizontally in order to adjust the tracker 
lanes.

The four levels of horizontal zoom are: 1x, 2x, 4x, 
and 8x.

Vertical Shrink button—Returns the vertical scale 
to normal after using the Vertical Expand button.

Vertical Expand button—Expands the gel image 
vertically to see the quality of the peaks in Slice 
View.

There are two levels of vertical zoom: full scale 
and 600 scans.

Interpolation button—Places the user in 
tracker-line interpolation mode.

For more information, see “Interpolating Tracker 
Lines” on page 2-57.
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Gel File Window
Described

The following table describes the diagram on page 2-13.

Off-Scale button—Displays off-scale data.

Turns off all the colors in the gel image and 
displays in white any data points that are 
off-scale. 

Off-Scale data is outside the range of the 
detector (8191 relative fluorescent units and 
greater.)

Note To see all off-scale data points, the 
Horizontal Expand and the Vertical Expand 
buttons must be used.

For more information, see “About Displaying 
Regions of Off-Scale Data” on page 2-38.

Window tool Description

Gel File window described. 

No. Description

1

2 Lane numbers—Numbers across the top of the gel image show the 
lane number currently assigned to each lane on the gel.

Channel Current cursor position on the horizontal 
scale and is displayed in sub-channel 
increments.

Channels are the divisions across the read 
region of a gel where the Data Collection 
software samples the data. 

The number of available channels depends 
on the instrument and run mode used.

Scan Current cursor position on the vertical scale.

Note These numbers change as you 
move the cursor over the image.

Lane Used Number of lanes used in the gel.
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3 Lane markers—Diamond shaped markers (�) show the current 
status of each lane.

The following table lists the status values:

4 Control points—Use to control shape and position the splines.

For more information, see “Using Control Points” on page 2-45.

5 Scroll bars—Use to scroll the gel view horizontally or vertically.

6 Gel Image—An image representing a time history of all 
fluorescence detected during the run.

� Each peak is shown as a brightly colored band within the 
sample lane. 

� Each position on the gel image is defined by a scan number 
and a channel number.

7 Tracker line for the selected lane.

8 Current Comb Type—Displays the current comb type that is set in 
the Gel preferences.

For more information, see “Comb Type” on page 2-10.

9 Control row

For information on adding and deleting a control row, see “Adding 
and Deleting Control Rows” on page 2-46.

Gel File window described. (continued)

No. Description

Lane 
color Description

White Lane used and marked for extraction.

Blue Lane is used but not marked for extraction.

Yellow Lane was edited and extracted, but the gel file was 
not saved with new information.

Gray The tracker does not expect to find a lane here, if it 
does, the tracker will confuse it and lane 
assignment confidence will be low.

Orange Lane was inferred by the Tracker software. 

If you move or reshape an inferred lane tracker line, 
it ceases to be inferred and the orange border is 
lost.
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10 Scan number—Reflects a particular point in time.

The address of a particular data point on the Gel file image.

11 Slice view—Graphical view of the data values in the tracked 
channel of the selected lane. 

� The display changes as you move the tracker line from one 
channel to another in the lane. 

� Each peak in the Slice view corresponds to a band in the gel 
image and indicates a DNA fragment. 

� Although these bands and peaks do not represent analyzed 
data, they provide an overview of the relative signal intensity 
between the bands in that lane, and allow you to make a 
qualitative evaluation of the run. 

� The Slice view is empty (black) when no lane is selected or 
when the lane has no data.

Gel File window described. (continued)

No. Description

This run... Collects...

2400 approximately 2250 scans per hour

1200 approximately 1125 scans per hour
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How to Adjust the Gel Image

Introduction Although the data shown in the gel image is not analyzed, the displayed 
information allows you to evaluate the quality of the run.

You can adjust the appearance of the gel image as follows. 

� Displaying/Hiding a Dye Color.

� Changing Dye Indicators.

� Adjusting the Contrast.

� Regenerating the Gel Image using a different scan number range, 
estimated maximum peak height, and multicomponenting option.

� Installing New Matrix Information.

Note Changing any of the above features in the Gel File window does not 
change the raw data contained in the gel file. 

Displaying/Hiding
a Dye Color

Introduction

You can control the display of specific fluorescent dye colors. For 
example, if you want to display only the bands labeled with blue dye, 
you can suppress the display of all green, yellow, or red bands.

How to Display or Hide a Dye Color

Display or hide by a 
color by... Default Comment

clicking the colored 
boxes near the top-left 
corner of the Gel File 
window.

All colors displayed. Any change you make 
in the button settings is 
saved in the gel file and 
used the next time that 
the file is opened.
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Changing Dye
Indicators

The following procedure describes how to change the dye indicator 
colors. 

You may want to change the dye colors to make the colors easier to 
distinguish. For information on changing the default dye indicator colors, 
see “Setting Dye Indicator Preferences” on page 5-15.

To change the dye indicator colors: 

Step Action

1 There are two ways to display the Dye Indicators dialog box:

Note Use the scroll bar to view additional dyes.

You can.... Result

Choose Preferences from the 
Settings menu and Dye 
Indicators from the submenu. The Dye Indicators dialog box 

appears.Hold the Option key and click 
one of the colored boxes in the 
upper corner of the gel display.

Scroll bar
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Adjusting the
Contrast

Use the Adjust Gel Contrast dialog box to increase or reduce the 
intensity of individual colors in the gel image. 

These kinds of adjustments can make it easier to see the data in the gel 
and can improve the appearance of the gel for presentation.

Note While using the Adjust Gel Contrast dialog box to adjust the contrast, 
the changes are shown in the background gel.

2 Select a color from the pop-up menu to change the Dye color or the 
Plot color.

Changing dye and plot colors has the following affects:

To change the dye indicator colors: (continued)

Step Action

Choosing a color 
from... Shows the colors...

Dye Color column that represent the dyes in the Analysis 
Control and the Results Control 
windows and in the gel image.

Plot Color column used for displaying the data in 
electropherograms.

To adjust the contrast in the gel image: 

Step Action

1 Select a lane in the gel image that contains the color you want to 
adjust.

Note Changes affect the entire gel, not just the selected lane.

2 Choose Adjust Gel Contrast (� J) from the Gel menu. 

The Adjust Gel Contrast dialog box appears (see below).
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3 Place the cursor on the triangle for the color you want to adjust, 
then hold down the mouse button and drag the triangle up or down 
to a new position.

Note The changes take effect in the gel image as you move the 
triangles.

To adjust the contrast in the gel image: (continued)

Step Action
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Removing Gel
Contrast Changes

To remove the changes you can:

� Choose Undo Adjust Contrast (� Z) from the Edit menu.

Note Can only undo if you do not choose another command, that is, after 
adjusting the gel contrast if you choose Undo Adjust Contrast you cannot do 
segment tracking.

� Redisplay the Adjust Gel Contrast dialog box and manually reset 
the settings.

� Close the Gel File window without saving the changes.

4 You can take the following action.

Note It is best to adjust one color, apply the change, and view 
the effect in the gel image before you adjust another color.

5 Click OK to dismiss the dialog box when you are satisfied with the 
gel contrast.

To adjust the contrast in the gel image: (continued)

Step Action

If you want to... Then...

increase the intensity of a color pull the top triangle for that 
color down.

For example, pull the top blue 
triangle down until it is 
somewhat above the tallest 
blue data peaks (not primer 
peaks) in the displayed Slice 
View.

suppress the background 
noise of a color

pull the bottom triangle for that 
color up.

For example, to correct a red 
background haze because of 
signal noise or because the 
signal baseline is not flat, pull 
the bottom red triangle up until 
it is just above the baseline 
and noise in the display.
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Regenerating the
Gel Image

Regenerating the gel image is useful, for example, if there is unusable 
data near the beginning or the end of the run, the maximum peak height 
is different from what you expected, or when a new matrix is installed.

To regenerate the gel image: 

Step Action

1 Choose Regenerate Gel Image from the Gel menu.

The Regenerate Gel Image dialog box appears. The values 
displayed are an example that were used to create the current gel 
image.

2 Make any required changes in the dialog box values, as follows:

Use the... To...

Stop text entry field include the last scan value 
desired in the gel image. 

The Max value indicates the 
total number of scans in the 
current gel file.

Start text entry field include the first scan value in 
the gel image.

Multicomponent Gel Image 
checkbox

cause GeneScan Analysis 
Software to apply the assigned 
matrix file to the gel image.

For information on the matrix 
file, see Chapter 6, “Making a 
Matrix File.”

Estimated Maximum Peak 
Height text entry field

enter the maximum signal level 
expected from samples in the 
run.
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Installing New
Matrix

Information

About the Matrix File

The Data Collection software copies the matrix information in the 
specified matrix file to the gel file during data collection. The GeneScan 
Analysis Software uses this matrix information to multicomponent the 
gel image (Multicomponenting is the adjusting for spectral overlap of the 
fluorescent dyes). It also copies this information during lane extraction 
to each Sample file for use during Sample file analysis.

IMPORTANT If you install new matrix file information after extracting the 
sample data from the gel file, the Sample files will not contain the new 
information. You must either regenerate the Sample files, or install the new 
matrix directly to the existing Sample files.

How to Install a New Matrix File

If you specified the wrong matrix file or no matrix file in data collection, 
you can install a new matrix file in the gel image. You can also specify a 
different matrix file in order to test the results of using different matrices 
on the samples.

3 Click OK to close the dialog box and start regenerating the gel 
image.

Note �-(period) cancels the regeneration.

To regenerate the gel image: (continued)

Step Action

To install a new matrix file in a gel image: 

Step Action

1 Open the gel image.

2 Choose Install New Gel Matrix from the Gel menu. 

A directory dialog box appears.

The Folder Preferences settings determine where the GeneScan 
Analysis Software looks for the matrix file. 

For more information, see “Specifying File Locations” on page 5-42.
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3 Find and select the desired matrix file, then choose Open. 

The dialog box closes and the information is added to the gel file.

If the new matrix installs correctly, the following dialog box appears.

4 Choose whether or not to regenerate the gel image.

Note If you do not regenerate the gel image now, the matrix is 
included in the data when Sample files are generated. 

For more information on matrix files, see Chapter 6, “Making a 
Matrix File.”

To install a new matrix file in a gel image: (continued)

Step Action
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Verifying Gel Information

Where the
Information is

Archived

Gel and run information is archived in the following:

� Data Collection run error log.

� Gel Info window.

� Gel image.

� Gel Sample Sheet.

Data Collection
Run Error Log

The Data Collection Run Error log can provide information about 
Macintosh® computer or instrument errors that occurred during the run.

Gel Info Window What the Gel Info Window Displays

The window displays information about the run conditions and 
parameters, and the gel image. You can change some of this 
information for your record keeping purposes, and other information, 
such as the date of the run, cannot be changed. The information in this 
window is saved with each Sample file generated from the gel file.

IMPORTANT Use the Matrix file section in the Gel Info window to verify 
what matrix is attached to the Gel file and use the Multicomponented section to 
verify whether or not the Gel file is multicomponented.

How to Display the Gel Info Window

There are two ways to display the Gel Info window:

You can Result

click the Gel Info button on the Gel 
File window

The Gel Info window appears (see 
“Gel Info Window Example” below).

choose Gel Info from the Gel menu
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Gel Info Window Example

Gel Image Review the gel image for a general measure of the quality of the run. 
For more information, see “How to Adjust the Gel Image” on page 2-18.

IMPORTANT If you make any of the changes to the scan range after 
extracting the sample data from the gel file, re-extract the Sample files to 
include the new information. For information, see “Regenerating the Gel Image” 
on page 2-23.

What to Review in the Gel Image

Review these items... Take this action...

� Inspect the general condition of 
the bands in the lanes in the gel 
image.

� Are the fluorescent signals 
displayed as discreet horizontal 
bands? 

This may indicate a poor gel.

� Are any of the colors too bright 
or too dark?

� Is there a green or red haze? 

� Is this something that you can 
fix by adjusting the gel image 
contrast? 

Either:

� Adjust gel contrast (see 
page 2-18).

� Adjust Estimated Maximum 
Peak Height (see page 2-6), or

� Rerun the gel.

� Inspect the lane markers. 

� Verify that each lane marker 
corresponds to a sample as 
designated in the Sample 
Sheet.

Adjust the locations of the lane 
markers, as necessary.
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Sample Sheet Review the Sample Sheet to confirm that the information in the fields is 
correct. If necessary, edit the Sample Sheet information (instrument file, 
sample names, comments, and so forth) that is automatically 
transferred to the Sample files or to the BioLIMS database.

For more information, see “Displaying the Sample Sheet” on page 2-29.

� Inspect the tracker lines. 

� Each tracker line should be 
centered over the brightest part 
of the bands it is tracking 
through. 

Adjust the tracker line placement, as 
necessary.

� Inspect the Slice View for each 
lane. 

� Verify that all fragments in the 
size standard are included in 
the current tracking. 

Adjust the tracker line placement, as 
necessary.

Review these items... Take this action...
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Displaying the Sample Sheet

What is the
Sample Sheet

The Sample Sheet contains sample information and is copied to the 
Data Collection run file before you start the run.

Using the Copy of
the Sample Sheet

The Sample Sheet copy is automatically copied to the gel file. You can 
view, edit, and print this Sample Sheet copy whenever the gel file is 
open. Changes you make in this copy are stored in the gel file; they do 
not affect the original Sample Sheet file.

Displaying the
Copied Sample

Sheet

To display the copied Sample Sheet:

Displaying a New
Sample Sheet

To display a new Sample Sheet:

Step Action

1 Open the gel file.

2 There are two ways to display the Sample Sheet.

You can... Result

click the Sample Sheet 
button

The Sample Sheet window 
appears.

See “Sample Sheet Example” 
on page 2-31.

choose Gel Sample Sheet from 
the Gel menu

Step Action

1 Open the GeneScan Analysis Software program.

2 Choose New from the File menu. 

The Create New dialog box appears.
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3 Click the Sample Sheet icon. 

The following dialog box appears.

4 Click the radio button that corresponds to the number of dyes 
contained in your gel file and click OK.

An untitled Sample Sheet appears. See “Sample Sheet Example” 
on page 2-31.

Step Action
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About the Sample Sheet

Sample Sheet
Example

The following is an example of a Sample Sheet for DNA fragments 
labeled with a blue dye and the GeneScan-350 Rox Internal Lane Size 
Standard:

Sample Sheet
Described

The following table describes the above diagram.

1 2 3 4 5 6 7 8 9 11 1210

Sample Sheet described: 

No. Description

1 Lane number for the sample.

GeneScan Analysis Software assigns lane numbers to the gel file 
lanes based on the numbers in this column. 

If a lane in the gel is empty, a corresponding empty row must 
appear in the Sample Sheet.
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2 Select this checkbox to mark the corresponding lane in the gel 
image as Used. 

When the GeneScan Analysis Software extracts the sample 
information from the gel file, it creates Sample files only from lanes 
marked Used.

Note Use the Fill Down command from the Edit menu to check 
all lanes as being “Used”.

If you change the setting for this checkbox, the corresponding lane 
setting in the gel file is automatically changed.

3 Name of the Sample file created for the data in this lane. 

The Sample file is saved to the hard disk, into the Run folder next to 
the gel file.

If the data is extracted into a BioLIMS database, then this is the 
name assigned to the database record for that sample file.

4 Name of the sample, which is used by the Data Collection software 
to generate the name for the Sample file.

The following table lists how the names correspond between the 
Data Collection software and the GeneScan Analysis Software:

While this information is often the same as the sample info field, it is 
used by the software for different purposes.

5 Indicates which dye contains the standard.

6 Information about the sample, usually patient or sample ID.

Note This is a required field if the data is to be analyzed using 
the Genotyper software and stored in GenBase.

7 Comments about the sample.

8 Select this checkbox for the GeneScan Analysis Software to 
automatically analyze the Sample files after generating the gel 
image.

Sample Sheet described: (continued)

No. Description

Data Collection software GeneScan Analysis Software

Sample Name Sample Name

Sample Name and lane 
number

Sample 
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9 When this checkbox and the checkbox labeled A are selected, the 
GeneScan Analysis Software automatically prints the Sample file 
information after it automatically analyzes the files.

10 Collection Name—If the samples are extracted into the BioLIMS 2.0 
database, this is the name of the collection that will contain them.

If a collection of that name does not exist in the database, one is 
created. 

See “Editing Collection Information” on page 2-34.

Use the Collection Manager to group samples in any number of 
desired collections (see Appendix E, “Using the BioLIMS 
Database.”

11 Collection Comment—Comment text associated with BioLIMS 2.0 
collection name specified in the Collection Name field described 
above.

12 Collection Owner—Collection Creator text associated with BioLIMS 
2.0 collection name specified in the Collection Name field.

Sample Sheet described: (continued)

No. Description
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Working with the Sample Sheet

Editing Collection
Information

How to Edit Collection Information

Use the pop-up menu in the Collection Name column to edit collection 
information that corresponds to that sample.

Using the Pop-Up Menu

To use the pop-up menu to edit the collection information: 

If you want 
to... Then...

select a 
collection

choose a collection from the pop-up menu

The Collection Name, Collection comment, and Collection 
owner fields use this information.

edit a 
collection

a. Choose the Edit Collection Names pop-up menu.

The Collection Name Editor dialog box appears.

b. Edit the information in the Collection Name, Collection 
Comment, or Collection Owner fields and click OK.

Pop-up menu
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Changing Column
Widths

To change the width of columns in the Sample Sheet:

Editing the Sample
Sheet

To edit the Sample Sheet, you can:

� Type in new text.

Note Use the Fill Down command to apply a change to all the rows in a 
column by entering the text in one of the rows, clicking the column header, and 
then choosing Fill Down from the Edit menu.

� Use the Edit menu commands.

� Select and deselect checkboxes.

add a 
collection

a. Choose the Edit Collection Names pop-up menu. 

The Collection Name Editor dialog box appears (see 
“edit a collection” above).

b. Click Add Row.

c. Enter a Collection Name, Collection Comment, and 
Collection Owner and click OK.

delete a 
collection

a. Choose the Edit Collection Names pop-up menu. 

The Collection Name Editor dialog box appears (see 
“edit a collection” above).

b. Select the row that contains the collection you want to 
delete.

c. Click Delete row and click OK.

To use the pop-up menu to edit the collection information: (continued)

If you want 
to... Then...

Step Action

1 Place the cursor on the divider line to the right of the column title.

2 When the cursor changes to two arrows, hold down the mouse 
button and drag the line to the desired location.
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Printing the
Sample Sheet

There are two ways to print the Sample Sheet:

Installing a New
Sample Sheet

Use the following procedure to replace the original Sample Sheet 
information by installing a new Sample Sheet.

IMPORTANT If you change the Sample Sheet after extracting Sample files 
from the gel file, you must re-extract the Sample files to include the new 
information. Make sure that the checkbox labeled Used is selected for each 
sample that you want to re-extract.

To install a new Sample Sheet:

If you choose from the File 
menu... Then...

Print (� P) the standard Print dialog box 
appears, choose any options, and 
click Print.

Print One when the Sample Sheet is 
active

one copy of the selected information 
is printed, bypassing the standard 
print dialog box.

Step Action

1 Choose Install New Sample Sheet from the Gel menu. 

A directory dialog box appears.

2 Select a new Sample Sheet from the directory dialog box. 

The new Sample Sheet replaces the original Sample Sheet copied 
to the gel file.
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Importing Data to
Sample Sheets

To import data to a Sample Sheet:

Exporting Data
From Sample

Sheets

To export data from Sample Sheets.

Step Action

1 With the Sample Sheet open, choose Import from the File menu. 

A directory dialog box appears.

Note Ensure that the text file you are importing is complete and 
properly formatted for a tab-delimited text file, for example a spread 
sheet program. 

For more information, refer to the ABI PRISM 377 Instrument User’s 
Manual.

2 Select a text file from the directory dialog box and click Open. The 
data in the Sample Sheet is replaced by the imported text file.

Step Action

1 With the Sample Sheet open, choose Export from the File menu.A 
directory dialog box appears.

2 Take the following action:

a. Enter a name for the text file.

b. Choose a folder location to save the file and click Save.
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About Displaying Regions of Off-Scale Data

Why Displaying
Off-Scale Data is

Important

Off-scale data refers to raw fluorescent signals that exceed the linear 
dynamic range of the CCD camera detection system. A data point is 
off-scale when the raw fluorescent signal is 8,191 rfu. Peak quantitation 
of off-scale data is not accurate; this includes both peak area and peak 
height. Additionally, the matrix file may not be accurately applied, often 
resulting in pull-up peaks and poor baselining.

Off-Scale
Detection and

GeneScan

The off-scale detection features of the GeneScan Analysis Software 
identify and flag such data points in the bands of a gel image and the 
peaks of an electropherogram. However, these features must be used 
in conjunction with “suppress left-right averaging” in Data Collection 
(refer to Setting Preferences, General Settings of chapter 4 in the 
ABI PRISM 377 User’s Manual) in order to detect all instances of 
off-scale data.

Displaying
Off-Scale Data

Displaying Off-Scale Data In the Gel Image

Displaying Off-Scale Data In the Electropherogram

Pre-Averaging Offscale Detection must be selected when extracting 
lanes for accurate displays of off-scale data in electropherograms. 
During the extraction process, each data point used to generate an 
average value for a scan number (i.e., channel averaging) is compared 
to the off-scale value of 8191.

Note If you extracted a sample file with the Pre-Averaging Offscale 
Detection checkbox selected, then pre-averaging has a value of zero in the 
Sample Info View.

Take this action Description

Click the OS button in the Gel File 
window to display where the data 
went off-scale data in the gel image.

Note To see off-scale portions in 
the gel image, click the Vertical 
Expand button. The resolution of the 
full display is low and does not show 
the off-scale data.

Each pixel that is off-scale is 
displayed as a white dot. 

The other colors in the gel are 
turned off. 

When finished viewing the off-scale 
data, turn on the other colors by 
clicking each color button or by 
clicking the OS button again to 
deselect it.



How to Process and Edit the Gel File 2-39

How Pre-Averaging Offscale Detection Works

The following table lists how the Pre-Averaging Offscale Detection 
feature identifies off-scale data points:

About Flat Topped Peaks

An additional feature is peaks that contain off-scale data points are 
drawn in the electropherograms as “flat topped.” That is, the top section 
of the peak is flat rather than pointed (see “Electropherogram 
Displaying the Flat Topped Effect” on page 2-42). 

This feature may be seen when the data is analyzed with no or light 
smoothing; the flat topped peaks may not be apparent with heavy 
smoothing. Choose Analysis Parameters from the Settings Menu (see 
“Smooth Options” on page 5-20).

If... Then...

each data point used in averaging is 
less than 8191 rfu (relative 
fluorescent units)

the peak in the electropherogram is 
not off-scale and appears normal.

any one of the data points used in 
the averaging is 8191 rfu

no averaging takes place and 8191 
rfu is written for that scan number of 
that lane. 

In the electropherogram, the 
off-scale regions are displayed by 
drawing red vertical regions where 
the off-scale data is present. 

How to Display the Red Regions
a. Choose Preferences from the 

Settings menu and Results 
Display from the submenu. 

b. Select the checkbox labeled 
“Show Offscale Regions.” 

Note You can choose Hide/Show 
Offscale Regions from the View 
menu if the checkbox labeled Show 
Offscale Regions is not selected.
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Gel File Window
Example

The following is an example of off-scale data displayed in a Gel File 
window. Each white line contains off-scale data points.

Off-scale
data
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Electropherogram
Examples

The following are two examples of off-scale data displayed in 
electropherograms. Each red bar/region indicates an off-scale data 
point.

Electropherogram Displaying Off-Scale Data

Note Choose the Zoom In command from the View menu to more clearly 
show the areas of off-scale data.

Off-scale data
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Electropherogram Displaying the Flat Topped Effect

The off-scale peaks in the zoomed-in electropherograms illustrate the 
flat topped effect. The second electropherogram has the red bars 
removed.

Flat topped
peaks

Red bars
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Working with Lane Markers

Introduction When the GeneScan Analysis Software first opens a gel file, it adds 
lane numbers, lane markers, and tracker lines to the gel image. In most 
cases, if you used a good gel for your run and the run settings are 
correct, the gel file should be properly tracked. If, however, the tracking 
is incorrect because the signal is weak and the tracker missed a lane, 
you might need to make some changes.

Topics in This
Section

This section includes the following topics:

For this topic See page

Moving Between Lanes and Channels 2-44

Using Control Points 2-45

Adding and Deleting Control Rows 2-46

What Marking Lanes as Used/Unused Means 2-47

Marking Lanes as Used or Unused 2-47

Moving Misplaced Lane Markers 2-48

Lane Marker Rules 2-50

About Marking Lanes for Extraction 2-50

Marking All Lanes for Extraction 2-51

Unmarking All Lanes for Extraction 2-51

Marking a Single Lane for Extraction 2-52

Unmarking a Single Lane for Extraction 2-52
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Moving Between
Lanes and
Channels

The following table lists how to move between lanes and channels:

If you want to move... Then...

quickly from one lane to the 
next lane

You can take the following action:

the location of a selected 
lane by one channel

You can take the following action:

� Click the control point and drag, or

� Use the Arrow keys.

Note Pressing the Option key while using 
the Arrow keys moves the control point in 0.1 
channel increments.

a lane segment Use the arrows to move the segment.

from one tracker line 
segment to the next 
segment

You can take the following action:

To move... Then...

the lane click the Lane 
marker of the lane 
you want to move.

one lane to the 
right

press the Tab key.

one lane to the left press the Shift-Tab 
key.

To move... Use the...

up one segment Up Arrow key.

down one line 
segment

Down Arrow key.
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Using Control
Points

When a gel is tracked, the tracker places a tracker line with spline 
control points over the strongest signals for its lane. Use the control 
points to control shape and position the splines. When a control point is 
selected it appears as a filled in square.

The following table lists how you can use the control points: 

If you want to... Then...

move a single control point � Click the control point and drag, 
or

� Use the Arrow keys.

Note Pressing the Option key 
while using the Arrow keys moves 
the control point in 0.1 channel 
increments.

select an entire row click one of the red triangles at the 
sides of the gel view.

Use the Right or Left Arrow keys to 
move all the control points in that 
direction.

select multiple control points draw a box around a set of control 
points.

All the control points that you drew a 
box around become enabled.

Use the Arrow keys to move all the 
control points.

Control point

Red triangle
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Adding and
Deleting Control

Rows

To add and delete control rows:

move up or down the control points 
on the spline

use the Arrow keys.

move forward (right) a lane

Note When moving forward the 
control point is deselected.

press the Tab key.

move left (backwards) a lane

Note When moving backwards 
the control point is deselected.

press the Shift-Tab key.

If you want to... Then...

If you want to... Then...

add a control row a. Place the arrow cursor outside the image (left or 
right side) and press the Option key.

The cursor changes to a symbol and a horizontal 
line will be displayed across the gel image.

b. Click the mouse button to add a control row at 
the desired location.

Place arrow cursor on left or right side
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What Marking
Lanes as

Used/Unused
Means

The GeneScan Analysis Software only tracks a lane and extracts 
sample data if the lane is marked Used in the Gel Sample Sheet. When 
a lane is marked Used, its lane marker (�) is colored blue, white, or 
yellow. All unused lanes have gray lane markers.

By marking lanes as Used or Unused, you specify which lanes contain 
sample data. This allows the software to correctly number the Used 
lanes and put the extracted sample data from each lane into the correct 
Sample file. It also ensures that Sample files are generated from only 
the Used lanes, and not from empty lanes.

Marking Lanes as
Used or Unused

Note Using any of these three methods to mark a lane used or unused 
changes the setting in both the gel image and the Sample Sheet.

The three ways to mark a lane as used or unused are by:

� Clicking the lane marker, then choosing Mark Lane Used/Unused 
from the Gel menu.

� Holding down the � key while clicking the lane marker.

� Clicking the Sample Sheet button to open the Sample Sheet that is 
attached to the gel file, and then selecting or deselecting the Used 
checkbox for the lane.

delete a control row a. Option-click once on the control row triangle that 
you want to delete. 

The following dialog box appears.

 

b. Click OK.

If you want to... Then...

Lane marker
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Moving Misplaced
Lane Markers

The following procedure describes how to move misplaced lane 
markers so that the lane numbers are properly aligned with the actual 
sample lanes. The lane data is written to the correct files with the 
Sample files are regenerated.

To move misplaced lane markers: 

Step Action

1 Inspect the gel image for incorrectly labeled lanes.

For example, in the following illustration, the GeneScan Analysis 
Software missed the faint signals from lane #25. As a result, lanes 
#26–36 are mislabeled, and the lane #36 marker is over an unused 
area to the right of the lanes.

Missed lane #25
has no marker

Lane #36 marker
is not over a 
lane
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2 Click the incorrectly placed marker to select it (the selected marker 
has a red border), and while holding down the mouse button, drag 
the lane marker to the correct location.

All the affected markers are renumbered accordingly.

Lane markers always remain in numerical order from left to right 
and are attached to their respective tracker line within a few 
channels to either side.

For example, if you drag the #36 marker (in the preceding 
illustration) to the real lane 25, lanes #25–36 all become correctly 
marked (as shown in the figure below).

To move misplaced lane markers: (continued)

Step Action

Lane #36 marker
is now above 
right-most lane of
gel

Lane #25 now
has a marker
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Marking and Unmarking Lanes for Extraction

Lane Marker
Rules

The GeneScan Analysis Software marks lanes according to the 
following rules:

About Marking
Lanes for

Extraction

During the extraction process, GeneScan Analysis Software only 
extracts data from gel lanes that are marked for extraction. This allows 
you to control which lanes to extract when using the Extract Lanes 
command.

For more information, see “Extracting Data Without Changing the 
Current Tracker” on page 2-64.

If... Then... Using...

the lane is identified 
with sample names in 
the sample sheet of the 
Data Collection 
software

it is automatically 
marked as Used.

blue markers

the lane is unidentified it is marked as Unused. gray markers

you are opening a gel 
file for the first time

all Used lanes are 
marked for extraction.

white markers

you have extracted the 
lanes

each lane is unmarked 
for extraction.

blue markers

you have edited a lane it is automatically 
marked for extraction.

white markers

the lane was inferred 
by the Tracker 
software. 

the lane is marked. orange markers

a lane is modified and 
then extracted and its 
edited tracking 
information is not 
saved to a gel file

this serves as a 
warning that the latest 
generated sample 
does not reflect the 
saved tracking 
information.

yellow markers



How to Process and Edit the Gel File 2-51

Marking All Lanes
for Extraction

To mark all lanes for extraction:

Unmarking All
Lanes for

Extraction

To unmark all lanes for extraction:

From the Gel menu choose... Result

Mark All Lanes for Extraction The color of all markers for Used 
lanes changes to white.

If you choose the Extract Lanes 
command, the GeneScan Analysis 
Software uses the current tracker 
line location to extract the data in all 
Used lanes and puts the extracted 
data in new sample files.

Step Action

1 Select Unmark All Lanes For Extraction from the Gel menu.

The color of all the lane markers changes to blue.

2 You can take the following action.

To... See...

extract all lanes marked as 
Used

step 2 on page 2-65.

remark selected lanes for 
extraction

“Marking a Single Lane for 
Extraction” on page 2-52.
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Marking a Single
Lane for

Extraction

To mark only selected lanes or to extract a lane that was not 
automatically extracted:

Unmarking a
Single Lane for

Extraction

To unmark a lane that is marked for extraction:

Step Action

1 Click the lane marker you want to mark for extraction.

2 There are two ways to mark a single lane for extraction:

You can either... Result

choose Mark Lane for 
Extraction from the Gel menu

The color of the lane marker 
changes to white.

When you choose the Extract 
Lanes command, the 
GeneScan Analysis Software 
uses the current tracker line 
locations to extract the data in 
this and other similarly marked 
files, and puts the extracted 
data into new Sample files.

press the Option key and click 
the lane marker

Step Action

1 Click the lane marker for the lane that you want to unmark.

2 There are two ways to unmark a single lane for extraction:

You can... Result

choose Unmark Lane for 
Extraction from the Gel menu The color of the lane marker 

changes to blue.press the Option key and click 
the lane marker
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Working with Tracker Lines

Topics in This
Section

This section includes the following topics:

Hiding/Showing
Tracker Lines

The following table lists how to hide and show tracker lines. The first 
time the GeneScan Analysis Software opens a gel file, tracker lines are 
added to the gel image.

Topics See page

Hiding/Showing Tracker Lines 2-53

Why Positioning Each Lane is Important 2-53

Causes to Misinterpreting Lane Positions 2-54

Verifying Optimal Channel Tracking 2-55

Reviewing Tracker Lines 2-55

Moving Tracker Lines 2-56

Deselecting a Lane 2-56

To... Then...

turn off the tracker lines choose Hide Tracker Lines from the Gel Menu.

All unselected tracker lines disappear.

If a lane is selected, the white tracker line for that 
lane remains visible.

turn on the tracker lines choose Show Tracker Lines from the Gel menu.

The following table lists how all the tracker lines 
are displayed.

display one tracker line click the lane marker (®) for the tracker line you 
want to view.

The unselected tracker lines are greyed out.

If... Then...

no lane is selected all lanes are grey.

a lane is selected that lane is white and 
all the other lanes are 
grey.
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Why Positioning
Each Lane is

Important

The GeneScan Analysis Software normally calculates the data values 
for each lane by averaging the data from selected channels.

Unless each lane is positioned at the optimum channel of the fragment 
band, the resulting calculations for peak height and peak area may be 
incorrect. Size calling, however, is still correct.

Causes to
Misinterpreting

Lane Positions

The following table lists the possible conditions that may cause 
automatic tracking to misinterpret lane positions or fail to follow the path 
of a lane completely.

Condition Result

Weak signals � Causes the software to completely miss or be 
unable to follow a lane, especially if the gel ran 
abnormally. 

� Although the software creates a track for each 
Used lane on the gel, the tracker lines might be 
incorrectly placed, indicating lane positions that 
do not exist or that are located elsewhere.

Gels that contain 
extremely bent 
lanes

� Causes the software to lose track of a lane at 
some point along the lane’s path. 

� Make identification of lane positions difficult.

Failure to complete 
the sample sheet

� The software uses the Used lane information to 
determine if what is found corresponds to what 
was loaded according to the Sample Sheet.

� If too few or too many lanes are marked Used, 
then the software must guess at which lanes to 
throw out and which to keep.

Wrong or bad 
matrix

The software needs a proper matrix to determine the 
centers of the bands of the gel.
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Verifying Optimal
Channel Tracking

To verify optimal channel tracking, examine peak heights in the Slice 
View of the Gel File window. These peaks represent the selected lane 
and show the peak intensity.

Reviewing Tracker
Lines

To review tracker line placement:

If the lane is... Then...

correctly tracked the white tracker line should appear in the middle of 
each band.

optimally located you may need to adjust the line and re-extract the 
affected lane.

For more information, see “Tracking and Extracting 
Data” on page 2-61.

Step Action

1 In the Gel File window, click the lane marker for the lane you want 
to review.

Note From the currently selected lane, you can also press the 
Tab key to move right, or press Shift-Tab to move left.

2 Inspect the placement of the tracker line on the lane.

� Does the tracker line seem to follow the brightest part of the 
lane (usually the center) for the full length of the lane? 

� Does the lane drift to the side while the tracker line does not? 

3 Inspect the Slice View of the lane data.

� Are the raw data peaks high enough for the full length of the 
lane? 

� Are some peaks very low because the tracker line is not 
located correctly on the lane?
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Moving Tracker
Lines

Tracker lines can be moved in the following ways:

Deselecting a Lane To de-select an edited lane:

To move... Then...

the line over one channel a. Click the lane marker for the tracker line 
you want to move.

The lane marker becomes outlined in red, 
and the tracker lines for all other lanes 
become hidden or grayed out. 

b. Press the Left Arrow or Right Arrow key 
to move the line over one channel.

selected lines to the right choose Force Selected Lanes to the Right 
from the Gel menu.

the line in channel 
increments of 0.1

a. Click the lane marker for the tracker line 
you want to move.

b. Press the Option key and either the Left 
or Right Arrow.

In the lane marker area at the top 
of the window.... Result

click the background (between the 
diamonds that mark the lanes) to 
deselect the lane marker.

If... Then...

all tracker lines 
are displayed

all lines 
become grey.

all lines are 
hidden

the deselected 
line becomes 
hidden.
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Interpolating Tracker Lines

Why Use
Interpolation

Mode

Use the interpolation mode to adjust the tracking lines between two 
vertical points in the gel image. This mode is very useful to manually 
manipulate the tracker lines for a set of lanes than have anomalous but 
similar migration patterns. Once the two points are chosen, you can use 
the control points on the tracker lines to move the lines.

Procedure To use the interpolation mode:

Step Action

1 With the Gel File window displayed, press the Interpolation button 
to enter interpolation mode.

2 In the region being tracked, click the left-hand lane marker at the 
bottom of the tracker line and then click the right-hand lane marker. 

These two lanes are the interpolation guides and the lanes 
between them are interpolated.

Note While in interpolation mode, all the other lanes are hidden 
and no editing of the tracker lines is allowed.

3 Press the Interpolation button again to exit the interpolation mode.
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4 You can take the following action:

Step Action

Interpolation guides

To... You can...

use the control points to move 
the tracker lanes

� Click the control point and 
drag, or

� Use the Arrow keys.

Note Pressing the Option 
key while using the Arrow keys 
moves the control point in 0.1 
channel increments.

For more information, see 
“Using Control Points” on 
page 2-45.

track and extract lanes choose Extract Lanes from the 
Gel menu. 

For more information, see 
“Tracking Lanes and Extracting 
Data” on page 2-59.
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Tracking Lanes and Extracting Data

Ways to Track and
Extract Data

Note The only action that changes the tracking is choosing the correct comb 
type (see “How to Set Gel Processing Preferences” on page 2-3). Changes to 
the Sample Sheet do not effect the tracking.

There are three ways to track and extract data in the gel file:

If the Run Folder
is Not Specified

Each time the GeneScan Analysis Software tracks and extracts a gel, 
the software looks for the data collection Run folder that is specified in 
the gel file.

To...
Choose from the Gel 
Menu Comment See...

track the gel without 
extracting Sample file 
data

Track Lanes command 
to track the gel file 
based on the current 
Sample Sheet 
information. Both these procedures   

generate the same 
tracking lines.

“Tracking the Gel 
Without Extracting 
Data” on page 2-60.

both track the lanes 
and extract data into 
the Sample files or the 
BioLIMS database 
records

Track and Extract 
Lanes command to 
calculate the tracking 
and then extract the 
Sample file from the 
tracked gel.

“Tracking and 
Extracting Data” on 
page 2-61.

extract Sample file 
data without changing 
the current line 
tracking

Extract Lane 
command each time 
you change the tracker 
line positioning in a 
lane, or the information 
in the Sample Sheet, 
to incorporate the new 
information.

“Extracting Data 
Without Changing the 
Current Tracker” on 
page 2-64.

If the... Then...

� Software does not locate the 
folder, or if the 

� Gel file does not reference one

the program creates a new one in 
the folder that contains the gel file.

The program places new Sample 
files in the Run folder.
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Tracking the Gel
Without

Extracting Data

Why Use this Procedure

Use this procedure to:

� View the results of auto-tracking and, if necessary, to correct any 
tracking errors or tracker line interpolation, before the software 
extracts the lanes and generates Sample files.

� Edit tracker information, and to redraw the lines based on original 
tracking information.

Procedure

Choose Track Lanes from the Gel menu. The Track Lanes dialog box 
appears.

Note Pressing �-period cancels tracking.

You can take the following actions:

If you choose... Then this...

Cancel cancels the tracking operation if you 
do not want to lose the current 
tracking information.

Revert to Straight Tracking adds straight, evenly spaced tracker 
lines to the gel. 

For information about moving these 
lines to the region of the highest 
signal within the lane, see “Working 
with Tracker Lines” on page 2-53.
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Tracking and
Extracting Data

Why Use This Procedure

Use this procedure to automatically track and extract lanes.

IMPORTANT When you Track and Extract a gel file, ensure the Sample 
Sheet associated with the gel file has the checkbox labeled Used selected for 
each sample you want to extract. The software only extracts data from used 
lanes (see “Sample Sheet Example” on page 2-31).

Procedure

Auto-Track Lane

IMPORTANT Before choosing 
Auto-Track Lane, verify that the 
comb type is set correctly by 
choosing Preferences from the 
Settings menu and Gel Preferences 
from the submenu.

places a tracker line with spline 
control points over the strongest 
signals for its lane.

For information about:

� Setting the lane assignment 
confidence value, see 
“Confidence Threshold text 
entry field” on page 2-10.

� Moving these lines to the region 
of the highest signal within the 
lane, see “Working with Tracker 
Lines” on page 2-53.

If you choose... Then this...

To track and extract the gel file: 

Step Action

1 Choose Track & Extract Lanes from the Gel menu. 

The Track & Extract Lanes dialog box appears.
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2 Use the Over-Write Original Sample Files checkbox as follows:

Note In BioLIMS mode, the file name must be unique. If the file 
name is not unique, then the sample file will not be written to the 
database.

Note If a series of numbered files exist, and you discard one of 
the files and then have the GeneScan Analysis Software re-extract 
that sample, the software adds the first available number to the new 
file. For example, if SAMPLE.1, SAMPLE.2, and SAMPLE.3 exist, 
and you discard SAMPLE.2, GeneScan names the next file 
SAMPLE.2 (not SAMPLE.4).

3 Use the Auto-Analyze after Extract checkbox to Analyze the new 
Sample files after extraction is finished. 

Do not select this checkbox if you want the Sample files extracted 
but not analyzed.

4 Use the Analyze All Files radio button to analyze all the new 
Sample files created from the gel file.

5 Use the Print Results checkbox to print the results for all new 
Sample files after analysis.

6 Choose Use Sample Sheet Settings radio button to analyze and 
print only those files that are marked for analysis and printing in the 
Sample Sheet for the gel file. 

Note Select this option if you want to process only some of the 
new Sample files created from the gel file.

To track and extract the gel file: (continued)

Step Action

If you... Then this...

select the 
checkbox

overwrites any existing Sample files that have the 
same name with the same sample data.

Tracking and extracting the gel file a second time 
without overwriting the original Sample files, creates 
new Sample files with a dot and a number (.#) 
appended to the original names. The number 
increments each time the program creates new 
files.

do not 
select the 
checkbox

preserves Sample file names that already exist and 
create new Sample files for this data.
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7 Click OK.

See the table below for the action you can take.

To track and extract the gel file: (continued)

Step Action

If a project 
is... Then...

open The following dialog box appears.

And you can take the following action:

not open The GeneScan Analysis Software creates a new project 
and adds the new Sample files to it.

To... Click...

add the new Sample files to 
the open project

Use Open Project.

close the project and create 
one for the new Sample files

Close it.

cancel the track and extract 
command

Cancel.



2-64 How to Process and Edit the Gel File

Extracting Data
Without Changing

the Current
Tracker

To extract the data without changing current tracker lines: 

Step Action

1 Choose Extract Lanes (� L) from the Gel menu and the Extract 
Lanes dialog box appears.

Note Press �-period (.) to cancel the Extract Lanes operation.
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2 In the Lane Extraction portion of the dialog box you can take the 
following action:

To extract the data without changing current tracker lines: (continued)

Step Action

Choose... To...

All Used Lanes radio button generate a new Sample file for 
every lane marked Used.

Lanes marked for Extraction 
radio button (white markers)

generate a new Sample file 
only for each lane with a white 
lane marker.

Over-Write Original Sample 
Files checkbox

replace the old files with the 
newly generated files.

If you deselect this checkbox, a 
number is appended to the 
name for each newly generated 
file, and the original files are 
preserved.

In BioLIMS mode, the file name 
must be unique. If the file name 
is not unique, then the sample 
file will not be written to the 
database.
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3 In the Project File portion of the dialog box you can take the 
following action:

4 When all of the information in the Extract Lanes dialog box is 
correct, click OK to begin extracting data. 

To extract the data without changing current tracker lines: (continued)

Step Action

Choose... To...

Add Sample Files to Project 
checkbox

� Create a new project, 
choose Create a New 
Project from the pop-up 
menu. 

� Use an open project, 
choose Use the Open 
Project from the pop-up 
menu.

Auto-Analyze New Sample 
Files checkbox

automatically analyze the new 
Sample files after extraction is 
finished.

Deselect this it you want the 
Sample files extracted but not 
analyzed. This option is only 
available if the Sample files are 
being added to a project.

Analyze All Files radio button analyze all the new Sample 
files created from the gel.

Print Results checkbox print the results for all new 
Sample files after analysis.

Use Sample Sheet Settings 
checkbox

analyze and print the Sample 
files as designated in the 
Sample Sheet.

Save Gel After Extraction 
checkbox

save tracker lines and other gel 
file settings to the gel file after 
extracting Sample file data.

If you do not select this option, 
the setting used for the 
extraction are discarded when 
you close the gel file without 
saving.
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How the GeneScan Analysis Software Names Sample Files

Naming Process The following table lists the process the GeneScan Analysis Software 
follows when naming generated Sample files:

If the generated Sample file... Then GeneScan uses the...

has an associated file name in the 
Sample Sheet

file name in the Sample Sheet.

does not have an associated file 
name, but has a sample namea

a. These defaults can be edited in GS Collection. Refer to the ABI PRISM 377 Instrument 
User’s Manual.

lane number of the sample 
concatenated in front of the sample 
name, for example 02_Test1.

does not have an associated file 
name, or a sample namea

lane number of the sample 
concatenated in front of the name 
Sample file, for example 02_Sample 
File.

has the same name as a previously 
generated Sample file

lane number of the sample in 
parentheses concatenated to the file 
name, for example Test1.1, Test2.2.
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Saving Gel Files After Editing Tracking

Introduction The Gel File window keeps track of whether or not you have edited 
data, and when appropriate, will enable the Save command in the File 
menu. You may save all the information, or selected parts of the gel file.

Saving Files After
Editing Tracking

IMPORTANT If you save changes to the gel file, the original tracking 
information is overwritten. You can retrieve the originally calculated tracking only 
by choosing Track or Track & Extract Gel from the Gel menu to retrack the gel. 
See “Tracking Lanes and Extracting Data” on page 2-59.

You have the following options:

For information regarding saving selected portions of gel files and 
archiving gel files, see “Saving Gel Files” on page 8-4.

If you... Then...

choose the Save command The contents of the Gel File window 
are saved to the gel file.

select the checkbox labeled Save 
Gel after Extraction in the Extract 
Lane dialog box

It is not necessary to use the Save 
command to save the gel file.
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Analyzing Sample 
Files 3
Introduction

In This Chapter Topics in this chapter include the following:

Topics See page

About Sample Files 3-2

Opening Sample Files 3-4

About The Sample File Window 3-5

Sample Results View 3-6

Sample Info View 3-8

Size Curve View 3-13

Raw Data View 3-15

EPT Data View 3-17

Analyzing a Sample File 3-19
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About Sample Files

What Sample Files
Contain

Sample files contain data generated from the following:

How GeneScan
Generates Sample

Files

The GeneScan® Analysis Software creates Sample files after extracting 
lanes. The information from each lane in the gel file is tracked and 
extracted, and the resulting Sample files are placed in their respective 
sample folder. If you change tracking, lane assignment, or Sample 
Sheet information, you have to regenerate the Sample files.

The software consults Sample Sheet information to determine whether 
a lane is used (contains sample). The lane tracker uses this information 
to assign lane numbers to the tracker lines. In addition, the GeneScan 
Analysis Software only extracts those lanes identified as Used.

Generated from... Using...

lane information 
from gel files

ABI™  373 or ABI PRISM® 377 instruments.

After extracting lanes from a gel file, Sample file data 
can be analyzed as follows:

capillary 
electrophoresis

ABI PRISM® 310 instrument.

Analyze Sample file 
data... For information, see...

directly from the Sample 
file

“Analyzing a Sample 
File” on page 3-19.

from the Analysis 
Control window in a 
project

“Analyzing Sample 
Files: Using the 
Analysis Control 
Window” on page 5-6.



Analyzing Sample Files 3-3

Ways to Generate
Sample Files

There are two ways to generate sample files:

How GeneScan
Analyzes Sample

Files

The GeneScan Analysis Software performs the following steps in 
analyzing Sample files:

Software Instrument Generates

Data Collection 
software

ABI PRISM 310 Sample file for each 
injection.

GeneScan Analysis 
Software

ABI 373 or 
ABI PRISM 377

Sample file for each 
lane.

Step Action

1 Processes the raw data signals to generate analyzed data signal 
and then uses the analyzed signals to detect the signal peaks 
associated with DNA fragments.

2 Performs size calling by identifying the peaks of the in-lane size 
standard found in each sample.

3 Determines the fragment size of each experimental peak within the 
sample based on the size calling curve generated using the size 
standard peaks, the selected size calling method, and by 
comparing it to the pre-defined size standard file.

The algorithmic steps of the process from raw data to analyzed 
data are as follows: 

� Multicomponenting.

� Baselining.

� Smoothing, if any.

� Peak detection.
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Opening Sample Files

Introduction Sample files can be opened as separate files outside of projects, and 
display related information about each Sample file.

For information on opening Sample files from within:

� Projects, see “Accessing Sample Files” on page 5-6.

� BioLIMS™, see “Switching Between Sample File and BioLIMS 
Mode” on page E-10.

Procedure To open a Sample file as a separate file:

If you are interested in... Then...

one or two Sample files it is often more convenient to open 
Sample files individually and analyze 
or view the data without or opening 
an entire project.

multiple Sample files use a project.

Step Action

1 Choose Open from the File menu. 

The Open Existing dialog box appears.

Note You can also double-click the Sample file name in the 
Finder. If the GeneScan Analysis Software is not running, the 
software starts and opens the Sample file.

2 Click the Sample icon. A directory dialog box appears.

3 In the dialog box, find and select the Sample file that you want to 
open.

4 Click Open. The Sample File window appears. See “About The 
Sample File Window” on page 3-5.
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About The Sample File Window

What it Displays You can use the different display modes in the Sample File window to 
review the analyzed and raw data, and all pertinent data collection, 
sizing and Sample description information from a single window. The 
Sample Results view appears as the default.

Five Views The five views of the Sample File window are:

View See page

Sample Results view 3-6

Sample Info view 3-8

Size Curve view 3-13

Raw Data view 3-15

EPT Data view 3-17
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Sample Results View

What it Displays The Sample Results View displays the Sample file’s analyzed data in 
both electropherogram and tabular data form.

Displaying the
View

The following table lists ways to display the Sample Results View:

Sample Results
View Example

The following is an example of the Sample Results view:

To display the view... Do this...

from the Sample file 
window

� Click the button for the Sample Results view 
at the bottom left of the Sample file window, 

or, 

� Choose Sample Results (� E) from the 
Sample menu.

from a project window a. Select a sample or multiple samples in the 
Analysis Control or the Results Control 
window.

b. Choose Sample Results from the Sample 
menu.
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Description of
Columns

The following table describes the columns in the above figure:

Differences From
the Results Display

The Sample Results view displays the same electropherogram and 
tabular data as the Results Display, with the following differences:

� One Sample file displayed.

� Show or hide dye/sample data by clicking the buttons below the 
electropherogram.

� Cannot display legends.

� Cannot use custom plot colors.

This column Identifies

Dye/Sample Peak � Dye color.

� Peak number.

Minutes The time, in minutes, from the start of the run to the 
time the fragment was detected.

Size The number of base pairs in the fragment.

This value is calculated automatically only if you:

� Run the size standard in the same lane or 
injection as the sample, and

� Perform size calling.

Peak Height Signal size.

Peak Area Area of the detected peak.

Data point Data point of the fragment at its maximum peak 
height.

Scan number for ABI 373, ABI 373XL, ABI PRISM 377 
and ABI PRISM 377XL data.
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Sample Info View

What it Displays Displays the following Sample file information:

� Run and data collection information.

� Gel information.

� Sample information—this information can be edited.

� Analysis records.

Displaying the
View

The following table lists ways to display the Sample Info View:

To display the view... Do this...

from the Sample file 
window

� Click the button for the Sample Info view at 
the bottom left of the Sample file window, 

 or, 

� Choose Sample Info (� I) from the Sample 
menu.

from a project window a. Select a sample or multiple samples in the 
Analysis Control or the Results Control 
window.

b. Choose Sample Info from the Sample menu.

The information is organized in five panels. 

Click the triangles to expand or collapse the 
panels to display specific information.
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Sample Info View
Example

The following is an example of the Sample File window in Sample Info 
View:

Description of
Information

The following tables list the information in the Sample Info View:

Run Information

Information found under the 
header Information inserted from

� User name.

� Instrument.

� Data Collection software 
version.

� Run date and start time.

� Run duration.

� Total data points collected.

� ABI PRISM 310 data-collection 
Run file and run information.

� ABI 373 or ABI PRISM 377 gel 
file (data collection Run file and 
run information).

This information is embedded in the 
gel file.
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Data Collection Settings

Gel Information (Polymer)

Information found under the 
header Information is inserted from

� Module File.

� Matrix File.

� Analysis Parameters.

� Size Standard.

� Electrophoresis voltage, 
current, and power (ABI 373 
and ABI PRISM 377 only).

� Run Voltage, Injection Voltage, 
and Injection Duration 
(ABI PRISM 310 only).

� Temperature. 

� Laser power.

ABI 373 or ABI PRISM 377 gel file 
(data collection Run File and run 
information). 

This information is embedded in the 
gel file. 

ABI PRISM 310 data collection Run 
file and run information.

Information found under the 
header Information is inserted from

ABI PRISM 310

� Gel type. Optional (user entered).

� Length to detector. Data Collection information.

� Lot # and expiration date.

ABI 373 and ABI PRISM 377

� Gel type. Optional (user entered).

� Name of gel file. Gel file (data collection Run file).

This information is embedded in the 
gel file.

� Gel percentage and thickness. Optional (user entered).

� Well-to-read (separation) 
distance.

� Number of channels. Gel file (data collection Run file).

This information is embedded in the 
gel file.

� Number of Lanes.
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Sample Information

Analysis Records

� Channel Averaging.

Note Zero (0) indicates use of 
pre-averaging offscale data.

The following is an example of how 
pre-averaging offscale data appears:

Gel processing parameters.

� Range of data points extracted.

Information found under header Information is inserted from

Sample data and comment for each 
dye color.

� ABI PRISM 310 Sample Sheet.

� ABI 373 or ABI PRISM 377 gel 
file (Sample Sheet).

This information is embedded in the 
gel file.

Information found under header Information is inserted from

Date and time each color was 
analyzed, and more panel-display 
arrows.

Analysis information.

Information found under the 
header Information is inserted from

Extraction method Displayed 

3 channel averaging 3

3 channel averaging 
with pre-averaging 
offscale

30

3 channel 
averaging-weighted

- 3

3 channel 
averaging-weighted, 
pre-averaging 
offscale

- 30
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Dyes Within Analysis Records

Information found under header Information is inserted from

� Analysis parameters file and 
range analyzed.

Analysis Settings.

� Whether baselined or 
multicomponented.

� Data smoothing.

� Peak detection threshold and 
minimum half-width.

� Size standard file. Analysis Control window.

� The dye color used for the 
standard, Sizing method, and 
range.

� Standard peak detection 
threshold.

Analysis Settings.

� Split Peak correction.

� Total number of peaks: found in 
sample & dye standard, defined 
in standard matched with 
standard peaks.

Analysis results.
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Size Curve View

What it Displays Displays sizing curves for Sample files. The size curve is a measure of 
how well the internal size standard matches the standard definition, and 
whether or not it is linear.

Displaying the
View

The following table lists ways to display the Size Curve View:

To display the view... Do this...

from the Sample file 
window

� Click the Size Curve button on the lower left 
of the Sample file window  or 

� Select Size Curve (� U) from the Sample 
menu.

from a project window a. Use the following table to select a sample or 
multiple samples in the Analysis Control or 
the Results Control window.

b. Choose Size Curve from the Sample menu. 

For each selected sample, a Sample file window 
opens and displays its Size Curve view.

If you want to... Then...

select a sample click the sample.

you want to select 
several consecutive 
samples

shift-click the first and 
last sample in the 
group you want to 
select.

select several 
samples that are not 
next to each other

�-click the samples.
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What the Size
Curve Displays

The Size Curve view displays two curves, as shown in the figure below. 
For a description of the curves, see “Curves Described” below.

Curves Described The following table describes the curves in the above figure:

Note Sizing errors due to anomalous mobilities are displayed as non-linear.

This curve Represents

Red curve The size calling curve, based on the size calling method 
used to analyze the data.

Black curve The best-fit least squares curve, which the GeneScan 
Analysis Software calculates for all samples, regardless of 
the size calling method. 

This curve is provided to help evaluate the linearity of the 
sizing curve. 

When the sizing curve and best-fit curve match, they 
overlap so you see only the size curve.
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Raw Data View

What it Displays Displays the raw data collected for a sample. Raw data is non-baselined 
and non-multicomponented. This information is stored in the Sample 
file. The gel file does not need to be available.

Displaying the
View

The following table lists ways to display the Raw Data View:

To display the view... Do this...

from the Sample file 
window

� Click the button for the Raw Data view at the 
bottom left of the Sample file window,  
or, 

� Choose Raw Data (� R) from the Sample 
menu.

from a project window a. Select a sample or multiple samples in the 
Analysis Control or the Results Control 
window.

b. Choose Raw Data (� R) from the Sample 
menu.
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Raw Data
Example

The following is an example of the Sample File window in Raw Data 
View:

What to Evaluate Use the Raw Data view to evaluate:

� Problems or noise in the baseline that could result in poor size 
calling.

� Areas with a lower signal may indicate bad tracking. 

� Start and stop points for analysis. 

For information on changing the horizontal (page 7-37) or vertical scale 
of the data (see page 7-38).

Data pointsRelative peak amplitude (signal intensity)
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EPT Data View

What it Displays Displays the electrophoresis power and temperature information 
collected for a sample. This information is stored in the Sample file. The 
gel file does not need to be available.

Displaying the
View

The following table lists ways to display the EPT Data View:

To display the view.... Do this...

from a Sample file 
window

� Click the button for the EPT Data view at the 
bottom left of the Sample file window,  
or 

� Choose EPT Data (� M) from the Sample 
menu.

from a project window a. Select a sample or multiple samples in the 
Analysis Control or the Results Control 
window.

b. Select EPT Data from the Sample menu, or 
click the EPT data button.



3-18 Analyzing Sample Files

EPT Data
Example

The following is an example of the Sample File window in EPT Data 
View:

Colored Lines
Described

The following table describes the lines in the above figure:

Blue line

Green line

Black line

Red line

Line Description

Blue Electric voltage in volts/10

Black Electric power in watts

Red Gel temperature in  °C

Green Electric current in mA (mamp)
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Analyzing a Sample File

Introduction The GeneScan Analysis Software analyzes raw data stored in Sample 
files according to parameters and standards that you select. You can 
use the analyzed data to detect peaks associated with DNA fragments, 
and identify those peaks with an established size standard.

Procedure

To analyze a sample file: 

Step Action

1 Choose Analyze “Sample File Name” from the Sample menu (� Y).

The Analyze Sample file dialog box appears.

2 From the Analyze Sample file dialog box, select one of the following 
options:

Choose... To select...

Dyes to Analyze checkboxes any number of dyes to analyze.

Analyze Parameters pop-up 
menu

from the default parameters or 
any parameter files in the 
folder location specified in the 
application preferences.

Size Standard pop-up menu from the default standard, or 
any standard files in the folder 
location that you specify in the 
application preferences.

Standard Dye pop-up menu the inlane standard dye.
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Installing a New
Matrix File

Use the following procedure to install a new matrix file for the Sample 
file that you want to analyze. 

For information on attaching the new matrix to an ABI 373 or 
ABI PRISM 377 gel file, see “Installing New Matrix Information” on 
page 2-24.

3 After analysis, evaluate the results.

For information on evaluating the results, see Chapter 7, 
“Evaluating Analysis Results.”

To analyze a sample file: (continued)

Step Action

To install a new matrix file: 

Step Action

1 Choose Install New Matrix from the Sample menu.

A directory dialog box appears.

The Folder Preferences settings determine where the GeneScan 
Analysis Software looks for the matrix file. 

For more information, see “Defining Folder Locations” on 
page 5-41.

2 Select the new matrix file in the dialog box and click Open.

A message appears when the matrix is successfully assigned.

3 Re-Analyze the Sample file.

Applying a new matrix file clears previous analysis information, so 
you must re-analyze the file.
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Creating a Project 4
Introduction

In This Chapter Topics in this chapter include the following:

Topics See page

Automatic Analysis and Project Creation Process 4-2

Setting Up for Automatic Analysis 4-4

Using a Project to Manage Sample Files 4-8

Working with Project Files 4-10

Finding Missing Sample Files 4-14

4



4-2 Creating a Project

Automatic Analysis and Project Creation Process

Introduction The following two diagrams illustrate the process of automatic analysis 
and project creation for data from the ABI PRISM® 310 and from the 
ABI™  373 and ABI PRISM® 377 instruments.

Process Using the
ABI PRISM 310

The following diagram illustrates data analysis using the ABI PRISM 310 
instrument.

Collecting 
injection #1

Start 
GeneScan

Analyzing 
Sample file #1

Idle

Add reference to 
Sample file #2
to project

New Project, Add 
Sample file, 
Analyze & Print

Add Sample file 
#1 to Run folder

 Add Sample 
file, Analyze & 
Print

Add Sample file 
#2 to Run folder

Data- 
Collection 
and Analysis 
completed

Run folder 
with 
analyzed 
Sample files

Project with 
all 
references 

Create project and 
add reference to 
Sample file #1

• • •

• • •
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Process Using the
ABI 373 and the
ABI PRISM 377

The following diagram illustrates data analysis using the ABI 373 and 
the ABI PRISM 377 instruments.

Collecting 
gel data

Start 
GeneScan

Processing 
the gel file 
generates 
tracking 

Extracting 
lanes 
generates 
Sample files

Analyzing
adds more 
data to 
Sample files

Add 
Sample file 
#1 to Run 
folder

Add 
Sample file 
#N to Run 
folder

Create project and add 
Sample file references

• • •

Data- 
Collection 
and 
Analysis 
completed

gel 
file

Gel file is created in the 
Run folder during data 
collection

Run folder 
with 
analyzed 
Sample files

Project with all 
references 
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Setting Up for Automatic Analysis

Introduction To set up the GeneScan® Analysis Software for automatic analysis after 
data-collection, you must have previously defined analysis parameters 
and size standards.

For more information see:

� “Defining Analysis Parameters” on page 5-18.

� “Defining the Size Standard” on page 5-31.

Procedure

To set up for automatic analysis after data collection: 

Step Action

Complete the following steps in the data collection software.

1 Set the GeneScan Run default preferences to auto-analyze and 
use the pop-up menu to locate and select the GeneScan Analysis 
Software.

2 In the GeneScan Sample Sheet, for each sample to be analyzed do 
the following:

� Enter the sample name.

This field must be completed for the samples to be active in the 
Injection or Run Sheet.

� Indicate which dye is the standard.

� Select the checkbox labeled Pres (Present) for each 
dye/sample you want auto-analyzed.

� Select any additional checkboxes.

IMPORTANT If you plan to use the Genotyper® software, then 
you must complete the Sample Info box correctly. For more 
information, refer to the Genotyper User’s Manual.
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3 In the Injection List or Run Sheet for each applicable sample, select 
AutoAnalyze, and choose from the appropriate pop-up menus one 
of the following:

� Matrix file.

� Analysis parameters.

� Size standard. 

The following table lists considerations when choosing a size 
standard.

4 Select Auto Print to print automatically.

Complete the following steps in the GeneScan Analysis Software:

1 Take the following action for the ABI 373 and the ABI PRISM 377 
data:

a. Start the GeneScan Analysis Software.

b. From the Gel menu and the Auto-Processing submenu, ensure 
that Auto-Track Gel and Extract Lanes after Auto-Tracking are 
selected.

IMPORTANT Before choosing Auto-Track Lane, verify that the 
comb type is set correctly by choosing Preferences from the 
Settings menu and Gel Preferences from the submenu.

For more information, see “How to Set Gel Processing 
Preferences” on page 2-3.

To set up for automatic analysis after data collection: (continued)

Step Action

If you choose a... Then GeneScan...

Size Standard definition file 
in the Collection Injection 
List or Run Sheet, but you 
do not specify which dye is 
the standard in the Sample 
Sheet

performs analysis using the 
dye specified in the 
Auto-Analysis defaults.

dye as the standard in the 
Sample Sheet, but do not 
specify a size standard 
definition file in the 
Collection Injection List or 
Run Sheet

does not perform size 
calling.
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2 If you are using the Auto-Analysis defaults, choose Auto-Analysis 
Defaults from the Settings menu.

The Auto-Analysis Defaults dialog box appears.

The parameters set in the Auto-Analysis Defaults dialog box apply 
when you have:

� Specified <Analysis Defaults> in the data-collection software.

� Selected the checkbox labeled Always Override Collection 
Settings.

3 Select the checkbox labeled Always Override Collection Settings to 
have the parameters set take precedence over the following files 
specified in the Data Collection software:

� Size standard.

� Analysis parameters.

� Dye standard.

4 Choose a new Size Standard if:

� <Analysis Defaults> is specified for the size standard in the 
data collection settings, or

� To override the specified size standard.

5 Choose the Dye pop-up menu to specify the dye that represents the 
internal size standard you are running with the samples.

6 Choose the analysis parameters you want to use from the 
Parameters pop-up menu.

To use the default parameters, choose <Analysis Parameters>.

To set up for automatic analysis after data collection: (continued)

Step Action
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7 In the Auto-Print section choose, you have the following options:

8 Click OK.

The GeneScan Analysis Software is now prepared to perform 
automatic analysis.

Note The settings that you specify are initial settings. Make two 
or three trial runs, fine tuning the parameters with each run, to 
determine which parameters work the best for a particular protocol.

To set up for automatic analysis after data collection: (continued)

Step Action

Choose... To print...

Show Electropherograms electropherograms.

Select the appropriate radio 
button to specify whether the 
electropherograms for the four 
dyes appear:

� Together in one panel 
(overlaid) or in 

� Separate panels (tiled).

Show Tabular data tabular data.
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Using a Project to Manage Sample Files

What is a Project A project is a file containing references to a set of Sample files that you 
want to analyze and display together. The project contains Analysis 
Control and Results Control windows that allow you to analyze specific 
dye/samples and display the results of analysis.

Why Create a
Project

You can create a new project and add any combination of Sample files, 
allowing you to analyze and display samples from different runs. 

Adding a Sample file to the project sets up a link between the project 
and the Sample file. The file itself is not imported into the project.

For more information, see “Creating a New Project” on page 4-10.

When GeneScan
Creates Projects

The GeneScan Analysis Software creates a project file when Sample 
files are created during automatic analysis.

Note When the GeneScan Analysis Software automatically creates a 
project, the default file name is the same as the gel file.

The following table lists when the GeneScan Analysis Software creates 
a project file:

When using this instrument... A project is created...

ABI PRISM 310 immediately after the first sample 
run.

Note The default project name is 
GeneScan Project - “date”.

ABI 373 and ABI PRISM 377 when the software extracts the lanes 
of the gel file to create the Sample 
files.

Note The default project name is 
the same as the gel with the 
following extension added to the 
end, “.p”.
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Where to Store
Projects

Keep the Sample files in the same location on the hard disk relative to 
the project file so the GeneScan Analysis Software can locate them 
when the project is opened. 

If Sample files are moved and the program does not find them when 
you open the project, see “Finding Missing Sample Files” on page 4-14.
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Working with Project Files

Opening an
Existing Project

To open an existing project:

Creating a New
Project

Step Action

1 Choose Open from the File menu.

The Open Existing dialog box appears.

For information on opening a Sample file from the BioLIMS™ 
database, see “Switching Between Sample File and BioLIMS 
Mode” on page E-10.

2 Click the Project icon. 

A directory dialog box appears.

3 In the dialog box, find and select the project you want to open.

4 Click Open.

The project opens in an Analysis Control window.

To create a new project: 

Step Action

1 Choose New from the File menu. 

The Create New dialog box appears.
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Using the Add Sample Dialog Box

2 Click the Project icon. 

An untitled Analysis Control window appears.

For information on using the Analysis Control window, see 
page 5-4.

3 There are two ways to add files to a project:

To use the Add Sample dialog box: 

Step Action

1 Find the folder containing the samples that you want to add from 
the top scroll box.

To create a new project: (continued)

Step Action

To add... Choose...

sample files you select to the 
open project

Add Sample Files (� B).

The Add Sample dialog box 
appears (see “Using the Add 
Sample Dialog Box” below).

a sample currently open to the 
open project

Add “file name”.



4-12 Creating a Project

Unlocking Sample
Files

If the Sample files added to a project are locked, the GeneScan 
Analysis Software does not allow changes to them. You cannot analyze 
locked files. When you add locked files, an alert appears.

2 You can take the following action:

3 Click Done when you have added all the Sample files.

To use the Add Sample dialog box: (continued)

Step Action

If... Then...

you want to select a single 
Sample file

double-click the file or select 
the file and click Add.

you want to select all the 
Sample files

click Add All.

you want to add a random 
selection of Sample files

double-click each file name.

If the... Then...

Sample files appear in the 
Analysis Control window

see “Analyzing Sample Files: 
Using the Analysis Control 
Window” on page 5-6.

Locked files alert appears (see 
below)

go to “Unlocking Sample Files” 
below.

To unlock locked files:

Step Action

1 Save and close the project.

2 In the Finder, select the applicable Sample files.

3 Choose Get Info from the File menu.

4 In the lower left-hand corner of each Sample Info window, deselect 
the checkbox labeled locked.
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Removing Samples
from a Project

Note A removed Sample file is not deleted from the hard disk. The reference 
is removed from the project.

5 Close the window and reopen the project.

Note If you did not close the project before unlocking the files, 
once the files are unlocked, close and open the project so the 
GeneScan Analysis Software recognizes that the Sample files are 
unlocked.

To unlock locked files:

Step Action

To remove Sample files from a project: 

Step Action

1 Select the file or files in the Analysis Control window or the Results 
Control window that you want to remove.

Note Shift-click to select multiple consecutive file or �-click to 
select multiple files that are not consecutive.

2 Choose Remove Sample Files from the Project menu, or press the 
Delete key.

A warning dialog box appears.

3 Click Remove.
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Finding Missing Sample Files

When are Files
Considered Lost

The project and related Sample files are usually located in the Run 
folder created by the Data Collection software. If the Sample files or the 
project are moved so they are no longer in the same relative position, 
the GeneScan Analysis Software might not be able to locate the 
Sample files when the project is opened. Usually, this only occurs if the 
Sample files are moved to another disk drive, another server on a 
network, or to another disk partition on the hard drive. 

When an Alert
Appears

If the GeneScan Analysis Software does not locate the Sample files 
associated with a project, an alert box appears and the Sample file 
names appear dimmed when the project opens.

Searching for
Missing Sample

Files

You can re-establish the links between the Sample files and the project 
by choosing Find Missing Sample Files from the Project menu and 
choosing one of the following options from the submenu.

Note Version 2.1 and later versions of the software allows you to choose 
how you want to search for missing Sample files.

Searching for missing sample files: 

Choose... If you... Description

Fast Search suspect that the 
GeneScan Analysis 
Software could not 
find the missing 
Sample files because 
they are located on an 
unmounted external 
storage device, or 
diskette.

Once the volume is 
mounted, or the 
diskette containing the 
files is inserted, Fast 
Search finds them 
immediately.

Search a Folder know what folder 
contains the missing 
Sample file.

Specify a folder in 
which to search for 
missing Sample files. 

The GeneScan 
Analysis Software 
then immediately 
locates the Sample 
files and 
re-establishes links to 
the project.
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Re-Establishing
Links

To re-establish the links with Sample files:

Exhaustive Search do not know where 
any of the specified 
missing Sample files 
are located. 

The GeneScan 
Analysis Software 
searches all mounted 
disk drives, and 
available servers. 

When the files are 
found, the software 
re-establishes links to 
the project.

Searching for missing sample files: (continued)

Choose... If you... Description

Step Action

1 Click the dimmed file name to select it.

When the missing file is selected the Find “file name” command 
becomes active. 

The name of the missing file appears inside the quotation marks.

2 Choose Find “file name”.

A file dialog box appears.

3 In the file dialog box, locate the proper folder and file.

4 Click Open or double-click the file name.
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Analyzing Project 
Files 5
Introduction

In This Chapter Topics in this chapter include the following:

Topics See page

Analyzing Project Files: About the Analysis Control Window 5-2

Analyzing Sample Files: Using the Analysis Control Window 5-6

About the Analysis Parameters 5-17

Using Analysis Parameter Files 5-24

About Size Standards 5-29

Defining the Size Standard 5-31

Using Size Standards 5-36

Defining Folder Locations 5-41

5
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Analyzing Project Files: About the Analysis Control Window

Introduction When a project is opened the Analysis Control window appears. The 
Analysis Control window is the main window of a project. You can use 
this window to specify the following for each sample in the project:

� Dye that represents the size standard you ran with the sample.

� Size standard.

� Analysis parameters.

� Specific dyes to be analyzed.

� Optionally, format the document for printing and print the results 
automatically. 

For more information, see “Analyzing Sample Files: Using the Analysis 
Control Window” on page 5-6.

Analysis Control
Window Example

The following is an example of the Analysis Control window:

1

2

7

3 54

6
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Analysis Control
Window

Description

The following table describes the above diagram:

No. Description

1 Use these columns to choose the dye colors to analyze and to 
specify which is the size standard.

2 Diamonds mark the standards.

For more information, see “What are Size Standards” on page 5-29.

3 �-click a dye/sample field to specify that dye/sample as the 
standard.

4 From this pop-up menu, you can choose:

� <Collection Settings>.

� A user-defined size standard.

� Define a new size standard for that sample.

For more information, see: 

5 From this pop-up menu, choose an analysis parameters file.

For more information, see:

6 Double-click the size standard text field or the analysis parameters 
text field to edit the size standard or the analysis parameters.

For more information, see:

Topic See page

About Size Standards 5-29

Using Size Standards 5-36

Topic See page

About the Analysis Parameters 5-17

Using Analysis Parameter Files 5-24

Topic See page

Editing an Existing Standard 5-37

Changing an Existing Analysis Parameters File 5-27
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Customizing the
Display

The following table lists how you can customize the display by changing 
the settings:

Note These preferences also apply to the Results Control window. See 
Chapter 7, “Evaluating Analysis Results.”

Using the Analysis
Control Window

7 A notation appears in this Information Display field when you move 
the cursor over a Sample file name or over a dye color field.

For information on how to customize this field, see “Displaying 
Sample and Dye Information” on page 5-12.

No. Description

To change... Choose... For more information

information 
displayed in the 
information display 
field

Project Options from the 
Settings menu and 
Sample Info Display from 
the submenu.

“Displaying Sample and 
Dye Information” on 
page 5-12.

the sorting of 
sample files

Project Options from the 
Settings menu and 
Sample File Sorting from 
the submenu.

“Setting Sample File Sort 
Order” on page 5-14.

dye Indicator code Preferences from the 
Setting menu and Dye 
Indicators from the 
submenu.

“Setting Dye Indicator 
Preferences” on 
page 5-15.

dye color

To use the Analysis Control window: 

To... Then... Result

select all the samples click the upper-left cell. All the columns in the 
Analysis Control 
window are selected.

select all of one dye 
color

click the column 
heading for that dye 
color.

The column is 
highlighted for the color 
selected.

Click here
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select all four dyes for 
one sample

click the row number. All the colors in the row 
are selected.

change all the 
standards in the size 
standards column to 
the same setting

a. Click the arrow in 
the column 
heading.

b. Choose a file from 
the pop-up menu.

The same size 
standard is displayed 
for all the samples.

change a size standard 
in one of the rows

a. Click the arrow in 
the row.

b. Choose a file from 
the pop-up menu.

The size standard for 
the selected row 
changes.

change all the 
parameters in the 
parameters column to 
the same setting

a. Click the arrow in 
the row heading.

b. Choose a file from 
the pop-up menu.

The same parameter is 
displayed for all the 
samples.

change a parameter in 
one of the rows

a. Click the arrow in 
the row.

b. Choose a file from 
the pop-up menu.

The parameter for the 
selected row changes.

apply a choice to 
selected fields in the 
size standards or 
parameters column

a. Click the row in the 
column containing 
the information 
you want to apply 
and drag down.

b. Choose Fill Down 
from the Edit 
menu.

The value in the 
selected rows changes 
to the value in the first 
row selected.

To use the Analysis Control window: (continued)

To... Then... Result
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Analyzing Sample Files: Using the Analysis Control Window

Introduction This section describes using the Analysis Control window to perform 
the following tasks:

Accessing Sample
Files

There are two ways to access Sample files contained in a project from 
the Analysis Control window. 

Sample files that are dimmed could not be found by the project.

Topic See page

Accessing Sample Files 5-6

Analyzing Sample Files 5-7

Specifying the Format for Printed Results 5-9

Displaying Size Standards and Analysis Parameters 5-11

Displaying Sample and Dye Information 5-12

Setting Sample File Sort Order 5-14

Setting Dye Indicator Preferences 5-15

You can... Then...

double-click a Sample file name

select a Sample file and choose one 
of the five display modes from the 
Sample menu

the Sample file window appears in 
the display mode selected.

If the Sample 
file is... Then that...

open Sample file 
window 
becomes 
active.

not open Sample file 
opens to its 
Sample Results 
view.
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Analyzing Sample
Files

The Analysis Control window allows you to analyze multiple samples 
easily. You choose dyes to analyze, dye standard, size standard, and 
analysis parameters for each Sample file, and then analyze the Sample 
files using these settings. You can also install a new matrix to the 
Sample files.

To analyze Sample files: 

Step Action

1 Click the dye color fields for each sample you want to analyze as 
follows:

2 Identify the sample containing the standard as follows:

A gray diamond appears in the field to identify the dye color as the 
standard.

3 Choose a defined size standard setting from the pop-up menu in 
the Size Standard column as follows:

To... Click the...

select a dye for all samples colored column header for that 
dye.

select all dyes for a single 
Sample file

index number at the left end of 
the row in which the Sample 
file appears.

all dyes for all samples area above the row index 
numbers.

To...  �-click the...

identify each sample that 
contains a standard

colored field that represents 
the standard.

select the same dye as the 
standard for all samples

colored column heading for 
that dye.

To... See...

define a new size standard “Using Size Standards” on 
page 5-36.

edit a size standard “Editing an Existing Standard” 
on page 5-37.

change the available size 
standards in the pop-up menu

“Defining Folder Locations” on 
page 5-41.
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4 To install a new matrix, select a set or all of the samples in the 
Sample File column and choose Install New Matrix from the 
Sample Menu.

5 Choose a parameters setting from the pop-up menu in the 
Parameters column as follows:

6 Select the Print Results checkbox to print the results automatically.

For information on print set-up, see “Specifying the Format for 
Printed Results” on page 5-9.

7 Click Analyze.

To analyze Sample files: (continued)

Step Action

To... See...

use the default analysis 
parameters to specify different 
parameters

“Defining Analysis Parameters” 
on page 5-18.

change the available 
parameters in the pop-up menu

“Defining Folder Locations” on 
page 5-41.

If a field... Then...

contains a small triangle 
(see the figure below)

you have analyzed the samples 
using the currently selected 
size standard and analysis 
parameters.

does not contain a triangle the sample has not yet been 
analyzed with the current 
settings.

Triangles indicate samples were analyzed with the current setting
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Specifying the
Format for Printed

Results

8 The triangle disappears if you

� Select a different size standard or analysis parameters file for a 
dye/sample.

� Modify the currently selected size standard or analysis 
parameters file (or the analysis parameters stored as program 
preferences).

� Specify a different dye color as the standard (move the 
diamond indicator to another dye/sample).

� Assign a new matrix to the Sample file.

9 To verify the results, refer to “Process of Verifying Results” on 
page 7-45.

To analyze Sample files: (continued)

Step Action

To specify the format for printed results: 

Step Action

1 In the Analysis Control window, select the checkbox labeled Print 
Results. 

When this checkbox is selected, the Print Setup button becomes 
active.

2 Click the Print Setup button. 

The Auto Print Setup dialog box appears (see below). 

All the dyes selected for analysis are also selected for printing.
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3 Moving the cursor over a Sample file name or over a dye color field, 
a notation appears in the Sample Information Display field.

4 Click the sample dye color fields to specify any sample you do not 
want to print (see the above figure).

To specify the format for printed results: (continued)

Step Action

Sample Dye color fields

Sample Information Display field
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Displaying Size
Standards and

Analysis
Parameters

Use the Analysis Control window to open, review, or change Size 
Standard and analysis parameters.

To display these files:

5 Choose the format by clicking either or both of the buttons at the 
right of the window.

6 Click OK.

To specify the format for printed results: (continued)

Step Action

Click this button... To print...

electropherograms for the 
samples and dyes selected for 
analysis.

Select the appropriate radio 
button to specify whether the 
electropherograms for the four 
dyes appear:

� Together in one panel 
(overlaid), or in

� Separate panels (tiled).

tabular data.

You can... Then...
For more information 
see...

double click the field 
containing the size 
standard or the 
analysis parameters 
file

the Size Standard or 
Analysis Parameter 
window appears.

� “Using Analysis 
Parameter Files” 
on page 5-24.

� “Defining the Size 
Standard” on 
page 5-31.
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Displaying Sample
and Dye

Information

How to Display Sample and Dye Information

Move the cursor over a dye color field or over a Sample file name field 
to display information about the samples and dyes.

How to Specify the Information Displayed

The following procedure describes how to specify the information 
displayed when moving the cursor over a dye color field or a Sample file 
name field.

To specify the information displayed: 

Step Action

1 Choose Project Options from the Settings menu and Sample Info 
Display from the submenu.

The Sample Info Display dialog box appears.

2 Select the checkboxes in the Dye/Sample Info & Legend section to 
control what appears when you move the cursor over the dye color 
fields in the Control windows.

The following table describes the checkboxes:

If you select this checkbox... This appears...

File Name Sample file name.

Sample Name Name of the sample file from 
the Sample file.

Sample Info Sample information from the 
Sample file.

Comment Comment from the Sample file.
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3 In the Sample File Info heading, select the checkboxes for the 
information that you want to display when you move the cursor over 
the Sample File name field.

The following table describes the radio buttons:

4 Select the checkbox labeled Save as Defaults to have the options 
you choose saved as the default settings.

5 Click OK.

To specify the information displayed: (continued)

Step Action

Select this radio button... To display...

Show User Name user name from the Sample 
file.

Show Instrument Name instrument name from the 
Sample file.

Show Folder Name path and name of the folder 
where the file is located.

Show Gel File name of gel file from the 
Sample file.

Show Run Date run date and start time from the 
Sample file.

Show Creation Date date and time the Sample file 
was created.
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Setting Sample
File Sort Order

Use this option to specify how Sample files are sorted using three 
criteria. If no sorting option is specified, then the program sorts by 
Sample number.

To set Sample file sort order: 

Step Action

1 Choose Project Options from the Settings menu and Sample File 
Sorting from the submenu. The Sample File Sorting dialog box 
appears.

2 Choose from the following items from the pop-up menus:

� File Name.

� Directory.

� Gel Name.

� Sample Number.

� User Name.

� Instrument Name.

� Run Data.

� Creation Date.

� As Added (sorts the files in the order that they were added).

The precedence indicates the sorting level.

3 Select a radio button for each sort to indicate whether ascending or 
descending order.

4 Select the checkbox labeled Save as Defaults to have the options 
you choose saved as the default settings.

5 Click OK.
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Setting Dye
Indicator

Preferences

The following procedure describes how to change the defaults that 
determine what dye colors appear on the screen and on printed results. 
Setting default dye and plot colors sets the colors used for both the 
Control windows and the Results displays.

To set default dye and plot colors: 

Step Action

1 Choose Preferences from the Settings menu and Dye Indicators 
from the submenu. The Preferences window appears.

Note If the Preferences window is already displayed, choose 
Dye Indicators from the pop-up menu.

2 The following table describes the Dye Color and Plot Color 
columns:

3 Use the vertical scroll bar to change the dye color and plot color for 
a fifth dye.

Vertical scroll bar

Item Description

Dye Color 
column

Shows the colors that represent the dyes in the 
Control window lists and the gel display of 
ABI™  373 and ABI PRISM® 377 data.

The dye color is also identified in the left color 
legend in the Results display.

Plot Color 
column

Shows the colors used for plotting the data in 
the electropherograms.
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4 To change a code, type a different character in the appropriate 
entry field in the Code column.

5 To change a color, select a new color from the pop-up menu. 

If you choose Other from the pop-up menu, a color picker appears.

Using the color picker: 

6 Click OK when finished changing dye indicator preferences.

To set default dye and plot colors: (continued)

Step Action

To use the... Then...

scrolling fields click one of the up or down arrows and hold 
down the mouse button.

The new color appears in the New box and the 
Original box retains the original color, until 
clicking OK to accept the new color.

color wheel a. Click the desired color in the wheel.

The new color appears in the New box.

b. Move the insertion point and click again 
until the desired color appears.
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About the Analysis Parameters

Introduction The GeneScan Analysis Software has default analysis parameters that 
are stored as preferences. You can set and use these default analysis 
parameters, or create analysis parameters files to use with specific 
protocols.

Parameters Used
During Automatic

Analysis

During automatic analysis, the GeneScan Analysis Software uses the 
information from the data collection Injection List or Run Sheet window 
to determine which parameters to use. 

If you do not specify the information in the Data Collection software, the 
GeneScan Analysis Software uses the parameters set in the 
Auto-Analysis Defaults (see step 2 on page 4-6).

Specifying Where
Files are Stored

Choose Preferences from the Settings menu and Folder Locations from 
the submenu to specify the folders in which the software automatically 
stores the analysis parameters and size standards files. 

For more information, see “Defining Folder Locations” on page 5-41.
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Defining Analysis
Parameters

Choose Analysis Parameters from the Settings menu to define the 
Analysis Parameters. 

The Analysis Parameters dialog box appears.

Six Analysis
Parameters

There are six Analysis parameters:

Topic See page

Analysis Range Parameter Options 5-19

Data Processing Parameter Options 5-19

Peak Detection Parameter Options 5-20

Size Call Range Parameter Options 5-21

Size Calling Method Parameter Options 5-21

Split Peak Correction Parameter Options 5-22
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Analysis Range
Parameter Options

The following are the Analysis Range parameter options:

Data Processing
Parameter Options

About the Data Processing Parameter Options

The Data Processing parameter options specify how the raw data is 
processed before peak detection and size calling. 

Data Processing Parameter Options Described

Item Description

Full Range radio 
button

Use to analyze all the data collected on the genetic 
analysis instrument for each sample.

This Range 
(Data Points) radio 
button

Enter Start and Stop data point numbers in the entry 
fields in order to specify only a limited range analyzed 
for each sample.

This affects what is displayed in the results display. 
Normally, set the analysis range to start after the 
primer peak.

Note Sample files generated from ABI™  373 or 
ABI PRISM® 377 may have already removed the 
primer peak. This was done by setting the scan range 
for gel image generation to exclude the primer peak.

Item Description

Baseline checkbox Use to automatically adjust the baselines of all 
detected dye colors to the same level for a better 
comparison of relative signal intensity.

When the GeneScan Analysis Software data is sent 
to the Macintosh® computer, during data collection, 
the baseline for each dye is at a different level.

Multicomponent 
checkbox

Use to specify that the GeneScan Analysis Software 
apply a predefined matrix to adjust for spectral 
overlap when it performs analysis.

Although the dyes used to label DNA fluoresce at 
different wavelengths, the spectra overlap to some 
extent. Create a matrix file containing a mathematical 
matrix to correct for this overlap. 

For a description of matrix files and how to create 
them, see Chapter 6, “Making a Matrix File.”
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Peak Detection
Parameter Options

About the Peak Detection Parameter Options

Use the Peak Detection parameter options to specify the minimum peak 
height to be detected for analysis. This, in turn, controls the number of 
peaks analyzed. Peaks falling below the parameters specified appear in 
the electropherogram, but are not analyzed, and no values appear for 
them in the tabular data.

Peak Detection Parameter Options Described

Smooth Options Use to help reduce the number of false peaks 
detected by the GeneScan Analysis Software.

You have the following options:

Item Description

Select... To...

None apply no smoothing.

Select this option if the data has very 
sharp, narrow peaks of interest.

Light provide the best results for normal 
data.

Heavy apply to data from slower runs that has 
very broad peaks.

Choosing this option might reduce 
peak size or eliminate narrow peaks.

Item Description For example

Dye Amplitude 
Threshold

Set the dye amplitude 
threshold at a level that 
allows the software to 
detect peaks, but 
eliminate noise. 

For each dye, the 
GeneScan Analysis 
Software detects peaks 
above the threshold 
entered in the entry 
field. 

If you leave the default 
value of 50, peaks with 
amplitude above 50 are 
analyzed and appear in 
the tabular data. 

Lower amplitude peaks 
still appear in the 
electropherogram, but 
are not analyzed and 
do not appear in the 
tabular data.
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Size Call Range
Parameter Options

About the Size Call Range Parameter Options

Use the Size Call Range parameter options to specify the range of size 
fragment (in base pairs) to be included in the peak tabular data.

Size Call Range Parameter Options Described

Size Calling
Method Parameter

Options

About Size Calling Method Parameter Options

Click a radio button to select the desired size calling method. The 
GeneScan Analysis Software uses these methods to determine the 
molecular length of an unknown fragment.

Size Calling Method Parameter Options Described

Minimum Peak Half 
Width

Defines what 
constitutes a peak. 

Use to specify the 
smallest half peak 
width for peak 
detection.

The range is from 
2 - 99. 

A typical number might 
be 3 for microsatellites, 
or 10 for SSCPs.

If this number is large, 
the software ignores 
noise spikes. 

If the peaks in the data 
are narrow, set the 
value to a low number. 

Experiment with this 
value to determine the 
best number for the 
data.

Item Description For example

Item Description

All Sizes radio 
button

All detected fragments appear in the tabular data.

This Range 
(Base Pairs) radio 
button

Define lower (minimum) and upper (maximum) limits 
of the peaks to include in the tabular data.

Item Description

2nd Order Least 
Squares and 3rd 
Order Least 
Squares

Both Least Squares methods use regression analysis 
to build a best-fit size calling curve.

For more information, see “Least Square Method” on 
page C-2.
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Split Peak
Correction

Parameter Options

About the Split Peak Feature

Under denaturing conditions, certain fragments in the GeneScan 2500 
standard appear as doublets, or split peaks. This standard has labels on 
both stands of the DNA. Under poor denaturing conditions you see split 
peaks. One of the two fragments typically has normal mobility, while the 
other does not. The Split Peak Correction feature allows the software to 
correctly call each of the splits.

Split Peak Parameter Options Described

If you select split peak correction, you will also need to verify or change 
the correction limits. After you decide on a split peak correction method, 
use the same method for all projects to keep size calling consistent.

Cubic Spline 
Interpolation

Forces the sizing curve through all the known points 
of the selected GeneScan size standard. 

For more information, see “Cubic Spline Interpolation 
Method” on page C-4.

Local Southern 
method

Determines the sizes of fragments by using the 
reciprocal relationship between fragment length and 
mobility.

For more information, see “Local Southern Method” 
on page C-5. 

Global Southern 
method

Similar to the Least Squares method in that it 
compensates for standard fragments that may run 
anomalously. 

For more information, see “Global Southern Method” 
on page C-7.

Item Description

Split Peak Correction parameter options: 

Item Description

None No correction for doublets.

GeneScan 2500 Makes the following peak size assignments for 
GeneScan 2500:

� The right peak for all fragments 222, 233, 238, 
286, and 490.

� The left peak for all other splits.

LeftMost Peak Chooses the left peak for every doublet.
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RightMost Peak Chooses the right peak for every doublet.

Correction Limit Set a correction limit if correcting for doublets. 

Set this value slightly larger than the largest split 
observed.

This value (set in scan lines or data points) specifies 
the maximum width of split that should be corrected 
(the difference in scan numbers or data points of the 
positions of the two peaks). 

Split Peak Correction parameter options: (continued)

Item Description
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Using Analysis Parameter Files

In This Section This section contains the following topics:

Analyzing Samples
Using the Same

Analysis
Parameters

To analyze samples using the same analysis parameters:

Topic See page

Analyzing Samples Using the Same Analysis Parameters 5-24

Selecting Different Parameters for Analysis Samples 5-25

Displaying Default Parameters 5-26

Creating Custom Analysis Parameter Files 5-26

Changing an Existing Analysis Parameters File 5-27

Deleting Custom Analysis Parameters 5-28

Step Action

1 If the Analysis Control window is not displayed, then choose 
Analysis Control (� 1) from the Windows menu.

2 Click the arrow in the Parameters column heading and choose 
parameters from the pop-up menu. 

Your menu choice applies to all fields in the column.

Pop-up menu
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Selecting Different
Parameters for

Analysis Samples

To apply separate analysis parameters to selected samples:

3 The pop-up menu contains the following options:

Step Action

Item Description

<Analysis Parameters> Applies the parameters that are 
stored as preferences in the software.

<Collection Settings> Applies the analysis parameters file 
specified in the data collection 
program, which is embedded in the 
Sample file.

Custom parameters that 
are listed at the bottom 
of the menu

These are files that you defined and 
they are located in the parameters 
folder specified in the Folder 
Locations preferences. 

For information on setting the Folder 
Locations preferences, see 
“Specifying File Locations” on 
page 5-42.

Step Action

1 If the Analysis Control window is not displayed, then choose 
Analysis Control (� 1) from the Windows menu.

2 Click the arrow in the Parameters column for the sample that you 
want to change the parameter settings.

A pop-up menu appears.

Pop-up menu
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Displaying Default
Parameters

There are two ways to display the default parameters:

Creating Custom
Analysis

Parameter Files

To create a custom analysis parameter file:

3 The pop-up menu contains the following options:

4 Repeat step 2 and step 3 for each sample.

Note You can also use the Macintosh computer Cut, Copy, and 
Paste commands from the Edit menu.

Step Action

Choose... To...

<Analysis Parameters> apply the parameters that are stored 
as preferences in the software.

Define New display the Analysis Control dialog 
box.

For information on completing the 
fields, see “About the Analysis 
Parameters” on page 5-17.

You can... Then...

choose Analysis Parameters from 
the Settings menu.

Analysis Parameters dialog box 
appears with the default parameters.

For information on defining the 
Analysis Parameters, see 
page 5-18.

double-click <Analysis Parameters> 
from within the Analysis Control 
window.

Step Action

1 Choose New from the File menu.

The Create New dialog box appears.
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Changing an
Existing Analysis

Parameters File

To change an existing analysis parameter file:

2 Click the Analysis Parameters icon. 

The Analysis Parameters dialog box appears.

3 Change the parameters as necessary.

For information on the specific options, see “About the Analysis 
Parameters” on page 5-17.

4 Choose Save (� S) from the File menu.

A dialog box appears.

5 Enter a descriptive name and click Save.

Note Unless you choose a different folder location, the 
GeneScan Analysis Software stores the file in the folder specified 
as the folder location for Analysis Parameters. 

For more information, see “Defining Folder Locations” on 
page 5-41.

The file now appears in the pop-up menu for analysis parameters in 
the GeneScan Analysis Control window. 

You can also select the file in the Data Collection software for 
automatic analysis.

Step Action

Step Action

1 Choose Open (� O) from the File menu.

Note You can also double-click the file name in the Parameters 
column of the Analysis Control window.

The Open Existing dialog box appears.

2 Click the Analysis Parameters icon.

A directory dialog box appears.

3 Select a file that you want to change and click Open.
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Deleting Custom
Analysis

Parameters

To delete a custom analysis parameters file:

4 Make the changes and close the window by clicking the close box.

Step Action

Close box

Step Action

1 Find the file in the folder you specified as the location for the 
analysis parameters files.

Note The custom analysis parameters file is in the folder that is 
normally called the GS Parameters Folder. This folder is inside the 
ABI PRISM GeneScan folder. 

2 Drag the custom analysis parameters file to the trash and empty 
the trash.
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About Size Standards

What are Size
Standards

Size standards are specific DNA fragments of known sizes. After 
defining the peaks of a size standard, the GeneScan Analysis Software 
matches this definition to the internal size standard included with the 
run. The software assigns the defined size values to the appropriate 
peaks of the internal size standard, and uses this information with the 
selected size calling method to size all unknown fragments.

Advantages of
Using Size
Standard

Running an internal size standard results in accurate and precise 
molecular length determination. This is because the internal size 
standard and the unknown fragments undergo exactly the same 
electrophoretic forces. The GeneScan Analysis Software can then 
compensate for band-shift artifacts caused by variations in the gel and 
in the sample from lane to lane or injection to injection.

Size Standards
Provided

Applied Biosystems provides several fluorescently labeled standards, 
which are described in Appendix B. You can also label and use other 
fragments if they better suit the fragment sizes with which you are 
working.

When to Define
Size Standards

Normally, a size standard is defined using the GeneScan Analysis 
Software after running the standard with samples on the instrument. 
The software detects peaks for a selected dye color in a selected 
Sample file and allows you to define the peak sizes. You can save the 
defined standard in a file and use it to automatically analyze other 
samples run with the same standard and under the same conditions.

If Split Peaks
Appear

Split peaks might appear in size standards in which both strands are 
labeled, for example GeneScan 1000 (see page B-8) and GeneScan 
2500 (see page B-10). For some peaks, the two strands migrate at 
different rates when running under denaturing conditions, and they 
appear as two peaks approximately half the height of normal non-split 
peaks. One peak of the two runs is true to size. You should assign a size 
to that peak for the standard definition, and assign zero to the other 
peak.

For more information, see “Split Peak Correction Parameter Options” on 
page 5-22.
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Specifying Where
Files are Stored

Choose Preferences from the Settings menu and Folder Locations from 
the submenu to specify the folders in which the software automatically 
stores the analysis parameters and size standards files. 

For more information, see “Defining Folder Locations” on page 5-41.
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Defining the Size Standard

Two Ways to
Define the Size

Standard

There are two ways to define a new size standard:

Using the New
Command

Topic See page

Using the New Command 5-31

Using the Analysis Control Window 5-34

To use the New command to define a new size standard: 

Step Action

1 Choose New from the File menu. 

The Create New dialog box appears.

2 Click the Size Standard icon. A directory dialog box appears.

3 Select the Sample file that contains the dye standard you want to 
use as the template and click Open.

The Select Dye and Analysis Parameters dialog box appears.

4 Choose from the Dye pop-up menu the code that represents the 
dye label of the size standard in the selected Sample file.
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5 Choose from the Analysis Parameters pop-up menu the analysis 
parameters to use.

The pop-up menu contains the following options:

6 Click OK.

A window appears (see below) showing the electropherogram and 
a table of peaks for the dye color and sample selected. 

You should be able to recognize the peak pattern of the standard in 
the electropherogram.

Note You can only change the peak size value in the right 
column of the table. You cannot change or rearrange the peak 
numbers.

Note If too many peaks appear in the electropherogram or the 
baseline is too high, you might need to adjust the analysis 
parameters. See “Using Analysis Parameter Files” on page 5-24.

The software assigns a number to each peak found in the 
electropherogram in order, from left to right.

To use the New command to define a new size standard: (continued)

Step Action

Item Description

<Analysis Parameters> Applies the parameters that are 
stored as preferences in the 
software.

custom parameters that are 
listed at the bottom of the menu

These are files that you defined 
and they are located in the 
parameters folder specified in 
the Folder Locations 
preferences. 

For information on setting the 
Folder Locations preferences, 
see “Defining Folder Locations” 
on page 5-41.
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7 Specify the peaks of the standards and their sizes as follows:

To use the New command to define a new size standard: (continued)

Step Action

Step Action

a. Click the peak you want to define either in the 
electropherogram or in the table.

Use the Zoom In (� Plus sign) and Zoom Out 
(� Minus sign) commands from the View menu to zoom 
the electropherogram for easier viewing.

b. Type the value for the selected peak in the 
corresponding Size field in the table.

Refer to Appendix B, “GeneScan Size Standards,” for 
values and peaks patterns.

Note Leave a zero in the Size field to ignore a peak 
for the standard definition.

c. Press Return to automatically move to the next size 
standard peak.

If you click a peak... Then the...

in the electropherogram corresponding row in the 
table is highlighted.

number in the table corresponding peak in the 
electropherogram is 
highlighted.
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Using the Analysis
Control Window

8 When you finish defining the peaks, save the size standard by 
choosing Save As from the File menu.

Note You can also click the close box.

9 Type in a descriptive name for the standard and click Save.

Note Run conditions are not stored in the Standard file. Use a 
name that clearly defines the standard for future use.

This file is automatically saved in the Size Standards folder. 

For information on how to define the folder location, see page 5-41.

To use the New command to define a new size standard: (continued)

Step Action

To use the Analysis Control window to define a new 
size standard: 

Step Action

1 Open an existing project or create a new project.

The Analysis Control window should appear. If it does not, choose 
Analysis Control (� 1) from the Windows menu.

2 In the Analysis Control window, find the row that contains the 
sample for which you want to define the standard.

3 In that row, �-click the dye color cell that represents your standard.

A diamond symbol (�) appears in the cell, identifying it as the 
standard.

For information on... See page

opening an existing project
4-10

creating a new project
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4 Click the arrow in the Parameters field of the same row, and select 
an option from the pop-up menu that appears.

The pop-up menu contains the following options:

5 In the same row, click the arrow in the Size Standard field, and 
choose Define New from the pop-up menu.

A window appears showing the electropherogram and a table of 
peaks for the dye color and sample you selected. 

You should be able to recognize the peak pattern of the standard in 
the electropherogram.

6 Follow step 7 on page 5-33 to step 9 on page 5-34.

The name of the standard appears in the following:

� Standard pop-up menu in the Analysis Control window.

� Auto-Analysis settings dialog box.

You can specify in the Auto-Analysis Settings dialog box (or in the 
Data Collection software) that the defined standard be used for 
automatic analysis in future runs. See “Setting Up for Automatic 
Analysis” on page 4-4.

To use the Analysis Control window to define a new 
size standard: (continued)

Step Action

Item Description

<Analysis Parameters> Applies the parameters that are 
stored as preferences in the 
software.

<filename> Applies the settings specified in 
the data collection run file.

custom parameters that are 
listed at the bottom of the menu

These are files that you defined 
and they are located in the 
parameters folder specified in 
the Folder Locations 
preferences. 

For information on setting the 
Folder Locations preferences, 
see page 5-41.
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Using Size Standards

In This Section This section contains the following topics:

Changing the
Number of Peaks

Detected

Use the Analysis Parameters dialog box to change the number of peaks 
detected in the Define New Standard window. 

For information, see “Peak Detection Parameter Options” on page 5-20.

Editing the Size
Standard
Definition

The following procedure describes how to edit the size standard 
definition (<Collection Settings> standard) that is embedded in the 
Sample file. Double-clicking the size standard definition will not open 
the file.

Topic See page

Changing the Number of Peaks Detected 5-36

Editing the Size Standard Definition 5-36

Using the Open Command to Edit an Existing Standard 5-37

Using the Analysis Control Window to Edit an Existing 
Standard

5-38

Deleting an Existing Standard 5-39

Analyzing Samples Using the Same Standard 5-39

Selecting Separate Standards for Samples 5-40

To edit the size standard definition: 

Step Action

1 If the file is on your hard disk, choose Open from the file menu.

The <Collection Settings> does not change.

2 Make any changes to the file.

3 Choose the edited file from the Standard pop-up menu to apply the 
changes.
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Editing an Existing
Standard

The two ways to edit a previously defined standard are by:

� Using the Open Command to Edit an Existing Standard.

� Using the Analysis Control Window to Edit an Existing Standard.

Using the Open Command to Edit an Existing Standard

Step Action

1 Choose Open (� O) from the File menu.

The Open Existing dialog box appears.

2 Click the Size Standard icon.

A directory dialog box appears.

3 Select the standard file that you want to modify.

4 Edit the peak size values by following step 7 to step 9 on 
page 5-34.

5 Choose Save or Save As from the File menu.

You can take the following action:

If you choose... Then the...

Save existing file is replaced.

Save As changes are saved using a file name 
you specify.
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Using the Analysis Control Window to Edit an Existing Standard

Step Action

1 If the Analysis Control window is not displayed, choose Analysis 
Control (� 1) from the Windows menu.

2 Click the arrow in the Standard column for the sample that you want 
to change. 

A pop-up menu appears.

3 Select a size standard from the pop-up menu.

4 Edit the peak size values by following step 7 on page 5-33 to step 9 
on page 5-34.

5 Choose Save or Save As from the File menu.

You can take the following action:

Pop-up menu

If you choose... Then the...

Save existing file is replaced.

Save As changes are saved using a file name 
you specify.
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Deleting an
Existing Standard

The following procedure describes how to delete a user-defined 
standard from the GS Standards Folder so that it no longer appears in 
the Standard pop-up menus. The standard is permanently removed and 
you must re-define to use it again.

Analyzing Samples
Using the Same

Standard

To select the same standard for analysis of all samples:

To delete an existing standard: 

Step Action

1 Switch to the Finder.

2 Locate and open the Current Standards folder.

3 Select the definition file that you want to delete.

4 Drag the file to the trash and empty the trash.

Note You can also drag the standard to another folder for 
storage.

Step Action

1 If the Analysis Control window is not displayed, choose Analysis 
Control (� 1) from the Windows menu.

2 Click the arrow in the Standard column heading and choose a 
standard file from the pop-up menu. 

Your menu choice applies to all fields in the column.

Note Alternatively, you can choose a value from the pop-up 
menu, click the header to select the entire column, and choose Fill 
Down from the Edit menu.

Pop-up menu
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Selecting Separate
Standards for

Samples

To apply separate size standards to selected samples, click the arrow in 
the Standard column for the sample that you want to change (see figure 
below) and a pop-up menu appears. 

For information on using the pop-up menu, see step 3 above.

3 The pop-up menu contains the following options:

Step Action

Item Description

<None> Apply no standard definition.

<filename> Apply the size standard 
specified in the Data Collection 
software, which is embedded in 
the Sample file.

For information on editing this 
file, see “Editing the Size 
Standard Definition” on 
page 5-36.

custom standards that are 
listed at the bottom of the menu

These are files that you defined 
and they are located in the 
parameters folder specified in 
the Folder Locations 
preferences. 

For information on setting the 
Folder Locations preferences, 
see“Defining Folder Locations” 
on page 5-41.

Pop-up menu
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Defining Folder Locations

Introduction The GeneScan Analysis Software looks in the designated folders for 
the: 

� Size Standard file.

� Analysis Parameter file.

� Matrix file. 

When saving one of these files for the first time, the default folder 
locations for saving the files are those same designated folders.

Storing Matrix
Files

Store matrix files, that are intended for use by Data Collection software 
to assign to collection runs, in the ABI Folder. The ABI Folder is located 
in the System folder on the computer on which the Data Collection 
software is installed.

If Data Collection and Analysis are Performed on Different Computers

Make a copy of a matrix and store as follows. This is useful when data 
collection and analysis are performed on different computers.

Note The ABI PRISM® instrument Data Collection software uses the files 
installed by the GeneScan Analysis Software in the ABI folder. When you run 
the analysis software, the program also creates several files (such as a 
Preference file) and an Analysis Log.

Store a copy in the... For use by the...

ABI Folder Data Collection software.

GS Matrix Folder GeneScan Analysis Software.
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Specifying File
Locations

Use the Folder Location preference in the Settings menu to specify 
where the software saves size standards, analysis parameters, and 
matrices. 

These preferences are saved as defaults for subsequent projects and 
Sample files.

To specify file locations:  

Step Action

1 Choose Preferences from the Settings menu and Folder Locations 
from the submenu. 

The Preferences window appears (see below).

Note It is advisable that you use the appropriate folders, that is, 
the GS Standards Folder, the GS Parameters Folder, and the GS 
Matrix Folder.

Note If the Preference window is displayed, choose Folder 
Locations from the Page pop-up menu.
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2 Click a button that shows the folder’s path name. 

A dialog box appears.

3 Take the following action:

a. Find the new location.

b. Highlight the target folder.

c. Click the Select button at the bottom of the dialog box.

4 Take the following action:

To specify file locations: (continued) 

Step Action

If you have... Then...

other folder locations to 
designate

choose another folder from the 
Folder Locations Preferences 
dialog box.

no other folder locations to 
designate

click OK.
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Making a Matrix File6
Introduction

In This Chapter Topics in this chapter include the following:

Topics See page

About Matrix Files 6-2

Process of Creating a New Matrix File 6-7

The Dye Matrix Standard Kits 6-8

Preparing Matrix Standards for the ABI PRISM 310 6-9

Preparing Matrix Standards for the ABI 373 and ABI PRISM 377 6-12

Loading and Running Dye Standards for the ABI PRISM 310 6-13

Loading and Running Dye Standards for the ABI PRISM 377 6-17

Loading and Running Matrix Samples on the ABI 373 (non XL) 6-20

Loading and Running Matrix Standards on the ABI 373 with XL 
Upgrade

6-24

Generating Matrix Sample Files for the ABI 373 and ABI PRISM 
377

6-27

Choosing a Scan Range for the Matrix Calculation 6-29

Generating a New Matrix File 6-32

Saving and Naming the Matrix File 6-34

Assigning the Matrix File to Sample Files 6-35

Evaluating the Matrix File 6-37

Causes for Bad Matrix Files 6-38

6
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About Matrix Files

Introduction There are three dye-labeling chemistries currently available to prepare 
nucleic acid samples for using the GeneScan® Analysis Software on 
ABI PRISM® instruments: 

� Fluorescent NHS-Ester

� Fluorescent dNTP

� Fluorescent Phosphoramidite

Each chemistry has a set of dye labels that fluoresce at different 
wavelengths when excited by a laser.

Matrix File
Definition

Matrix files are mathematical matrices that correct for spectral overlap 
of fluorescent emission spectra data collected from ABI PRISM® 
instruments. 

A matrix file allows you to account for spectral overlap when analyzing 
Sample files.

Multicomponent
Definition

This process of eliminating the bleed-through caused by spectral 
overlaps is called multicomponenting. 

Applying a matrix file to raw data allows you to generate 
multicomponented data.

During data collection on the... The wavelengths are separated...

ABI PRISM® 310 or ABI PRISM® 377, 
377XL, or 96-lane upgrade

by a spectrograph into a known 
spectral pattern across a detection 
system with the sequencer.

ABI™  373 and the ABI™  373 with XL 
upgrade

using a filter wheel.



Making a Matrix File 6-3

Why is a Matrix
File Necessary

A matrix file is necessary because the four or five dyes used to label 
your fragments fluoresce at different wavelengths and may have 
spectral overlaps, as shown below.

When to Create a
Matrix File

Create a matrix file for each dye set used from that particular instrument 
before analyzing fragment data. 

You may have to create new matrix files for different gel compositions or 
unusual run conditions.
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Sample Files Using
Matrix File

The figure below shows an example of data analyzed with and without a 
matrix file. 

You can see that peak data from a Sample file analyzed without a 
matrix file displays the expected peak, along with extra peaks in other 
dye colors, or bleed-through from other dye colors.

Applying a Matrix
File

You can apply a matrix to a gel image or to the raw data within Sample 
files. 

The matrix from a matrix file is installed within a gel file or Sample file 
automatically upon generation during or after a run, or manually from 
within the GeneScan Analysis Software.

When to Assign a
Matrix File

Before you can successfully analyze Sample files using the GeneScan 
Analysis Software, you must make a new matrix file or assign an 
existing one to a set of Sample files. 

Sample file analyzed without a matrix file

Sample file analyzed with a matrix file

If a matrix is installed to the... See page

Gel image during image generation 2-24

Sample file’s raw data during analysis 3-20
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Limitations to
Matrix Files

You can only assign a matrix file to Sample files generated on the same 
instrument, under the same electrophoresis, gel matrix and buffer 
conditions, and using the same dye set.

Note If you are using a fifth dye, then you need to create a new matrix file for 
that dye.

When to Create
New a Matrix File

Create a new matrix file in the following conditions:

� For each dye set:

– NHS-Esters

– Phosphoramidite set

– Fluorescent dNTPs

� Whenever you change the dye set you use to label sample 
fragments, for example if you are using the fifth dye.

� When you use gel materials or buffers with pH values that differ 
greatly from the pH value of the gel material or buffer on which the 
existing matrix files were generated.

� When you use dyes other than those provided by Applied 
Biosystems.

� When you run the same gel on a different instrument.

� When you see multiple unexpected peaks of different colors under 
an expected peak.

� When you recalibrate your CCD camera (ABI PRISM 310 and 
ABI PRISM 377) and the change is greater than 3 pixels from the 
original pixel position.

� When you replace your filter wheel (ABI 373) or CCD camera 
(ABI PRISM 310 and ABI PRISM 377).
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Considerations
Before Making a

Matrix File

The following table lists some of the considerations before making a 
matrix file:

Where to Store
Matrix Files

Store matrix files intended for use by Data Collection software in the 
ABI folder. The ABI folder is located in the System folder on which the 
Data Collection software is installed.

If Data Collection and Analysis are Performed on Different Computers

Make a copy of a matrix and store as follows. This is useful when data 
collection and analysis are performed on different computers.

Note The ABI PRISM® instrument Data Collection software uses the files 
installed by the GeneScan Analysis Software in the ABI folder. When you run 
the analysis software, the program also creates several files (such as a 
Preference file) and an Analysis Log.

Consideration Comment

How much dye matrix standard to 
load?

With the ABI 373 or ABI PRISM 377, 
loading more than 3-µL, produces 
too much signal. 

Any amount that results in a signal 
over 4,000 FU’s is too strong.

Which lanes to load with the dye 
matrix standards?

For gel electrophoresis, load the 
matrix standards with an empty lane 
between each sample to avoid 
contamination of the individual dyes 
by residual material leaking adjacent 
samples.

After generating a gel image, for 
ABI 373 and ABI PRISM 377 
instruments, check that the tracking 
of the gel file is adequate.

 

Store a copy in the... For use by the...

ABI Folder Data Collection software.

GS Matrix Folder GeneScan Analysis Software.
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Process of Creating a New Matrix File

Process Diagram The following diagram shows the procedure for making a new matrix 
file:
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Steps to Creating a
New Matrix

The following table lists the steps to creating a new matrix file:

The Dye Matrix Standard Kits

Table of Kits Applied Biosystems provides Dye Matrix Standard kits that are 
designed to test and define the multicomponent matrices for specific 
dye sets. Tubes containing matrix standards for each of the four 
different dye colors (blue, green, red, and yellow) are available in the 
each of these kits:

Step Process See page

1 Preparing Matrix Standards for the ABI PRISM 310. 6-9

2 Preparing Matrix Standards for the ABI 373 and 
ABI PRISM 377.

6-12

3 Loading and Running Dye Standards for the 
ABI PRISM 310.

6-13

4 Loading and Running Dye Standards for the 
ABI PRISM 377.

6-17

5 Loading and Running Matrix Samples on the ABI 373 
(non XL).

6-20

6 Generating Matrix Sample Files for the ABI 373 and 
ABI PRISM 377.

6-27

7 Choosing a Scan Range for the Matrix Calculation. 6-29

8 Generating a New Matrix File. 6-32

9 Saving and Naming the Matrix File. 6-34

10 Assigning the Matrix File to Sample Files. 6-35

11 Evaluating the Matrix File. 6-37

Kit Part number

Dye Primer Matrix Standard Kit 401114

Fluorescent Amidite Matrix Standards 401456

Fluorescent dNTP Matrix Standards 402792
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Preparing Matrix Standards for the ABI PRISM 310

About Formamide
and Samples in

Formamide

! WARNING ! CHEMICAL HAZARD. Formamide is a known 
teratogen. It can cause birth defects. Wash thoroughly after handling 
formamide. Wear appropriate protective eyewear, clothing, and gloves. 
Obtain a copy of the MSDS from the manufacturer. Wash thoroughly after 
handling formamide.

IMPORTANT Use the same matrix standards that you used for your 
GeneScan Analysis Software run.

The protocol uses formamide as a sample preparation reagent. Fresh 
formamide must be deionized and aliquotted into smaller volumes for 
storage. Each aliquot should be adequate for about one week’s work.

Store aliquots of formamide at -20°C for up to three months. Formamide 
stored at 4°C is good for about one week.

At room temperature, samples in formamide are stable for a maximum 
of 48 hours. 

Although not recommended on a routine basis, you can keep samples 
prepared in formamide frozen for no more than three days, with no 
detectable loss in resolution, before running on the ABI PRISM® 310 
Genetic Analyzer.

Deionizing
Formamide

To deionize formamide:

Step Action

1 Mix 50-mL of formamide and 5 g of ion-exchange resin (AG501 X8 
from BioRad is recommended).

2 Stir the mixture at room temperature for 30 minutes.

3 Check the pH. It must be 7.0–9.0.

4 If the pH… Then…

is in the proper range filter the mixture through a 2-micron 
filter.

is not in the proper range a. Decant the formamide into a 
beaker with 5g of resin.

b. Stir at room temperature for 30 
minutes.

c. Check the pH; it must be 7.0 – 
9.0.
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Preparing the
Formamide-Size

Standard Mix

To ensure reproducibility of results for all samples, prepare the 
formamide-size standard mix using the 12:1 ratio of reagents stated in 
the procedure below.

IMPORTANT The formamide-size standard mix for the ABI PRISM 310 
differs from the mix prepared for the ABI 373 and ABI PRISM 377, and do not 
use on other instruments.

! WARNING ! CHEMICAL HAZARD. Formamide is a known 
teratogen. It can cause birth defects. Wash thoroughly after handling 
formamide. Wear appropriate protective eyewear, clothing, and gloves. 
Obtain a copy of the MSDS from the manufacturer. Wash thoroughly after 
handling formamide.

Prepare the formamide-size standard mix as follows:

Preparing Matrix
Standard Samples

About Matrix Standards

You must run matrix standards and create a matrix file the first time you 
use a new chemistry or change the run conditions.

Do not prepare matrix standards more than two hours in advance.

To ensure reproducibility of results for all samples, prepare the matrix 
standard mix using the 12:1 ratio of reagents stated in the procedure 
below.

IMPORTANT Do not add size standard mix to the matrix standard 
samples.

5 Make 500-µL aliquots and store them at minus 20°C for up to 3 
months.

Step Action

Step Action

1 Mix in a sample vial:

a. 0.5-µL GeneScan–350 [TAMRA] Size Standard (for example).

b. 12.0-µL deionized formamide.

2 Label the vial.

3 Gently vortex the mixture for 3–5 seconds.

4 Spin down the mixture.

5 Store the mix at 2–6 °C until ready to use.
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IMPORTANT The matrix standard mix for the ABI PRISM 310 differs from 
the mix prepared for the ABI 373 and ABI PRISM 377, and should not be used 
on other instruments.

Note Remember that the matrix standards run must always match the 
sample run chemistry and conditions.

Preparing Matrix Standard Samples

For each matrix standard:

For... Prepare the...

the Fluorescent Genotyping 
Demonstration Kit

Fluorescent Amidite Matrix 
Standards (P/N 401546)

fluorescent dNTPs Fluorescent dNTP Matrix Standards 
(P/N 402792).

Step Action

1 Mix in a sample vial:

a. 1.0-µL of matrix standard.

b. 12.0-µL of de-ionized formamide.

2 Label each vial according to the dye.

3 Gently vortex the mixture for 3–5 seconds.

4 Spin down the mixture.

5 Store at 2–6 °C until ready to use.
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Preparing Matrix Standards for the ABI 373 and ABI PRISM 377

Introduction Use the following procedure to prepare matrix standards for the 
following instruments:

Procedure To prepare the matrix standards for loading:

Table of Matrix
Standards

The following table lists the matrix standards to prepare for each 
instrument:

ABI 373 ABI PRISM 377

ABI 373 with XL Upgrade ABI PRISM® 377 with XL Upgrade

Step Action

1 Set up a run with the instrument conditions you want to duplicate.

Run conditions depend on the following:

� Instrument system you are using (ABI PRISM 377 or ABI 373).

� Kind of experiment that you are running.

2 Select the four Dye Matrix Standards (one for each color) from the 
Dye Matrix Standard kit that you are using.

3 Depending on the instrument system, use the table below to 
prepare dye matrix standards for loading.

If you are using... Then each dye that you use...

ABI PRISM 310 or 
ABI PRISM 377

must be recognized as a different color by 
the single virtual filter.

ABI 373 must be recognized by a different filter on 
one filter wheel.

For
ABI PRISM 377 and with 
XL Upgrade ABI 373

ABI 373 with XL 
Upgrade

Denaturing 
gels

Combine 2.5-µL of each 
standard with 1.5-µL 
Loading buffera. 

Combine 2.5-µL of each 
standard with 2.5-µL 
Loading buffer.

Combine 2.5-µL of 
standard with 2.5-µL of 
deionized formamide.

Heating Heat each sample at 95 ˚C for five minutes to denature before loading.

a. Loading buffer is 1 part 25-mM EDTA/50-mg/ml Blue Dextran with 5 parts deionized formamide.
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Loading and Running Dye Standards for the ABI PRISM 310

Introduction This section describes how to do the following tasks before running 
matrix standards on the ABI PRISM 310:

Note When loading the matrix standards on an instrument, note which 
colors you load in which autosampler positions.

Creating a
GeneScan Sample

Sheet

Topic See page

Creating a GeneScan Sample Sheet 6-13

Creating a GeneScan Injection List 6-14

Starting the Data Collection Software 6-15

To create a GeneScan Sample Sheet: 

Step Action

1 Open the ABI PRISM 310 Data Collection software.

2 Choose New from the File menu.

3 Click the GeneScan Sample Sheet 48 or 96 tube icon.

The GeneScan Sample Sheet appears.

4 Enter the appropriate colors (Blue, Green, Yellow, or Red) in the 
positions for each sample name.
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Creating a
GeneScan

Injection List

The Sample Sheet is imported into the Injection List, which defines the 
sample names and the initial injection order.

5 Enter any additional information about the sample in the Comments 
column.

6 Use the Save As command and save the Sample Sheet to the 
Sample Sheet folder.

To create a GeneScan Sample Sheet: (continued)

Step Action

To create a GeneScan Injection List: 

Step Action

1 Choose New from the File menu.

2 Click the GeneScan Injection List icon.

The GeneScan Injection List appears.

3 Choose a Sample Sheet from the Sample Sheet pop-up menu.

4 Choose the appropriate module in the Module pop-up menu for 
lines 1 through 4, for example, A1, A3, A5, and A7.

5 Deselect Auto-Anlz (analysis).

6 Deselect Auto-Print.



Making a Matrix File 6-15

Starting the Data
Collection

Software

To start the Data Collection software:

If the Run was
Cancelled

The following table lists what happens to the Sample file if the run was 
cancelled:

Step Action

1 Click the Run button.

The following windows open:

2 Choose Status from the Window menu. 

The current run is in italics in the Injection List. 

You can monitor activities such as electrophoresis current, laser 
power, running time, and gel temperature.

Window Description

Raw Data window Shows the real-time chromatogram of the 
run.

Log Window Shows the real-time written record of run 
events.

If a run was cancelled and you are 
using... Then the sample file is...

Data Collection software v 1.0.4

Note Version 1.0.4 is a free 
upgrade. To obtain the upgrade, 
either access the ABI PRISM 310 
Genetic Analyzer website at 
www.appliedbiosystems.com/techsu
pport or call technical support (see 
page 1-20).

For more information, refer to 
ABI PRISM 310 Data Collection 
Software Version 1.0.4 User Bulletin 
(P/N 4305798).

saved if you skip to the next sample 
or cancel a run.
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Run Time Run time is approximately 30 minutes for the GS STR POP-4 module, 
so the total run time will be about 120 minutes.

Assigning Matrix
File

For information on Assigning the Matrix File to Sample Files, see 
page 6-35.
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Loading and Running Dye Standards for the ABI PRISM 377

Introduction This section describes how to do the following tasks using the 
ABI PRISM 377 and the ABI PRISM 377 with XL Upgrade:

Note When loading the matrix standards on an instrument, note which 
colors you load in which lanes for gel based systems.

Creating a
GeneScan Sample

Sheet

The GeneScan Sample Sheet assigns sample and dye information to 
their appropriate lane.

Topic See page

Creating a GeneScan Sample Sheet 6-17

Loading Matrix Standards 6-18

Running the Matrix Standards 6-19

To create a GeneScan Sample Sheet: 

Step Action

1 Open the ABI PRISM 377 Data Collection software.

Define or verify the data collection preferences.

2 Choose New from the File menu.

3 Click the GeneScan Sample Sheet icon.

The GeneScan Sample Sheet appears.
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Loading Matrix
Standards

To load matrix standards:

4 Enter the individual colors in the appropriate lanes where the matrix 
standards are loaded.

Note It is important to fill out the Sample Sheet completely.

5 Enter any additional information about the sample in the Comments 
column.

6 Use the Save As command and save the Sample Sheet to the 
Sample Sheet folder.

To create a GeneScan Sample Sheet: (continued)

Step Action

Step Action

1 For denaturing gels load:

� 0.5-2-µL of matrix standard per lane.

� 8 lanes with different colors, leaving an empty lane between 
each lane of matrix standard.

2 Complete the information in the data collection Run sheet, making 
sure to choose the appropriate PreRun and Run modules.

Take the following action:

3 Electrophorese samples according to conditions specified in your 
instrument manual.

For this matrix...
Choose modules 
that use... Module file

Dye Primer matrix Virtual Filter A GS 36A...

Fluorescent 
Amidite

Virtual Filter C GS36C...
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Running the
Matrix Standards

Run the matrix standards under the precise conditions you want to 
generate a matrix file.

To run the matrix standards: 

Step Action

1 Complete the information in the data collection Run sheet. 

Refer to the figure below to choose the appropriate Prerun and Run 
modules.

2 Take the following action:

3 Start the electrophoresis run according to the conditions specified 
in your instruction manual.

4 Go to “Generating Matrix Sample Files for the ABI 373 and 
ABI PRISM 377” on page 6-27.

For this matrix...
Choose modules 
that use... Module file

Dye Primer or 
dNTP matrix

Virtual Filter A GS 36A...

GS Amidite matrix Virtual Filter C GS36C...
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Loading and Running Matrix Samples on the ABI 373 (non XL)

Introduction The ABI 373 uses the 672 Data Collection software. For analysis of the 
data after completing the matrix run, transfer the data collection file to a 
Power Macintosh® computer.

This section describes how to do the following tasks:

Note See Appendix A for converting ABI 373 data collection data into gel 
files.

Loading the
Matrix Standards

To load matrix standards:

Topic See page

Loading the Matrix Standards 6-20

Completing the Sample Sheet in the 672 Software 6-21

Running the Gel 6-22

Completing the GeneScan Sample Sheet 6-23

Step Action

1 For denaturing and native gels load:

� 1-5-µL of matrix standard per lane (depending on comb 
configuration, see instrument user’s manual).

� 8 lanes with different colors, leaving an empty lane between 
each lane of matrix standard.

2 Select the appropriate filter set on the ABI 373 sequencer.

3 Electrophorese samples according to conditions specified in your 
instrument manual.

For this matrix... Choose...

Dye Primer matrix Filter set A.

Fluorescent Amidite matrix Filter set B.
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Completing the
Sample Sheet in

the 672 Software

Introduction

After opening the Collection file, complete the Sample Sheet embedded 
and track the lanes. This ensures that when the Sample files are 
generated they contain the correct information.

The Sample Sheet that is part of the Collection file is blank when it is 
opened. This is because the GeneScan® 672 Software does not 
automatically embed a copy of the data collection Sample Sheet in the 
Collection file.

Procedure

IMPORTANT When tracking and extracting the Collection file, ensure the 
Sample Sheet associated with the gel file has the checkbox labeled “Used” 
selected for each sample you want to extract. The GeneScan Analysis Software 
only extracts the samples with that checkbox selected.

To complete the Sample Sheet: 

Step Action

1 Open the Sample Sheet by either:

� Clicking the Sample Sheet button in the upper-left corner of the 
Gel Window, or by

� Choosing Gel Sample Sheet from the Gel menu.

2 Enter the following information:

� Sample file name.

� Sample name for each sample.

� Sample info.

� Comment for each dye/sample.

For more information, see “Displaying the Sample Sheet” on 
page 2-29.

3 Select checkboxes, as applicable.

To... Then select the...

indicate that the lane contains 
data

Used checkbox.

automatically analyze Sample 
files when generating them

"A" checkbox.

automatically print Sample files 
when generating them

"P" checkbox.
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Running the Gel To run the gel:

4 Identify the dye standard for each sample by clicking in the 
appropriate dye cells under the standard column.

Note Alternately, you can create a stand-alone Sample sheet 
and attach it to the gel file using the Install New Sample Sheet 
command from the Gel menu (see “Installing a New Sample Sheet” 
on page 2-36).

5 Choose Save (�-S) or Save As from the File menu.

If you click the close box before saving, a dialog box appears with 
the message whether or not to save the entries.

To complete the Sample Sheet: (continued)

Step Action

Step Action

1 Open the Data Collection software.

2 Set the run time and Data Collection File name.

3 On the ABI 373 instrument, choose the appropriate filter set for the 
conditions you wish to duplicate:

4 Run the matrix standards. 

5 Start the electrophoresis run according to the conditions specified 
in your instruction manual.

For this matrix... Choose...

Dye Primer or dNTP matrix Filter Set A.

Fluorescent Amidite matrix Filter Set B.



Making a Matrix File 6-23

Completing the
GeneScan Sample

Sheet

To complete the Sample Sheet in the GeneScan Analysis Software:

Step Action

1 Open the GeneScan Analysis Software program.

2 Choose New from the File menu. The Create New dialog box 
appears.

3 Click the Sample Sheet icon. The following dialog box appears:

4 Click the radio button that corresponds to the number of dyes and 
click OK.

An untitled Sample Sheet appears. 

5 Fill out the Sample Sheet for each of the colors.

6 Set the preprocessing parameters as follows:

7 Choose Install New Sample Sheet from the Gel menu.

8 Go to “Generating Matrix Sample Files for the ABI 373 and 
ABI PRISM 377” on page 6-27.

Do... And...

deselect Multicomponent

select Use Sample Sheet choose the appropriate 
Sample Sheet.

select Auto Lane Track 
Baseline Data

leave the Process amount as 
the default value.
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Loading and Running Matrix Standards on the ABI 373 with XL 
Upgrade

Introduction The ABI 373 with XL upgrade updates the Data Collection software of 
the ABI 373 to make it compatible with Power Macintosh® computers, 
and allows you to open gel files directly using the GeneScan Analysis 
Software in much the same way the ABI PRISM 377 does. 

This section describes how to do the following tasks:

Note The procedures in Appendix A are not necessary since the ABI 373 
software operates on a Power Macintosh computer.

Completing the
GeneScan Sample

Sheet

The GeneScan Sample Sheet assigns the sample and dye information 
to their appropriate lanes.

Topic See page

Completing the GeneScan Sample Sheet 6-24

Loading the Matrix Standards 6-25

Running the Matrix Standard 6-26

To create a GeneScan Sample Sheet: 

Step Action

1 Open the Data Collection software.

2 Choose New from the File menu.

3 Click the GeneScan Sample Sheet icon. 

The GeneScan Sample Sheet appears.
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Loading the
Matrix Standards

To load matrix standards:

4 Enter the individual colors in the appropriate lanes where the matrix 
standards are loaded.

5 Enter any additional information about the sample in the Comments 
column.

6 Use the Save As command and save the Sample Sheet to the 
Sample Sheet folder.

To create a GeneScan Sample Sheet: (continued)

Step Action

Step Action

1 For denaturing and native gels load:

� 1-5-µL of matrix standard per lane (depending on comb 
configuration, see instrument user’s manual).

� 8 lanes with different colors, leaving an empty lane between 
each lane of matrix standard.

2 Select the appropriate filter set on the ABI 373 sequencer.

For this matrix... Choose...

Dye Primer matrix Filter set A.

Fluorescent Amidite matrix Filter set B.
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Running the
Matrix Standard

Run the matrix standards under the precise conditions you want to 
generate a matrix file.

3 Electrophorese samples according to conditions specified in your 
instrument manual.

Step Action

To run the matrix standards: 

Step Action

1 Complete the information in the Run window. 

Note Make sure to choose the appropriate PreRun and Run 
modules.

2 Choose the appropriate filter set for the conditions you wish to 
duplicate.

3 Start the electrophoresis run according to the conditions specified 
in your instruction manual.

For this matrix... Choose...

Dye Primer or dNTP matrix Filter Set A.

Fluorescent Amidite matrix Filter Set B.
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Generating Matrix Sample Files for the ABI 373 and ABI PRISM 377

Who Should Use
This Step

Verify Tracking Before generating Sample files, verify that the lanes were set and 
tracked correctly. The following table lists where the data appears for 
each instrument once you have successfully completed your run of Dye 
Matrix Standards.

Generating
Sample Files

Who should use this step Who shouldn’t use this step

This step is only necessary if you 
are using an:

� ABI 373

� ABI PRISM 377 

� XL-upgraded instrument

� 96-lane upgrade

The ABI PRISM 310 Genetic 
Analyzer automatically processes 
collection data and generates 
Sample files when the run 
completes. 

If you ran your Dye Matrix Standards 
on the ABI PRISM 310, go to 
“Choosing a Scan Range for the 
Matrix Calculation” on page 6-29.

On this instrument... The data appears... Next step...

ABI PRISM 377 in a Gel File window.

Verify that the lanes 
were set and tracked 
correctly.

ABI 373 in a Data Collection 
file.

Convert the Data 
Collection file to 
generate the gel image 
(see Appendix A).

To generate Sample files: 

Step Action

1 Click the appropriate Lane Indicators at the top of the Gel window 
to make sure that the tracker line is optimally aligned over each 
band in all lanes.

If any of the lanes are not properly tracked, use the tracker line 
editing tools to align the tracker lines in each lane. See “Working 
with Tracker Lines” on page 2-53.
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2 If you change any of the lane assignments in any way, save the 
changes.

3 From the Gel menu, choose Track & Extract Lanes.

Note If the gel is already tracked, choose Extract Lanes from 
the Gel menu.

The project Analysis Control window appears containing each of 
the Sample files.

To generate Sample files: (continued)

Step Action
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Choosing a Scan Range for the Matrix Calculation

Introduction Depending on how well your Matrix Standards run, it may be necessary 
for you to choose a specific range of data points to be considered for 
your matrix calculation.

In order to choose appropriate values for the Scan range, you must first 
view the Sample file raw data from each of the four matrix standard 
files, so you can decide where to choose the start and stop points for 
the scan range.

Viewing the Raw
Data

When you have multiple Sample files, raw data can be accessed more 
easily through a project’s Analysis Control window. Raw data can 
provide useful information about the Sample files you have created. 

Note You can view Sample files without opening a project. However, this 
procedure is easier if you use a project to organize the Sample files (see “Using 
a Project to Manage Sample Files” on page 4-8).

To view raw data: 

Step Action

1 Use the following steps to create a project for the Dye Matrix 
Standards:

For more information, see “Creating a New Project” on page 4-10.

Step Action

a. Choose New from the File menu.

The Create New dialog box appears.

b. Click the Project icon. 

An untitled Analysis Control window opens.

c. Choose Add Sample Files from the Project menu.

d. Find and open your matrix run folder.

e. Select the four Sample files representing the blue, 
green, yellow, and red dye-labeled runs, and then click 
Add.

f. Click Done after the Sample files are transferred.
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What to Look For
in the Raw Data

Display

In the raw data display of the Sample files verify the following:

� Data peaks are present in all four of the matrix standards. 

� There are no anomalies.

� The baseline is stable. 

� Peaks should be on-scale—no more than 4,000 relative fluorescent 
units—and the peaks of the dye of interest should have a value of at 
least 200.

If peak data does not show these characteristics, see “Causes for Bad 
Matrix Files” on page 6-38, for possible interpretations of your peak 
data.

Choosing a Scan
Range

To choose a scan range:

2 From the Analysis Control window, select the four matrix standard 
Sample files by clicking on the first Sample file, holding down the 
mouse button, and releasing on the last Sample file.

3 From the Project menu, choose Raw Data (� R).

Electropherograms displaying raw data from the four matrix 
standard Sample files appear.

Note For the ABI PRISM 377 or ABI 373, you can also view raw 
data from the gel display by selecting one of the four lanes 
containing Dye Matrix Standard and looking at the Slice View to the 
left of the gel image.

For more information about viewing the gel image, see “What to 
Review in the Gel Image” on page 2-27.

To view raw data: (continued)

Step Action

Step Action

1 Move the cursor well away from the primer peak, in a region at the 
beginning of the run and in a flat part of the baseline, and record 
the scan numbers.

Note When choosing the start point do not include primer peaks 
in the scan range (see “Eliminating Primer Peaks” on page 6-31). 
Also, the region for both the start and stop points should be flat 
points at the baseline.
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Eliminating
Primer Peaks

Both the primer peaks and the data peaks are displayed when viewing 
the raw data of your matrix standards. Anytime you run dye-labeled 
samples on a gel (ABI 373 and ABI PRISM 377), or capillary 
(ABI PRISM 310), you always have excess dye-labeled primer in the 
reaction. The primer peak displays as the first peak, usually off-scale 
because it is in molar excess. 

Eliminate the primer peak when making a matrix by choosing the start 
point after the primer peak in a flat area with a stable baseline. 

2 Record the data point values for both the start and stop points of 
the scan range.

You will need to enter those values in the next step when 
generating the new matrix file (see page 6-32).

3 Close the raw data boxes and the project by clicking in the upper 
left-hand corner of the window. 

Note Holding down the Option key while clicking in the upper 
left-hand corner of the window will close the windows 
simultaneously.

Step Action
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Generating a New Matrix File

Procedure To generate a new matrix file:

Step Action

1 Choose New from the File menu. 

The Create New dialog box appears.

2 Click the Matrix icon. 

The Make New Matrix dialog box appears.

3 Choose the number of dyes from the Number of Dyes pop-up 
menu.

If 5 dyes are selected, a button is added to the bottom of the list.

4 The B, G, Y, and R buttons represent dye colors.

a. Click a button to display a pop-up menu. 

b. Use the pop-up menu to access a Sample file to link to each of 
the four dye-labeled primers.

c. Choose the Sample file that represents the dye color for that 
button.

5 Enter the start point that you determined when choosing a scan 
range in the Start at field.

See “Choosing a Scan Range” on page 6-30.

6 Enter the total number of data points to include to calculate the 
matrix in the Points field.

Note You must have at least five peaks to make a matrix.

In most cases, leave the default value, unless you must exclude a 
portion of your data because of artifacts or bleed-through.
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Matrix File
Example

The following is an example of the Matrix Values window that appears 
showing the values used to calculate the overlap correction.

For each dye, the value where the dye fluorescence is read by the 
appropriate filter is 1.000. The adjacent colors show the amount of 
overlap for which the system must compensate. The adjacent values, in 
most cases, should be less than 1.000, but equal to or greater than 
0.0000.

Note In some Filter Set C matrices, the matrix value for green in the first 
column can vary from about 0.8 to 1.2.

7 Click OK.

This generates a new matrix file. 

Step Action
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Saving and Naming the Matrix File

Introduction The matrix file is instrument-specific. You cannot apply a matrix file you 
made on the ABI 373 to data you collected on a ABI PRISM 377 or 
ABI PRISM 310, nor can you apply a matrix file made on a ABI 373 to a 
Sample or gel file made on another ABI 373. Also, you cannot apply 
matrix files created on one instrument to other instruments of the same 
model.

Naming
Considerations

When naming a matrix file, consider including the following information 
in the name:

Saving the Matrix
File

To save the matrix file:

Where to Store the
Matrix File

Store matrix files that are intended for use by data collection to assign 
to collection runs in the ABI folder. The ABI folder is located in the 
System folder of the computer on which Data Collection software is 
installed.

When to Make
Copies of a Matrix

You can make a copy of a matrix and store one in the ABI Folder for use 
by the Data Collection software and the other in the GS Matrix Folder 
for use by the GeneScan Analysis Software. This is useful when data 
collection and analysis are performed on different computers.

Item For example

Instrument type ABI 373, ABI PRISM 377, or ABI PRISM 310.

Filter set used A, B, or C.

Gel conditions native or denaturing.

Step Action

1 If a matrix folder does not already exist inside your GeneScan 
applications folder, create one.

2 Choose Save from the File menu.

A dialog box appears.

3 Enter a descriptive name for the new matrix file and click Save.
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Assigning the Matrix File to Sample Files

Introduction After generating the new matrix file, assign it to all the Sample files that 
you want to analyze.

IMPORTANT After assigning your matrix file to Sample files, see 
“Evaluating the Matrix File” on page 6-37.

Procedure

To assign a matrix file to Sample files: 

Step Action

Assigning a matrix file to Sample files:

1 From the project that contains your matrix standard Sample files, 
open the Analysis Control window.

2 Select the four matrix standard Sample files.

3 Choose Assign New Matrix from the Project menu.

4 Select the matrix file you just created.

5 Select numbers 1, 2, 3, and 4 on the left side of the window to 
highlight the colors for each row.

6 Choose Set Analysis Parameters from the Settings menu.

7 Enter the appropriate range for the Analysis Range and click OK to 
return to the Analysis Control window.

8 Click Analyze.

Reviewing the results:

1 Choose Results Control from the Windows menu.

The Results Control window appears (see below).
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2 Select 4 from the # of Panels pull-down menu (see above).

3 Click 1 under Dye/Samples (see above).

4 Click 1 on the Sample Files side of the Results control window.

5 For matrices 2, 3, and 4,click Analyze and repeat step 1 and step 2.

To assign a matrix file to Sample files: (continued)

Step Action

# of Panels
pull-down menu

Dye/Samples
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Evaluating the Matrix File

Introduction After creating a new matrix file and assigning it to select Sample files, 
the next step is evaluating the quality of the matrix file. The quality of the 
matrix files has a direct impact on the quality of the results data.

Procedure To evaluate the matrix file:

Step Action

1 Analyze the Sample files used to make the matrix.

2 Display Results data for all four Dye Matrix Standard Sample files 
on one screen, showing only electropherogram data.

3 For each displayed Sample file:

You should see... If not...

that the only visible peaks 
represent the color of the Dye 
Matrix Standard run in that 
lane, or for that injection 
(ABI PRISM 310).

you probably have a bad matrix 
file. 

For instructions on how to 
identify and correct problems 
with bad matrix files see, 
“Causes for Bad Matrix Files” 
on page 6-38.

all other lines should be 
relatively flat.

This indicates that the matrix 
properly compensated for the 
spectral overlap. 

For example, for the blue 
matrix standard Sample file, 
you should only see blue.

sharp, well-defined, singularly 
colored peak data.
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Causes for Bad Matrix Files

If an Error
Message Appears

If an error message appears, the following table lists two possible 
causes:

Two Causes of Bad
Matrix Files

The following table lists two common causes of bad matrix files:

For this cause... Take this action...

designated the wrong files. reassign the matrix files. 

See “Assigning the Matrix File to 
Sample Files” on page 6-35.

signal is too weak to make a matrix. rerun the matrix standards.

“Loading and Running Matrix 
Standards on the ABI 373 with XL 
Upgrade” on page 6-24.

Problem Cause What to do

Artifact peaks of 
different colors under 
the true peaks.

See the figure below.

Loading too much dye 
when running matrix 
standards resulting in 
dye bleed-through.

Complete another run 
and recreate the 
matrix.



Making a Matrix File 6-39

Noisy baseline. If the matrix subtracts 
too much of a 
particular color from 
the sample, then the 
baseline may become 
too elevated, resulting 
in false peaks.

See the figure below.

Compete another 
matrix run and make 
sure that you do not 
have any off-scale 
data.

Problem Cause What to do
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Evaluating Analysis 
Results 7
Introduction

In This Chapter Topics in this chapter include the following:

Topic See page

Process of Evaluating Analysis Results 7-2

Ways to Display Analysis Results 7-3

The Results Display Window 7-4

Using the Results Control Window 7-7

Changing How the Results are Displayed and Printed 7-13

The Sample Results View 7-16

Updating the Results 7-16

Saving and Renaming the Results Control Format 7-17

About Electropherogram and Tabular Data Displays 7-20

Displaying Electropherogram and Tabular Data 7-22

Displaying Electropherogram Data 7-25

Working with Electropherogram Data 7-27

How to Define Custom Colors 7-40

How to Change the Dye Scale 7-44

Process of Verifying Results 7-46

How to Verify Size Calculations 7-48

Using the Analysis Log 7-51

How to Verify Peak Detection 7-53

7
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Process of Evaluating Analysis Results

Steps to
Evaluating

Analysis Results

The following table lists the steps to evaluating the analysis results:

Step Action For information, see...

1 Displaying Analysis Results. “Ways to Display Analysis 
Results” on page 7-3.

2 Using Electropherogram and 
Tabular Data Displays.

“About Electropherogram and 
Tabular Data Displays” on 
page 7-20.

3 Viewing Electropherograms. “Displaying Electropherogram 
Data” on page 7-25.

4 Verifying analysis results. “Process of Verifying Results” 
on page 7-46.

5 Displaying Other Sample File 
Data.

� “Sample Info View” on 
page 3-8.

� “Size Curve View” on 
page 3-13.

� “Raw Data View” on 
page 3-15.

� “EPT Data View” on 
page 3-17.

6 Using the Analysis Log. “Using the Analysis Log” on 
page 7-51.

7 Remembering and Renaming 
the Results Display.

“Saving and Renaming the 
Results Control Format” on 
page 7-17.
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Ways to Display Analysis Results

Two Ways to
Display Analysis

Results

The following table lists two ways to display analysis results:

You can use... Description See page

The Results 
Display 
Window

This window is created from the Results 
Control window of a project. 

Use to group and view multiple Sample files 
as electropherogram and tabular data.

7-4

The Sample 
Results View

This view displays one Sample file at a time, 
just as the Results Display window, but is 
more convenient for viewing analysis results 
from a single Sample file.

It also allows quick access to supporting 
information views.

7-16
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The Results Display Window

Introduction The Results Display window is created from the Results Control window 
of a project and allows you to group and view multiple Sample files as 
electropherogram or tabular data. You can use the window to show up 
to eight panels, with multiple dye/samples per panel.

Displaying the
Window

Choose Results Control (� 2) from the Windows menu. 

The following is an example of the Results Control window.

1 2 3 4 5

6

7

8

9

10

11

1213
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Results Control
Window

Description Results Control window descriptions:

No. Description

1 Select dye/sample information by clicking one of the dye color fields.

2 Each button corresponds to a panel in the display window.

3 Click to display electropherograms for the selected samples.

4 Choose the number of electropherogram panels available for display 
from the pop-up menu.

5 Click to display tabular data for the selected samples.

6 Identifies the sample by row number and dye code.

Sample information is displayed as specified in the project options.

7 Plot color indicator.

Note If you change the plot color, a vertical line appears beside 
the indicator, showing that it has been modified.

If you... Then...

double click the plot color 
indicator

the Choose a Plot Color dialog 
box appears.

For more information, see 
“Defining Individual Plot 
Colors” on page 7-42.

�-double-click the dye color 
indicator

the plot color indicator returns 
to the default color.

For more information, see 
“Setting Dye Indicator 
Preferences” on page 5-15.
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8 Dye color indicator.

Note If you change the scale, a vertical line appears beside the 
indicator, showing that it has been modified.

9 Clear panel button. 

See “Removing Samples” on page 7-12.

10 Quick Tile radio buttons. 

See “Creating Tiled Electropherogram Displays” on page 7-10.

11 Display button. 

See “Displaying the Results” on page 7-12.

12 Clear All button. 

See “Removing Samples” on page 7-12.

13 Print button. 

See “Printing the Results” on page 7-12.

Results Control window descriptions:

No. Description

If you... Then...

double click the dye color 
indicator

the Choose a Dye Scale dialog 
box appears.

For more information, see 
“Changing the Dye Scale of an 
Electropherogram” on 
page 7-44.

�-double-click the dye color 
indicator

the dye color indicator returns 
to the default scale.

For more information, see 
“Changing the Dye Scale 
Preferences” on page 7-45.
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Using the Results Control Window

Selecting Display
Format

Choose the results display format by clicking either or both the 
electropherogram and tabular icons. You must select one of the icons to 
display or print data.

Selecting
Electropherogram

Panels

In electropherograms, the data appears in panels. You can overlay up to 
sixteen samples within up to eight panels. Select the number of 
available panels (up to eight) from the pop-up menu labeled # of Panels.

Note Set the number of panels when using the Quick Tile option. Using this 
option causes the GeneScan Analysis Software to automatically change panels 
as you select samples for display (see “Creating Tiled Electropherogram 
Displays” on page 7-10).

Click this icon... To display... And the...

electropherogram data panel information below 
the icon is enabled.

tabular data panel information below 
the icons is dimmed.

Tabular data appears in a 
single table, so 
electropherogram panel 
configuration is not 
relevant.

Pop-up menu
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Selecting Samples
to Display

Use the dye color field on the left side of the Results Control window to 
select the dye for display. 

You can select any or all dye colors, including the standard, for each 
Sample file.

To select samples for display: 

Step Action

1 Click the Electropherogram icon.

The panel below the icon is enabled.

2 Click a panel number in the list to the left of the Dye/Sample Display 
list.

If fewer than eight panels are available and you want to use more, 
choose a larger number (up to eight) from the # of Panels pop-up 
menu.

3 Click dye color fields to select or deselect the corresponding 
samples.

Take the following action:

4 If you specified Electropherogram display, the samples 
corresponding to the selected dyes appear in the Dye/Sample 
Display list to the right of the Sample File list, as shown in the figure 
below.

To... Click the...

select the entire column header.

deselect the entire column header, again.

select four colors for a Sample 
file

index number to the left of the 
color columns.
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5 When you change to a new panel, the dye colors of the samples 
you selected in other panels appear dark gray to indicate that they 
have been selected.

You can select them again in the current panel.

To select samples for display: (continued)

Step Action

Dye color
of sample

Plot color of
electropherogram

Row number and dye code
followed by dye/sample information
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Creating Tiled
Electropherogram

Displays

Procedure

To create tiled electropherogram displays:

Example

The following table describes two examples of how to use the Quick Tile 
feature:

Step Action

1 Choose the number of panels you want to display from # of Panels 
pop-up menu.

2 Click the On radio button under Quick Tile.

3 Select samples by clicking color fields.

For information on:

Each time a sample is selected, the program automatically changes 
to the next panel, so each selection is placed after the one 
containing your previous selection. 

After you select a sample for the last panel, the panel increments to 
the first panel again.

If you... Then...

have four samples and choose four 
panels for display

click the column heading for the blue 
dye to select all four blue 
dye-labeled samples.

The blue dye for each Sample file 
appears in a separate panel.

click the row index number for the 
first Sample file to select all dye 
colors for one sample file

each dye for that Sample file 
appears in a separate panel.

Topic See page

Selecting Samples to Display 7-8

Setting the tiled electropherogram preferences 7-13
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Deselecting
Samples

To deselect the samples that you have selected for display:

Step Action

1 If you specified Electropherogram display, click the panel number to 
the left of the Dye/Samples display list to display the information for 
the panel containing the samples you want to deselect.

2 On the left side of the Results Control window, deselect the dye 
color fields corresponding to the samples you want to remove.

The dye/sample identifiers are removed from the Dye/Sample 
Display list as you deselect samples.

Panel numbersDye color fields
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Removing Samples To remove samples:

Displaying the
Results

To display the results on the screen, you can either:

� Click the Display button.

� Press the Return or Enter key.

Printing the
Results

To print the results:

Step Action

1 Select the panel number on the buttons to the left of the 
Dye/Sample Display list.

2 You can take the following action:

To remove... Click...

all the samples you selected 
for display in a panel

Clear Panel.

the samples you have selected 
for display in all panels

Clear All.

Step Action

1 You can either:

� Click the Print button, or

� Choose Print (� P) from the File menu.

2 Click Print in the dialog box that appears.
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Changing How the Results are Displayed and Printed

Procedure You can set certain display preferences that remain in effect each time 
you display or print results data.

To change how results are displayed and printed: 

Step Action

1 Choose Preferences from the Settings menu and choose Results 
Display from the submenu.

The following dialog box appears.

There are three Results Display preferences:

� Default Display Attributes.

� Stacked Electropherogram Panels.

� Printing Preferences.
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2 Set the Default Display Attributes to control the display attributes of 
new results displays, as follows:

3 Configure Stacked Electropherogram Panels, as follows:

To change how results are displayed and printed: (continued)

Step Action

You can set... For more information...

Show Peak Positions “Displaying Peak Positions” on 
page 7-29.

Use opaque or transparent 
peak highlighting

“Highlighting Peaks” on 
page 7-29.

Show Legends “Using Legends to Change the 
Display” on page 7-30.

Show Offscale Data “Showing Off-Scale Data” on 
page 7-32.

Align By Size “Showing Data by Fragment 
Size” on page 7-35.

Use standard or custom plot 
colors

“Defining Custom Color for All 
Electropherogram” on 
page 7-41.

Choose... To...

Use Common Vertical Scale 
checkbox

set all panels in a display so 
they have the same vertical 
scale. 

The common scale is based on 
the electropherogram with the 
largest vertical scale.

Panel Height Resize Limits set minimum and maximum 
values for electropherogram 
panel height in the results 
display. 

This allows you to limit how 
much the electropherogram 
panels stretch or shrink to fit 
the size of the window.
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4 Set the Printing Preferences, as follows:

5 Click OK

To change how results are displayed and printed: (continued)

Step Action

If... Then...

the height of the panels that 
appears on screen is 
acceptable

choose the As Shown on 
Screen radio button.

you want to print the 
electropherogram at a 
specified height

click the Fixed at radio button 
and enter a value in the field.

you want to force a page break 
after the electropherograms 
have been printed

select the Page Break before 
Tabular data checkbox.
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The Sample Results View

About the View The Sample Results view is displayed within a Sample file window. You 
can access the window through a Sample file or through a project’s 
Analysis Control or Results Control window. If you are opening a 
Sample file as a stand-alone file, the Sample Results view is the default 
display within the Sample file window.

For More
Information

See “Sample Results View” on page 3-6.

Updating the Results

Re-Analyzing the
Data

The Results Control and the Sample Results windows are dynamic. The 
following table lists how the windows are updated if you re-analyze the 
data.

If you re-analyze... Then the...

your data with either window active software updates the window.
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Saving and Renaming the Results Control Format

Introduction You can use the Results Control window to view multiple Sample files in 
electropherogram and tabular format. The GeneScan Analysis Software 
allows you to save formats for future use. You can then redisplay or print 
these formats without having to redefine them again.

Important
Considerations

The following are important considerations for saving a Results Control 
format:

� You must save the project for the display to be available when you 
open the project again.

� Remembering a display preserves the combination of 
windows/panels /data and customized color settings. 

It does not preserve any zooming you have performed.

Saving the Display
Format

To save a display format for future viewing:

Step Action

1 With the Results Control window set for the display, either:

� Click the Display button, or 

� Press the Return key.

2 With the display on the screen, choose Remember Display from the 
Project menu. 

The Remember Display dialog box appears.

3 Enter a name for the display and click OK.
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Working with a
Previously Saved

Displays

Use the Previous Displays dialog box to display, print, remove or 
rename a saved display.

To work with a previously saved displays: 

Step Action

1 Choose Previous Displays from the Project menu. 

The following is an example of the Previous Displays dialog box.

 

2 Select a display or multiple displays and take the following action:

To...
Click an item in the list and 
click...

display the saved formats Display.

print the saved formats Print.

The standard print dialog box 
appears.

remove the saved formats Remove.

An alert appears.

rename Rename.

Note You can only rename 
one display at a time.

The Rename dialog box 
appears (See “Renaming the 
Current Results Display” on 
page 7-19).
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Renaming the
Current Results

Display

To rename the Results display that is currently on the screen and to 
save the display under a different name.

Step Action

1 Ensure the display is the active window.

2 Choose Rename Display from the Project menu. 

The following is an example of the Rename Display dialog box.

3 Enter a new name for the display and click OK.
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About Electropherogram and Tabular Data Displays

Introduction After analyzing the data, you can display the results for each sample in 
electropherograms and tabular data. You can also customize the 
electropherograms and tabular data display.

Note Altering the appearance of the electropherograms and the tabular data 
displays does not change the analyzed data contained in the Sample file on 
which they are based. 

How the Window
is Divided

When electropherograms and tabular data are displayed together, the 
window is divided into upper and lower windows.

You can customize the window’s appearance by adjusting the relative 
size of each window, see “Adjusting Window Size” on page 7-24.

What Tabular
Data Contains

If you analyze samples with an internal size standard and perform size 
calling, the tabular data contains the estimated sizes (in base pairs) of 
all detected fragments. Use this information for detailed data analysis 
and further calculations. The peaks matched to the defined size 
standard are identified by dots next to the Dye/Sample Peak field.

Sample peaks that are larger (in base pairs) than the largest defined 
peak in the selected standard are not sized. The corresponding size 
fields are blank.

Note Tabular data displays only peaks that are detected based on the Dye 
Amplitude Thresholds and Minimum Peak Half Width setting of the analysis 
parameters.

How
Electropherogram

Panels are Sized

In the Results Display window, the GeneScan Analysis Software sizes 
all electropherogram panels to fit within the electropherogram portion of 
the window by using the largest size that fits them into the visible area. 
You can scroll to see the portion of the display that is not visible.

Window Contains

Upper window electropherograms

Lower window tabular data
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Peaks Visible in
Electropherogram
Not Tabular Data

Peaks may be visible in the electropherogram and not listed in the 
tabular data because:

For More
Information

For more information, see the following topics:

Reason For more information, see

The software detects the peaks 
based on the Dye Amplitude 
Thresholds and Min Peak Half 
Width.

“Peak Detection Parameter Options” 
on page 5-20.

Electropherograms display the 
peaks that fall within the range 
specified by the Size Call Range 
parameters that are defined in the 
Analysis Parameters dialog box.

“Size Call Range Parameter 
Options” on page 5-21.

Topic See

Displaying Electropherogram and Tabular Data 7-22

Displaying Electropherogram Data 7-25

Working with Electropherogram Data 7-27
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Displaying Electropherogram and Tabular Data

Displaying
Electropherogram
and Tabular Data

To display electropherogram and tabular data:

Tabular Data and
Electropherogram

Example

The following is an example of tabular data with a corresponding 
electropherogram:

Step Action

1 Choose Results Control (� 2) from the Windows menu to open the 
Results Control window.

2 Click the electropherogram icon ( ) and the tabular icon 
( ).

3 If applicable, select the number of electropherogram panels.

4 Select the dye/samples for display.

5 Click Display. The electropherogram and tabular data are displayed 
in the Results Display window.

See also “Working with Electropherogram Data” on page 7-27.



Evaluating Analysis Results 7-23

Table Describing
Columns

The following table describes the columns in the above figure:

Highlighting
Information

To highlight information for one peak in the electropherogram and 
tabular data:

How to Change the Highlight Color

Choose Peak Highlighting from the View menu and either Opaque or 
Transparent from the submenu.

For more information, see “Highlighting Peaks” on page 7-29.

This column Identifies...

Dye/Sample Peak � Sample index number.

� Dye color.

� Peak number.

Minutes The time, in minutes, from the start of the run to the 
time the fragment was detected.

Size The differences in fragment mobility.

This value is calculated automatically only if you:

� Run the size standard in the same lane or 
injection as the sample, and

� Perform size calling.

Peak Height Signal size.

Peak Area Area of the detected peak.

Data point Data point of the fragment at its maximum peak 
height.

Click... Then...

the peak in the electropherogram the peak fills with color and the 
corresponding row in the tabular 
data window is highlighted.

the Dye/Sample Peak number in the 
tabular data window

highlights the corresponding peak in 
the electropherogram.
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Adjusting Window
Size

To adjust the relative size of the electropherogram and tabular windows:

Hiding Selected
Rows of Data

To hide selected rows of data:

Limited the Rows
Displayed

To limit the display to the selected rows of data:

Step Action

1 Move the cursor to the window divider (the double line between the 
two windows).

2 When the cursor changes to a bidirectional arrow ( ), click the 
window divider line and drag it up or down.

Step Action

1 Take the following action:

2 Choose Hide Selected Rows (� H) from the View menu.

If you want to... Then...

select a row either:

� Click the first field in the 
row, or

� Click the corresponding 
peak in the 
electropherogram.

select several consecutive 
rows

shift-click the first and last row 
you want to select.

select several rows that are not 
next to each other

�-click the rows.

Step Action

1 Select the rows you want to display.

2 Choose Show ONLY selected Rows (� G) from the View menu.

Note Choose Show All Rows (� G) from the View menu to 
display all of the tabular data after limiting the display.
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Displaying Electropherogram Data

Definition Each electropherogram provides a profile of the selected dye samples it 
represents. The y-axis represents the relative fluorescence of the 
detected fragments as they occurred over time. The x-axis represents 
time and can be displayed by data points or base pairs.

Base Pairs Versus
Data Points

You can choose to have the horizontal tick marks on the x-axis 
represent size in base pairs instead of data points only if you ran an 
internal size standard with the sample (see “Showing Data by Fragment 
Size” on page 7-35).

Procedure To display electropherogram data:

Step Action

1 Choose Results Control (� 2) from the Windows menu to open the 
Results Control window.

2 Click the electropherogram icon.

3 If applicable, select the number of electropherogram panels.

4 Select the dye/samples for display.

5 Click Display.

The electropherogram is displayed in the Results Display window.
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Electropherogram
Example

The following is an example of an electropherogram:

Descriptions of the
Electropherogram

The following table lists the descriptions for the above figure:

1

2

3456

No. Description See...

1 Cross hairs “Displaying X-and Y-
Axis Positions” on 
page 7-27.

2 Magnifying glass

Use to zoom in a specific area or hold 
down while pressing the Option key to 
zoom out in successively smaller scale.

“Zooming In and Out” 
on page 7-31.

3 Legend

Text from the Sample file that appear 
beneath electropherogram panels in the 
Results Display window.

“Using Legends to 
Change the Display” 
on page 7-30.

4 Dye color indicator “Dye color indicator.” 
on page 7-6.

5 Plot color indicator “Plot color indicator.” 
on page 7-5.

6 Scroll bar

Use the scroll bar to scroll horizontally.

“Scrolling the Display” 
on page 7-30.
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Working with Electropherogram Data

In This Section This section describes how to perform the following tasks:

Displaying X-and
Y-Axis Positions

Click the cross hairs and select an area in the Electropherogram to 
display the x-and y-axis positions.

The x-and y-axis values appear in the box in the lower left corner of the 
electropherogram and, if tabular data is also displayed, the row in the 
table is highlighted.

Task See

Displaying X-and Y-Axis Positions 7-27

Moving the Electropherogram 7-28

Changing the Dye Color 7-28

Displaying Peak Positions 7-29

Highlighting Peaks 7-29

Using Legends to Change the Display 7-30

Scrolling the Display 7-30

Zooming In and Out 7-31

Showing Off-Scale Data 7-32

Showing Data by Fragment Size 7-35

Changing the Horizontal Scale 7-37

Changing the Vertical Scale 7-38

Assigning Standard or Custom Colors 7-39
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Moving the
Electropherogram

Move the associated electropherogram to the front by clicking in the 
legend either the:

� Dye color indicator

� Plot color indicator, or

� Text

Changing the Dye
Color

To change the dye color, double-click the dye color indicator. If you 
change the dye color or scale, a vertical line appears beside the 
indicator, showing that it has been modified.

Note �-double-click the dye color indicator to return it to the default.

TextDye color
indicator

Plot color
indicator
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Displaying Peak
Positions

Choose Show Peak Positions from the View menu. Use this command 
to examine how the GeneScan Analysis Software defined peaks by 
displaying markers that identify the beginning, center, and end of each 
peak.

Highlighting Peaks Use the Peak Highlighting command to highlight a selected peak with 
the dye/sample’s plot color.

To highlight selected peaks:

Step Action

1 Choose Peak Highlight from the Views menus and either Opaque or 
Transparent from the submenu.

2 Click a detected peak in an electropherogram. 

The peak is highlighted

Use this option... To...

Opaque fill the peak with a solid color 
that can obscure peaks behind 
the selected peak.

Transparent use a slightly diffused plot color 
that allows you to view 
overlapping peaks.
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Using Legends to
Change the

Display

The following table lists how to use legends to change how 
electropherograms are displayed:

Scrolling the
Display

The following table lists ways to scroll the display:

If you want to... Then...

show or hide legends choose Show Legends from the 
View menu.

open Sample file windows double-click the corresponding 
legend text.

reorganize overlaid 
electropherograms

a. Display the electropherograms 
with legends.

b. Click either the dye, color 
indicator, plot color indicator, or 
the text for the sample you want 
to move to the front.

Use the Description

scroll bar

scroller 
symbols

a. Hold the mouse cursor over either the vertical or 
horizontal scale of the electropherogram.

Either a vertical scroller symbol ( ) or a horizontal 
scroller symbol( ) appears.

b. Hold down the mouse button and move the mouse in 
the direction of the information you want to view.

If you want to... Then...

shift the electropherogram 
to the right or the left

click in the gray region of 
the scroll bar to the right or 
the left of the scroll box.

scroll across the 
electropherogram

click an arrow at the end of 
the scroll bar.

control the amount of 
scroll

drag the scroll bar to the 
right or the left.
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Zooming In and
Out

About Zooming In and Out

By default the GeneScan Analysis Software scales each 
electropherogram horizontally to show all peaks detected during the 
run. While this provides a good overview of the run, some peaks may 
be quite compressed.

To improve visibility, you can change the horizontal scale of the 
electropherograms by zooming.

Zooming affects:

� Only the horizontal scale, and zooms the middle portion of the 
window.

� All displayed electropherogram panels.

How to Change the View Scale

To change the view scale: 

If you want to... Then...

see views with greater detail � Choose Zoom In (� +) from the 
View menu, or

� Click the magnifying glass in the 
upper-left corner of the window 
and select a specific area on 
which to zoom in by drawing a 
box on the electropherogram.

see a smaller scale view of the data 
after zooming in

� Choose Zoom Out (� -) from 
the View menu, or 

� Click the magnifying glass 
cursor, hold down the Option 
key, and click the 
electropherogram.

The data appears in 
successively smaller scale 
views.

quickly scale the data so that the 
entire length fits within the window, 
again

Choose Zoom Out (Full Range) from 
the View menu.
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Showing Off-Scale
Data

This section contains the following information:

Procedure

To show off-scale data:

Topic See page

Procedure 7-32

For ABI PRISM 377 Runs 7-33

About Flat Topped Peaks 7-33

Electropherogram Displaying Off-Scale Data 7-34

Electropherogram Displaying the Flat Topped Effect 7-35

Step Action

1 Choose Preferences from the Settings menu and Results Display 
from the submenu. 

The Results Display Preferences dialog box appears.

2 Choose the Show Offscale Regions checkbox to highlight with a red 
bar regions in the electropherogram that contain off-scale (see 
“Electropherogram Displaying Off-Scale Data” on page 7-34). 

Note Choose the Zoom In command from the View menu to 
more clearly show the areas of off-scale data.

The Analysis Log lists the numbers of off-scale regions in the 
analysis range for each Sample file, if the sample was sized.

Note You can toggle this command for individual 
electropherograms by choosing Hide/Show Offscale regions from 
the View menu.
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For ABI PRISM 377 Runs

The Show Offscale Regions feature must be used in conjunction with:

About Flat Topped Peaks

An additional feature is that peaks that contain off-scale data points are drawn 
in the electropherograms as “flat topped,” that is, the top section of the peak is 
flat rather than pointed (see “Electropherogram Displaying the Flat Topped 
Effect” on page 7-35). 

This feature may be seen when the data is analyzed with no or light smoothing; 
the flat topped peaks may not be apparent with heavy smoothing. 

Choose Analysis Parameters from the Settings Menu (see “Smooth Options” on 
page 5-20).

For ABI PRISM 377 runs, use Refer to...

Pre-averaging offscale detection in 
the Gel Preferences menu

“Pre-Averaging Offscale Detection 
checkbox” on page 2-9

Suppress Left/Right Averaging 
checkbox in the General Setting 
Preferences dialog box

ABI PRISM 377 Data Collection 
software. 

Refer to Chapter 4 in the 
ABI PRISM 377 Instrument User’s 
Manual.
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Electropherogram
Displaying

Off-Scale Data

The following is an example of an electropherogram displaying off-scale 
data.

Off-scale data
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Electropherogram
Displaying the Flat

Topped Effect

The off-scale peaks in the electropherogram in the expanded view 
below illustrates the flat topped effect.

Showing Data by
Fragment Size

Introduction

If you analyze your samples with an internal size standard, you can use 
the Align by Size command to show the horizontal scale of the 
electropherograms by fragment size instead of by data point.

Note You can only display data by size if you analyzed your samples using 
an internal size standard.

Adjusts for Run Variations

The Align by Size command adjusts for run to run and lane to lane 
variations and thereby eliminates any apparent differences, and any 
possible confusion, caused by run discrepancies. For example, if you 
run two identical samples in different runs, aligning peaks by size value 
eliminates any apparent differences (and any possible confusion) 
caused by run discrepancies. With ABI 373 and ABI PRISM 377 data, 
the command lets you align two different samples run on the same gel 
using the internal size standard as a reference.

Flat topped
peaks



7-36 Evaluating Analysis Results

Note You can display overlaid samples in the same dye in different colors. 
See “How to Define Custom Colors” on page 7-40.

How to Switch Between Size and Data Point Display

To switch between size and data point display: 

If you want to... Then...

show data by size choose Align by Size (� T) from the View menu.

When the data is aligned by size, the menu changes 
to Align by Data point.

Choose the command again, to show the data aligned 
by data point.

set the default peak 
alignment

choose Preferences from the Settings menu and 
choose Results Display from the submenu. 

You can use the Results Display Preferences dialog 
box to set certain preferences that remain in effect 
each time you display or print results data.

For more information, see “Changing How the Results 
are Displayed and Printed” on page 7-13.
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Changing the
Horizontal Scale

You can change the vertical scale:

� All electropherograms.

� Individual electropherograms.

How to Change the Horizontal Scale for All Electropherograms

To change the scale of the horizontal axis for all electropherograms:

1 Display the electropherogram panels you want to change.

2 Choose Horizontal Scale from the View menu. 

The Horizontal Scale Parameters dialog box appears.

Note You can also move the cursor over the horizontal axis of a 
displayed electropherogram and double-click.

3 Enter the increments represented by the tick marks for the 
horizontal axis in the Tick Spacing box.

4 Enter a range in the entry fields labeled Display from and to.

5 Click OK.
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How to Change the Horizontal Scale for Individual Electropherograms

To change the horizontal scale for individual electropherograms:

Changing the
Vertical Scale

You can change the vertical scale for

� All electropherograms.

� Individual electropherograms.

How to Change the Vertical Scale for All Electropherograms

Step Action

1 Display the electropherograms.

2 Move the cursor over the horizontal axis of the panel that you want 
to change and double-click.

The Horizontal Scale Parameters dialog box appears.

3 Enter the increments represented by the tick marks for the 
horizontal axis in the Tick Spacing box.

4 Enter a range in the entry fields labeled Display from and to.

5 Click OK. 

The horizontal scale changes 

To change the vertical scale for all electropherograms: 

Step Action

1 Display the electropherogram panel that you want to change.

2 Choose Vertical Scale from the View menu.

The Vertical Scale dialog box appears.

3 Enter the increments represented by the tick marks for the vertical 
axis in the Tick Spacing box.
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How to Change the Vertical Scale for Individual Electropherograms

Assigning
Standard or

Custom Colors

To assign standard or custom colors, choose the Plot Color command 
from the View menu and either Standard or Custom from the submenu.

For information on defining custom colors, see “How to Define Custom 
Colors” on page 7-40.

4 Enter a range in the entry fields labeled Display from and to.

5 Click OK.

To change the vertical scale for individual electropherograms. 

Step Action

1 Display the electropherograms.

2 Move the cursor over the vertical axis of the panel that you want to 
change and double-click.

The following dialog box appears.

3 Enter tick mark increments and a range.

4 Ensure that the Apply to all Electropherogram panels checkbox is 
not selected.

Select the checkbox only to apply the changes to all displayed 
electropherogram panels.

5 Click OK.

The vertical scale changes only for the electropherogram panel that 
you selected.

To change the vertical scale for all electropherograms: (continued)

Step Action
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How to Define Custom Colors

Introduction The GeneScan Analysis Software assigns a plot color to each 
dye/sample added to an electropherogram. Normally, it is the color 
associated with the individual dye/sample by the Dye Indicators 
Preferences.

Note To change the default dye colors in the Analysis Control window and 
the Results displays, refer to “Setting Dye Indicator Preferences” on page 5-15.

Note Custom plot colors are not available in the Sample Results view.

Why Change
Colors in the

Electropherogram

Change the colors in the electropherogram to:

� Differentiate between different samples labeled with the same color 
dye.

� Improve contrast between different dye colors.

� Show data in a special color for a presentation.

� Optimize plot colors for a particular printer.

Saving the Display
Format

The following table lists the options for saving the display format after 
customizing the display colors:

If you... And then...

specify save the display format of a 
Results Display window after 
customizing the display

open it at a later time, the custom 
colors still appear.

For more information, see “Saving 
and Renaming the Results Control 
Format” on page 7-17. 

do not save the display format after 
manually customizing the colors

redisplay the same results again, the 
electropherograms are redrawn with 
default colors.
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Defining Custom
Color for All

Electropherogram
To define custom colors for all electropherograms: 

Step Action

1 Choose Project Options from the Settings menu and Choose 
Custom Plot Colors from the submenu.

The Custom Plot Colors dialog box appears.

2 Choose new colors from the pop-up menus beside the plot 
numbers.

Note The plot numbers indicate the order of the samples in the 
electropherogram legend.
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Defining
Individual Plot

Colors

To define the individual plot colors:

3 Choose Other from the pop-up menu to specify a color that does 
not appear in the pop-up menu.

The following is an example of a color picker that appears.

4 Select the checkbox labeled Save As Defaults to save the 
customized colors.

5 Click OK.

To define custom colors for all electropherograms: (continued)

Step Action

Step Action

1 Display the electropherograms with legends.

2 Double-click the plot color indicator next to the sample you want to 
change.

The Choose a Plot Color dialog box appears.

3 Choose a new color from the pop-up menu.

If you choose Other, then a color picker appears.

Pop-up menu
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4 Click OK.

The color of the electropherogram for the individual sample 
changes, and a vertical line appears beside the plot color indicator 
to signify that it is modified.

Note You can change the plot color in the same way from the 
Results Control window. When you do so, the dye/sample is plotted 
with the set color each time you open the applicable Results 
Display window.

Note Press � and double-click the plot color indicator to reset it 
to the original color.

Step Action
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How to Change the Dye Scale

What the Dye
Scale Defines

The dye scale defines how dyes in an electropherogram appear relative 
to each other. You can compensate for peaks with different intensities 
by redefining the dye scale.

Note Changing the dye scale affects only the display, not the underlying 
data.

 Increasing the Dye
Scale Example

The following table describes an example of increasing the dye scale.

Changing the Dye
Scale of an

Electropherogram

To change the dye scale of an individual electropherogram:

If... Then... Action...

you loaded a smaller 
amount of green 
sample in relation to 
the red sample.

the peaks for the green 
sample might appear 
half as tall as those of 
the red sample.

To make it easier to 
view both samples on 
the same scale, 
increase the dye scale 
value of the green 
sample to make the 
peaks appear similar.

Step Action

1 Display the electropherograms with legends.

2 Double-click the dye color indicator next to the sample you want to 
change. The Choose a Dye Scale dialog box appears.

3 Enter a new scale in the dialog box and click OK.

The dye scale for the individual sample changes, and a vertical line 
appears beside the dye color indicator to signify that it is modified.

Note You can change the dye color in the same way from the 
Results Control window. The dye is scaled each time you open the 
Results Display window.
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Changing the Dye
Scale Preferences

To change the dye scale preferences:

Step Action

1 Choose Preferences from the Settings menu and choose Results 
Dye Scales from the submenu.

The Preferences dialog box appears with the Results Dye Scales 
pop-up.

2 Enter a positive number between 0.1 and 100 for each sample 
relative to any other sample, and click OK.

Note Dye scale values do not automatically revert to default 
values. Change them back to the defaults before examining results 
of another run.
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Process of Verifying Results

Introduction You can use the electropherogram and tabular displays to verify the 
results of analysis by checking the GeneScan Analysis Software 
calculated sizes and peaks.

Note The size calling of the standard and of sample fragments depend on 
the size calling method you defined in the Analysis Parameters and the 
accuracy of the defined standard.

Steps to Verifying
Size Calculation

To verify size calculations:

Step Action See

1 Compare how well multiple size 
standard electropherograms 
line up within a Results Display 
window when aligned by size.

“How to Verify Size 
Calculations” on page 7-48.

2 View the sizing curve calculated 
by the GeneScan Analysis 
Software.

“Size Curve View” on 
page 3-13.

3 Determine how well the defined 
size standard matched the size 
standard run with your sample.

Use the Peak Total information 
in the Sample Info view of the 
Sample File window.

“Sample Info View” on page 3-8.

4 View the Analysis Log, which 
provides messages for each 
analyzed Sample file. 

If there is a problem or a 
questionable condition during 
size calling, a warning message 
is displayed in the Analysis Log.

“Using the Analysis Log” on 
page 7-51

5 Use the Raw Data view to 
display information about the 
raw data for a sample.

Analyzed Sample files contain 
both raw and analyzed data.

“Raw Data View” on page 3-15.
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6 Use EPT Data to troubleshoot 
problems caused by poor run 
conditions, such as the:

� EP voltage (for 
ABI PRISM 377).

� EP current.

� EP power (for the ABI 373).

� Laser power (for the 
ABI PRISM 310).

� Gel temperature versus 
time.

EPT data can be displayed for 
each Sample file.

“EPT Data View” on page 3-17.

Step Action See
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How to Verify Size Calculations

Introduction This section describes the following:

� Verifying for the GeneScan-350 Standard.

� Evaluating for Multiple Internal Size Standards.

Verifying for the
GeneScan-350

Standard

About the Standard

In the GeneScan-350 standard, the size of the first peak should be 
approximately 50 bp, the second 75 bp, and so on, assuming that 
processing started after the 35 bp fragment passed the scan region. If 
this appears to be correctly measured for your run, measurement of the 
sample fragments that ran with the standard should also be correct.

Note For a complete list of fragment sizes, refer to Appendix B, “GeneScan 
Size Standards.”

Procedure

To verify the size calculation for the GeneScan-350 standard: 

Step Action

1 In the Results Control window, select the Electropherogram and the 
Tabular Display icons.

2 Click the Clear All button to clear the panels.

3 Click the dye color indicator for the size standard you want to view.

4 Click Display.

Note You could also open the Sample File window of the 
Sample file of interest to verify size calling.
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5 Click each peak in the electropherogram and check the tabular data 
to ensure it is the correct size.

Note The peaks matched to the defined size standard are 
identified by dots next to the Dye/Sample Peak field.

6  If you find that the sizes were not calculated correctly, you can:

� Redefine the size standard, or

� Change the analysis parameters and re-analyze the affected 
samples (see “Defining Analysis Parameters” on page 5-18).

To verify the size calculation for the GeneScan-350 standard: (continued)

Step Action

Indicates peak matched to defined size standard
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Evaluating for
Multiple Internal

Size Standards

To evaluate size calculations for multiple internal size standards:

Step Action

1 In the Results Control window, select the Electropherogram button.

2 Click the Clear All button to clear the panels.

3 Click the On radio button to turn on the Quick Tile option.

4 Click the dye color indicators for the size standards you want to 
view.

When the Quick Tile option is on, the GeneScan Analysis Software 
inserts each in a separate panel.

Note Click the header of the appropriate dye/sample column to 
display all standards in the project that are the same color dye.

5 Click Display.

The standards appear in tiled electropherogram displays.

For information on setting the tiled electropherogram displays, see 
“Creating Tiled Electropherogram Displays” on page 7-10.

6 Choose Align by Size (� T) from the View menu if the 
electropherograms are not already aligned by size. 

The size standards should line up when aligned by size.

Note You can set preferences so that all new displays show 
data aligned by size. 

For more information, see “Changing How the Results are 
Displayed and Printed” on page 7-13.
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Using the Analysis Log

What is the
Analysis Log

The Analysis Log maintains a running record of analysis performed by 
the GeneScan Analysis Software. If a problem occurs during analysis of 
a Sample file, the Analysis Log automatically opens and appears in the 
foreground as an alert.

Displaying the
Analysis Log

Choose Analysis Log from the Windows menu.

The following is an example of the Analysis Log.
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What to Evaluate Evaluate the following:

Removing
Information from
the Analysis Log

To remove information from the Analysis Log:

Closing the
Analysis Log

You can either:

� Click the close box in the upper-left corner.

� Choose Close (� W) from the File menu.

What to evaluate What not to evaluate

Potential problems that the 
GeneScan Analysis Software might 
have had during size calling.

It will alert you to any peaks defined 
in the size standard definition that 
the software failed to match to the 
size standard run with your sample.

The GeneScan Analysis Software 
will not alert you to any consecutive 
peaks at the end of the definition.

This is to avoid logging warnings 
when your sample was not run long 
enough to include all the defined 
size standard peaks. 

This prevents you from having to 
create a new standard for shorter 
runs.

The Analysis log will, however, alert 
you if less than 50% of the defined 
size standard peaks were not 
matched, regardless of the peak 
locations in the definition.

Step Action

1 Select the information you want to remove.

Note Choose Select All (� A) from the Edit menu to select all 
the information.

2 Choose Clear from the Edit menu.
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How to Verify Peak Detection

Introduction Use the Show Peak Position command, while the electropherogram and 
associated tabular data are displayed, to verify results by examining 
how the GeneScan Analysis Software defined the total area that 
comprises each peak and the center of the peak.

Verifying Peak
Detection

To verify peak detection:

Step Action

1 Choose Show Peak Positions from the View menu.

Markers appear that identify the beginning, center, and end of each 
peak.

Note For a better view, choose Zoom In from the View menu, or 
use the Zoom tool (see “Zooming In and Out” on page 7-31).

2 Examine the display to ensure that each peak’s center, beginning, 
and end points are correct.

3 Choose Hide Peak Positions from the View menu to suppress the 
display of the peak markers.

Note You can also use the Sample Info view to display 
information about the peaks detected and matched. 

For more information, see “Description of Information” on page 3-9.
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Saving, Archiving and 
Copying Files 8
Introduction

In This Section Topics in this chapter include the following:

Topics See page

Saving GeneScan File 8-2

How to Archive Sample and Gel Files 8-6

Transferring Data to Other Applications 8-7

8
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Saving GeneScan File

Why Save The following table lists why to save projects, Sample files, and gel files. 
For information on archiving files, see “How to Archive Sample and Gel 
Files” on page 8-6.

Save Because See

GeneScan projects Protects the links to 
Sample files and their 
preferences.

Projects contain links 
to Sample files and 
preferences regarding 
display and analysis.

“Saving Projects” on 
page 8-3.

Sample files Protects the links to 
projects and their 
preferences.

Sample files also 
contain raw data and 
critical information 
about the run, settings, 
and analysis control.

“Saving Sample Files” 
on page 8-3.

Gel files Preserves the integrity 
of the data.

Note If you require 
long-term storage of 
multiple gel files, 
saving selected 
information from the 
files reduces their size 
considerably.

“Saving Gel Files” on 
page 8-4.

Results Displays Saves the Results 
Display settings in 
projects when you 
have found a display 
format that suits your 
needs.

“Saving Results 
Displays” on page 8-5.
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Saving Projects Note You do not need to save a Sample file after analysis. The analyzed 
data is written directly to the Sample file during analysis.

The following table lists the options for saving a project:

Saving Sample
Files

Choose Save Sample Info (� S) from the File menu.

Note If you choose Close from the File menu, or click the close box when 
you have not saved the changes, a dialog box asks if you want to save them.

If you choose... Then...

Save Project (� S) you can take the following action:

Save Project As a dialog box appears.

Select a location for the file, enter a name, and click 
Save.

If you... Then...

previously saved the 
project

it is automatically saved 
using the same name.

had not saved the 
project

a dialog box appears.

Select a location for the 
file, enter a name, and 
click Save.
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Saving Gel Files Why Save Only Parts of the Gel File Information

A gel file can be large, normally 10 MB to 60 MB. You do not need to 
keep a gel file once the tracking is verified and the corresponding 
Sample files are created. The following procedure describes how to 
keep parts of the information, while discarding the rest.

IMPORTANT Do not discard any gel file until you have verified the tracking 
and taken any required corrective action.

Procedure

To save selected information about a gel file: 

Step Action

1 Select Save As from the File menu. 

The Save As dialog box appears.

2 Select a location and type in a name for the file.

The default file name is the original file name with “copy” added.
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Saving Results
Displays

You can combine electropherograms and tabular data in many ways for 
display, and the GeneScan Analysis Software allows you to save 
display combinations and formats for future viewing.

For information on saving a display for future viewing, see “Saving and 
Renaming the Results Control Format” on page 7-17.

3 You have the following options from the pop-up menu:

To save selected information about a gel file: (continued)

Step Action

File format Description

Gel file Saves the entire gel file into the specified 
folder.

This includes the image, raw data, and 
other collection information.

Gel without image Saves all of the information in the gel file 
excluding the image.

Storage requirements are about one-third 
less than the entire gel file. 

When this gel file is later opened again in 
the analysis software, the image will be 
regenerated.

PICT file Creates a PICT file from the gel image.

This PICT file can not be opened in the 
analysis software.
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How to Archive Sample and Gel Files

Introduction Since the gel file is so large, you will probably want to back up only 
specific Sample files. Archive Sample files when you feel confident that 
the channel selections (tracking) used to generate them was correct. 

If you need to save a gel file, you can save only selected information 
from it, and greatly reduce the file’s size (see “Saving Gel Files” on 
page 8-4).

Archiving Sample
and Gel Files

The following table lists how to archive Sample and gel files:

Item Description How to archive

Sample files A sample file is 60 KB 
to 150 KB in size, 
depending on the 
length of the run.

Drag the file icon or the 
Run folder containing 
the files to floppy disk 
icon or to an 
alternative storage 
device.

A 1.4 MB high-density 
disks holds about 
twelve files.

Gel files Gel files contain the 
raw data acquired by 
the Data Collection 
software and take up a 
lot of space: 10 MB to 
60 MB is typical.

After the GeneScan 
Analysis Software 
generates Sample files 
from a 
correctly-tracked gel 
file, you do not need to 
save the gel file.

Make a backup copy of 
the gel file and remove 
the file from the hard 
disk.

For best performance, 
keep as few files on 
your hard disk as 
possible.

Use magnetic tapes, 
removable cartridge 
drives, or optical disks 
to archive gel files.

Gel files are too big for 
diskettes.
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Transferring Data to Other Applications

Other Applications GeneScan files can be read by the following version of the Genotyper® 
software for further analysis:

Both programs can convert GeneScan Analysis Software data into 
formats used by downstream applications like the GenBase™ software, 
GenoPedigree™ software, and Linkage, among others.

Cutting and
Pasting Tabular

Data

To cut and paste tabular data:

Genotyper 
software 
version... Can read...

1.0 Sample files from the GeneScan® Analysis Software

2.0 both Sample files and project files

Step Action

1 Display the tabular data you want to copy.

2 Select the rows you want to copy by taking the following action:

3 Choose Copy from the Edit menu.

4 Open the new application and click where you want to place the 
information.

5 Choose Paste from the Edit menu.

If you want to select... Then...

all tabular data choose Select All (� A) from 
the File menu.

several consecutive rows shift-click the first and last row 
in the group you want to select.

several rows that are not listed 
next to each other

�-click the rows.
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Creating a Text
File

To create a text file from tabular data.

Step Action

1 Display the tabular data.

2 Choose Export Table from the File Menu.

3 Choose a name and file location in the dialog box and click Save.
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Printing Results 9
Introduction

In this Chapter Topics in this chapter include the following:

Topics See page

About Printing 9-2

Automatically Printing Run Results 9-3

Printing the Gel Image 9-4

Printing Selected Sample Files 9-5

Printing Supporting Information 9-6

9
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About Printing

Ways You Can
Print

You can print the:

� Results of your run automatically at the end of the run or 
interactively, as selected Sample files or display combinations. 

� Gel file from the Gel File window, and supplementary information 
from the Sample Info view.

If You Get
Unexpected

Results

You might initially get unexpected results from autoprinting or the Print 
One command if you switch printers. 

The first time you print after changing the printer configuration, do the 
following:

First Second

Choose Print Setup from the File 
menu and click OK.

Choose Print from the File menu 
and use the standard Print dialog 
box.
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Automatically Printing Run Results

Introduction You can specify that the results are printed in the Data Collection 
software or in the GeneScan® Analysis Software.

From the Data
Collection

Software

When you choose automatic printing from the Data Collection software, 
the GeneScan Analysis Software prints a separate page for each 
designated Sample file, showing electropherograms and tabular data as 
specified in the Auto-Analysis Defaults (see step 2 on page 4-6).

Choose automatic printing in the Data Collection software as follows:

For information about setting up your run, refer to your instrument user 
manual.

From the
GeneScan Analysis

Software

When you analyze a project separately from the Data Collection 
software, you can print results automatically as the samples are 
analyzed.

On this instrument... Choose...

ABI PRISM® 310 Auto-Print in the Injection list.

ABI PRISM® 377 Auto-Print in the data collection Run 
window.

To print the results automatically as the samples are analyzed: 

Step Action

1 In the Analysis Control window, select the samples you wish to 
analyze.

For more information, see “Analyzing a Sample File” on page 3-19.

2 Select the checkbox labeled Print Results in the Analysis Control 
window. 

3 Click the Print Setup button to specify the samples and the format.

For more information, see “Specifying the Format for Printed 
Results” on page 5-9.

4 Click OK.

The results are printed after the results are analyzed.
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Printing the Gel Image

About Printing the
Gel Image

You can print a gel image any time it is displayed.

Note For best results when printing, adjust the gel contrast to increase the 
intensity of the gel colors. Depending on your printer, the printed image may be 
less intense than the screen image.

Procedure To print the gel image, press Command (�)-Shift-3 to get a screen 
capture of everything displayed on the screen.
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Printing Selected Sample Files

Introduction You can print selected Sample files using the Results Control window or 
by choosing the Sample file.

Setting Printing
Options

To set the printing options, use the Results Display Preferences dialog 
box (see “Changing How the Results are Displayed and Printed” on 
page 7-13). 

These options affect the electropherogram height and page breaks. 
Depending on how you set these options, the format that prints may be 
different from what is on the screen.

For information on printing saved Results Control formats, see “Working 
with a Previously Saved Displays” on page 7-18.

From the Results
Control Window

You print selected samples after analysis, regardless of whether you 
choose automatic printing.

To print results for selected Sample files after analysis: 

Step Action

1 In the Results Control window, select the dye/samples and format 
you wish to print.

Use the same technique as selecting the format and the 
dye/samples to display the data. 

For more information, see “Using the Results Control Window” on 
page 7-7.

2 Take the following action:

� Click Print.

� Choose Print or Print One from the File menu.

Note If you choose Print One the Print dialog box does not 
appear.
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From the File
Menu

To print a Sample file from the File menu:

Printing Supporting Information

Introduction The following procedure describes how to print supporting information 
about a Sample file, such as the Sample Info view, or to print the 
sample sheet.

Note You can use the same procedure for ABI™  373 and ABI PRISM 377 
runs to print the Sample Sheet and an image of the Gel File window.

Procedure To print supporting information:

Step Action

1 Choose Open from the File menu.

The Open Existing dialog box appears.

Note You can also double-click the sample name in the Finder. 
If the GeneScan Analysis Software is not running, the software 
starts and opens the Sample file.

2 Click the Sample file icon.

3 In the dialog box that appears, find and select the Sample file that 
you want to open.

4 Click Open.

The Sample File window appears.

5 Select a display mode and choose Print or Print One from the File 
menu.

Step Action

1 Display the information you want to show.

2 Choose Print (� P) or Print One from the File menu.

Note If you choose Print One the Print dialog box does not 
appear.
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Using GeneScan with 
the ABI 373 A
Introduction

In This Appendix Note This section does not apply if you are processing data collected on 
ABI™  373 DNA Sequencer with XL upgrade instruments.

Topics in this appendix include the following:

Topics See page

Processing Using the ABI 373 A-2

Setting Gel Processing Parameters A-5

Opening the Collection File A-7

Completing the Sample Sheet A-9

Tracking Lanes A-11

Generating Sample Files A-12

A
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Processing Using the ABI 373

Introduction This section describes using the ABI 373 data with the GeneScan 
Analysis Software in the same way as you use ABI PRISM® 377 data. 
When the GeneScan® 672 Software has been upgraded to work on a 
Power Macintosh® computer running System 7.5 or higher, this will be 
true. 

ABI 373 Versus
ABI PRISM 377

Data

The ABI 373 and ABI PRISM 377 run on different computers. If you use 
the GeneScan® 672 Software to collect data on the ABI 373, the 
data-collection program runs on a 68K Macintosh® computer. Since the 
GeneScan Analysis Software 2.0 or later runs on a Power Macintosh 
computer, transfer the data to a Power Macintosh®-compatible 
computer before analyzing the data.

Using the
GeneScan Analysis

Software Before
Version 2.0

Using the GeneScan® 672 Software on data collected using the   
ABI 373, the software creates a Collection file that contains the raw 
data. When using previous versions of the GeneScan Analysis Software 
(before 2.0), you preprocessed this Collection file to create a gel file. 
Once you were satisfied with the tracking of the gel file, the gel file could 
be analyzed to create a Results file. The Results file contained all of the 
analyzed data.

Using the
GeneScan Analysis

Software Version
2.0 or Later

Using the GeneScan® Analysis Software version 2.0 or later, it was not 
necessary to preprocess the Collection file. You process the Collection 
file to create Sample files, then analyze the Sample files. Each Sample 
file contains information from one lane of the gel and, after analysis, the 
corresponding analyzed data.
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Processing Steps The steps to using the GeneScan Analysis Software with ABI 373 data 
are as follows:

Comparison of
GeneScan Analysis

The following figure is a comparison of using the GeneScan® Analysis 
Software before version 2.0 and how to use the software with version 
2.0 or later. Once you have generated Sample files, use the GeneScan 
Analysis Software as described in this manual.

Note After analysis, the GeneScan Analysis Software automatically creates 
a Run folder named “373 SampleFiles <date>”, where <date> is the original 
date on which the GeneScan® 672 Software file was generated.

Step Action See page

1 Setting Gel Processing Parameters. A-5

2 Opening the Collection File. A-7

3 Completing the Sample Sheet. A-9

4 Tracking lanes. A-11

5 Generating Sample files. A-12
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GeneScan® 672 Software on 
ABI 373 instrument

Collection file

Results file

GS Analysis 
preprocesses 
Collection file to 
create gel file

GS Analysis analyzes 
gel file to create 
Results file

Analyzed data and 
analysis information 
stored in a single 
Results file

Sample files before analysis

Sample files after analysis

Gel file

GeneScan® Analysis Software on 
ABI 373 instrument

Collection file

GeneScan Prior to Version 2.0 Using GeneScan 2.0 or Later



Using GeneScan with the ABI 373 A-5

Setting Gel Processing Parameters

Introduction Before you open a Collection file, set the gel processing parameters. 
The GeneScan® Analysis Software takes the information in the 
processing parameters into account when it opens the Collection file.

Procedure

To set the gel processing parameters: 

Step Action

1 Double-click the GeneScan Analysis Software icon to start the 
program. 

2 Choose Gel Preferences from the Settings menu.

The Gel Preferences dialog box appears.

Note The checkboxes under Auto-Launch processing only 
apply when the Data Collection software automatically starts the 
GeneScan Analysis Software. The GeneScan® 672 Software does 
not automatically start GeneScan 2.1.

IMPORTANT Before choosing Auto-Track Lane, verify that the 
comb type is set correctly by choosing Preferences from the 
Settings menu and Gel Preferences from the submenu.
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3 You can take the following action in the Image Generation Defaults 
section:

For more information, see “Image Generation Defaults” on 
page 2-4.

Note Setting a range for gel display processing is similar to the 
same function in the preprocessing parameters of the GeneScan 
1.X software.

4 You can take the following action in the Lane Extraction section:

For more information, see “Lane Extraction” on page 2-7.

5 Click OK. 

To set the gel processing parameters: (continued)

Step Action

To... Then...

start and stop processing data

Note All scans outside the 
specified scan range are 
ignored.

enter the scan numbers in the 
Scan Range Stop and Start 
text entry boxes.

compensate for the spectral 
overlap between dyes

select the Multicomponent Gel 
Image checkbox.

set the upper limit of the scale 
of the peaks in the Slice view of 
the Gel window

Note This value also affects 
the brightness of the fragment 
bands.

enter a value in the Estimated 
Maximum Peak Height text 
box.

To... Then...

use a weighted average select the weighted averaging 
checkbox.

specify the number of channels 
to be averaged

enter a value in the Channel 
averaging text box.

stop extraction when the 
extraction process falls below a 
set confidence level

select the Stop extraction when 
below confidence level 
checkbox.

Enter a value in the 
Confidence Threshold box.
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Opening the Collection File

Introduction When first opening a Collection file, you usually need to tell the 
GeneScan Analysis Software how many lanes were collected, and what 
matrix file should be used to adjust for spectral overlap.

Procedure

Opening the Collection file: 

Step Action

1 Choose Open from the File menu.

The dialog box appears.

2 You can either:

� Double-click the file name, or

� Select the desired Collection file and click Open.

 The gel file verification dialog box appears. 

3 When opening a Collection file, specify to the GeneScan Analysis 
Software the number of lanes collected by entering the appropriate 
number in the entry field and clicking OK.

4 Another dialog box appears if the Multicomponent Gel Image 
checkbox in the Gel Processing Parameters was selected.

Identify the matrix file to use for adjusting spectral overlap. 

For more information, see Chapter 7, “Evaluating Analysis Results.”

Note If multicomponent was not chosen, but later you decide to 
regenerate the image with adjustment for spectral overlap, choose 
Install New Gel Matrix from the Gel menu to attach a Gel matrix 
(see “Installing New Matrix Information” on page 2-24).
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5 Find and select the matrix file you wish to attach and click Open.

Note This version of the GeneScan Analysis Software can read 
a matrix generated using GeneScan 1.X. Move the matrix file from 
the 68K Macintosh® computer to the Power Macintosh® computer 

you are using for analysis.

The GeneScan Analysis Software:

� Attaches the matrix to the Collection file

� Adjusts for spectral overlap, and 

� Generates a gel image, which appears on the screen.

For more information on the gel image, see page 2-27.

Opening the Collection file: (continued)

Step Action
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Completing the Sample Sheet

Introduction After opening the Collection file, complete the Sample Sheet embedded 
and track the lanes. This ensures that when the Sample files are 
generated they contain the correct information.

The Sample Sheet that is part of the Collection file is blank when it is 
opened. This is because the GeneScan® 672 Software does not 
automatically embed a copy of the data collection Sample Sheet in the 
Collection file.

Procedure IMPORTANT When tracking and extracting the Collection file, ensure the 
Sample Sheet associated with the gel file has the checkbox labeled “Used” 
selected for each sample you want to extract. The GeneScan Analysis Software 
only extracts the samples with that checkbox selected.

To complete the Sample Sheet: 

Step Action

1 Open the Sample Sheet by either:

� Clicking the Sample Sheet button in the upper-left corner of the 
Gel Window, or by

� Choosing Gel Sample Sheet from the Gel menu.

2 Enter the following information:

� Sample file name.

� Sample name for each sample.

� Sample info.

� Comment for each dye/sample.

For more information, see “Displaying the Sample Sheet” on 
page 2-29.

3 Select checkboxes, as applicable.

To... Then select the...

indicate that the lane contains 
data

Used checkbox.

automatically analyze Sample 
files when generating them

"A" checkbox.

automatically print Sample files 
when generating them

"P" checkbox.
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4 Identify the dye standard for each sample by clicking in the 
appropriate dye cells under the standard column.

Note Alternately, you can create a stand-alone Sample sheet 
and attach it to the gel file using the Install New Sample Sheet 
command from the Gel menu (see “Installing a New Sample Sheet” 
on page 2-36).

5 Choose Save (�-S) or Save As from the File menu.

If you click the close box before saving, a dialog box appears with 
the message whether or not to save the entries.

To complete the Sample Sheet: (continued)

Step Action
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Tracking Lanes

Introduction When opening a Collection file, the GeneScan Analysis Software 
places an appropriate number of straight tracker lines on the image, 
based on the number of lanes chosen using the Gel file verification 
dialog box (see “Opening the Collection File” on page A-7). The 
software does not automatically track the lanes. You must do so before 
generating Sample files.

Process The normal process is as follows:

Procedure To track the lanes and review the tracking before generating Sample 
files:

Step Action

1 Track the lanes.

2 Review and edit the tracking, if necessary.

3 Generate the Sample files.

Note However, if you wish, you can automatically extract 
sample information and create Sample files immediately after 
tracking.

Step Action

1 Choose Track Lanes from the Gel menu.

IMPORTANT Before choosing Auto-Track Lane, verify that the 
comb type is set correctly by choosing Preferences from the 
Settings menu and Gel Preferences from the submenu.

The Track Lanes dialog box appears.

2 Click Auto-Track Lanes.
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Generating Sample Files

When to Generate
Sample Files

Generate new Sample Files from the lanes if you:

� Did not automatically generate Sample files after tracking, or you

� Edited the lane tracking.

For information on generating sample files, see “Extracting Data 
Without Changing the Current Tracker” on page 2-64.

3 Review the tracking and edit as necessary. 

For information on:

� Editing tracking, see “Working with Tracker Lines” on 
page 2-53.

� Changing the appearance of the window for better visibility, see 
“How to Adjust the Gel Image” on page 2-18.

4 When you are satisfied with the tracking, choose Save from the File 
menu.

Step Action
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GeneScan Size 
Standards B
Introduction

In This Appendix Applied Biosystems provides four different size standards that you can 
choose from to analyze fragments run on the ABI PRISM® 310, the ABI™  
373, or the ABI PRISM® 377. 

See also “About Size Standards” on page 5-29.

Topics in this appendix include the following:

Topics See page

GeneScan 350 Size Standard B-2

GeneScan-400HD Size Standard B-4

GeneScan 500 Size Standard B-6

GeneScan 1000 Standard B-8

GeneScan 2500 Standard B-10

B
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GeneScan 350 Size Standard

What To Use It For GeneScan 350 is a size standard useful for sizing fragments between 
35 and 350 base pairs. The native fragments are uniformly spaced to 
provide accurate size calling.

How It Is Prepared GeneScan 350 is prepared by Pst 1 digestion of plasmid DNA, followed 
by ligation of a TAMRA or ROX-labeled 22-mer oligodeoxynucleotide to 
the cut ends. A subsequent enzymatic digestion with BstU 1 yields DNA 
fragments containing a single TAMRA or ROX dye (see “GeneScan 350 
Molecular Lengths” below).

GeneScan 350
Molecular Lengths

The following table lists the GeneScan 350 Denatured Fragment 
Molecular Lengths (Nucleotides):

Running Under
Denaturing
Conditions

The following table describes running the GeneScan 350 standard 
under denaturing conditions:

250 139 35

300 150 50

340 160 75

350 200 100

Like However Consequently

the GeneScan 2500 
and GeneScan 1000 
standards, the 
GeneScan 350 
standard is made of 
double-stranded DNA 
fragments. 

like GeneScan 500, the 
GeneScan 350 
standard has only one 
labeled strand.

under denaturing 
conditions, even if the 
two strands migrate at 
different rates, only the 
labeled strand is 
detected.

Because of this, split 
peaks are avoided that 
result when two 
strands move through a 
denaturing polymer at 
different rates, see the 
figure below.
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Double-Stranded
GeneScan 500

Fragments

The following figure shows the sizes of double-stranded GeneScan 500 
fragments. Use these values to size fragments run under native 
conditions.

IMPORTANT An asterisk (*) for the 250 and 340 base pair peaks denotes 
peaks resulting from abnormal migration of double strands that did not 
completely separate under denaturing conditions when analyzed on the 
ABI PRISM 310. Do not use these peaks to size samples. The peaks show 
smaller values than the actual size of the fragments. Refer to the GeneScan 
Reference Guide, Chemistry Reference for the ABI PRISM 310 Genetic Analyzer 
(P/N 4303189 rev A) for further details.
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GeneScan-400HD Size Standard

What To Use It For You can use the GeneScan-400HD (High Density) size standard to 
determine fragment lengths between 50 and 400 base pairs.

Special Uses The high density of marker bands in this standard makes it particularly 
useful for microsatellite analysis. All fragments have been checked for 
migration that is true to size under a wide variety of run conditions on all 
ABI PRISM® instruments. There are no anomalous fragments (e.g., the 
250-bp fragment in GeneScan-350 on the ABI PRISM 310 Genetic 
Analyzer).

Note GeneScan-400HD is the recommended size standard for use with the 
ABI PRISM Linkage Mapping Set Version 2.

How It Is Prepared All aspects of the preparation of the GeneScan-400HD size standard 
are proprietary. Each fragment contains a single ROX fluorophore.

Fragment Lengths The following table lists the lengths of the 21 fragments comprising the 
GeneScan-400HD size standard:

50 160 260 360

60 180 280 380

90 190 290 400

100 200 300

120 220 320

150 240 340
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Denaturing
Electropherogram

Although the GeneScan-400HD size standard is made of 
double-stranded DNA fragments, only one of the strands is labeled. 
Consequently, even if the two strands migrate at different rates under 
denaturing conditions you will not need to worry about peak splitting. 
The following figure shows the peak patterns of GeneScan-400HD 
fragments run under denaturing conditions. Fragments were run using 
the POP-4 polymer at 60 °C.

Non-denaturing
Electropherogram

The following shows the peak patterns of GeneScan-400HD fragments 
run under non-denaturing conditions. Fragments were run using 
3% GeneScan Polymer (GSP) at 30 °C.
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GeneScan 500 Size Standard

What To It Use For GeneScan 500 is a size standard useful for sizing fragments between 
35 and 500 base pairs. The native fragments are uniformly spaced to 
provide accurate base calling.

How It Is Prepared GeneScan 500 is prepared by Pst 1 digestion of plasmid DNA, followed 
by ligation of a TAMRA or ROX-labeled 22-mer oligodeoxynucleotide to 
the cut ends. A subsequent enzymatic digestion with BstU 1 yields DNA 
fragments containing a single TAMRA or ROX dye (see “GeneScan 350 
Molecular Lengths” below).

GeneScan 500
Molecular Lengths

The following table lists the GeneScan 500 Denatured Fragment 
Molecular Lengths (Nucleotides):

Running Under
Denaturing
Conditions

The following table describes running the GeneScan 500 standard 
under denaturing conditions:

400 250 139 35

450 300 150 50

490 340 160 75

500 350 200 100

400 250 139 35

Like However Consequently

the GeneScan 2500 
and GeneScan 1000 
standards, the 
GeneScan 500 
standard is made of 
double-stranded DNA 
fragments. 

with GeneScan 500, 
only one strand of the 
double-stranded DNA 
is labeled, whereas the 
other two standards 
have labels on both 
strands.

under denaturing 
conditions, even if the 
two strands migrate at 
different rates, only the 
one labeled strand is 
detected. 

Because of this, split 
peaks are avoided that 
result when two 
strands move through a 
denaturing polymer at 
different rates, see the 
figure below
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Double-Stranded
GeneScan 500

Fragments

The following figure shows the sizes of double-stranded GeneScan 500 
fragments. Use these values to size fragments run under native 
conditions.

Asterisks
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GeneScan 1000 Standard

How It Is Prepared The GeneScan 1000 standard is prepared by digesting pBR322 with 
the restriction enzyme Alu I, followed by the ligation of a ROX labeled 
oligonucleotide. This standard has 17 fragments, ranging from 47 to 
946 base pairs.

GeneScan 1000
Molecular Lengths

Fluorescently labeled native fragments are 18 nucleotides longer than 
denatured fragments (see the table below). You can use this standard to 
size fragments in the 100 to 900 base pair range.

GeneScan 1000 Fragment Molecular Lengths (Base Pairs):

Unlabeled Native (+36)

928 946

677 695

674 692

539 557

421 439

299 317

275 293

244 262

118 136

108 126

81 99

75 93

56 85

64 82

37 55

33 51

29 47
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Running Under
Native Conditions

The following diagram shows the peak pattern of fragments run under 
native conditions on an ABI PRISM 310 using 2.5% GeneScan Polymer 
Solution in a 30 cm Ld capillary.

IMPORTANT An asterisk (*) for the 262 and 692 base pair peaks denotes 
peaks resulting from abnormal migration of double strands that did not 
completely separate under denaturing conditions when analyzed on the 
ABI PRISM 310. Do not use these peaks to size samples. The peaks show 
smaller values than the actual size of the fragments. Refer to the GeneScan 
Reference Guide, Chemistry Reference for the ABI PRISM 310 Genetic Analyzer 
(P/N 4303189 rev A) for further details.

Asterisks
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GeneScan 2500 Standard

How It Is Prepared The GeneScan 2500 standard is made from lambda phage DNA 
restriction digested with Pst I, followed by ligation of either a TAMRA or 
ROX oligonucleotide. It has 28 fragments, ranging from 55 to 14, 097 
base pairs (bp).

What To Use It For You can use the GeneScan 2500 standard for native applications to size 
fragments in the 100 to 5,000 base pair range.

Running Under
Native Conditions

The following figure shows the peak pattern of fragments run under 
native conditions on the ABI PRISM 310 using 2.5% GeneScan Polymer 
Solution in a 30 cm Ld capillary.

IMPORTANT An asterisk (*) for the 508 base pair peaks denotes peaks 
resulting from abnormal migration of double strands that did not completely 
separate under denaturing conditions when analyzed on the ABI PRISM 310. Do 
not use these peaks to size samples. The peaks show smaller values than the 
actual size of the fragments. Refer to the GeneScan Reference Guide, 
Chemistry Reference for the ABI PRISM 310 Genetic Analyzer (P/N 4303189 
rev A) for further details.

Asterisk



GeneScan Size Standards B-11

GeneScan 2500
Molecular Lengths

Fluorescently labeled native fragments are 18 nucleotides longer than 
denatured fragments (see table below).

GeneScan 2500 Molecular Lengths (bp) 

Denatured Native (+18)

14079 14097

5099 5117

4771 4789

4529 4547

2860 2878

2481 2499

2465 2483

2162 2180

2008 2026

1722 1740

1181 1199

1115 1133

827 845

536 554

490 508

470 488

361 379

286 304

269 287

238 256

233 251

222 240

186 204

172 190

116 134

109 127

94 112

37 55
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Size Calling MethodsC

Introduction

In This Appendix Topics in this appendix includes the following:

Topic See

Least Square Method C-2

Cubic Spline Interpolation Method C-4

Local Southern Method C-5

Global Southern Method C-7

C
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Least Square Method

About This
Method

Both Least Squares methods (2nd Order and 3rd Order) use regression 
analysis to build a best-fit size calling curve. This curve compensates 
for any fragments that may run anomalously. As a result, this method 
normally results in the least amount of error for all the fragments, 
including the size standards and the samples.

Depending on whether you choose the 2nd or 3rd Order Least Squares 
Method in the Analysis Parameters dialog box, the resulting size curve 
is either a quadratic or a cubic function. The software uses the known 
standard fragments and the associated scan number positions to 
produce a sizing curve based on Multiple Linear Regression.

Advantages In the figures Figure C-1 and Figure C-2, you can see that in nearly all 
instances the mobility of an individual DNA fragment is coincident with 
the best curve fit of the entire data set. Stated differently, the mobility of 
most DNA fragments is strictly length-dependent. This method 
automatically compensates for fragments that run anomalously.

GeneScan® Analysis Software calculates a best-fit least squares curve 
for all samples, regardless of the size calling method you choose. The 
curve is black in the Standard Sizing Curve window.

Figure C-1 2nd Order Least Squares size calling curve
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Figure C-2 3rd Order Least Squares size calling curve
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Cubic Spline Interpolation Method

About This
Method

By definition, the Cubic Spline method forces the sizing curve through 
all the known points of the selected GeneScan size standard. Although 
this produces exact results for the values of the standards themselves, 
it does not compensate for standard fragments that may run 
anomalously.

Possible Local
Sizing Inaccuracy

Mobility of any DNA fragment can be affected by its sequence, and by 
secondary and tertiary structure formation. If any internal size standard 
fragment has anomalous mobility, the Cubic Spline method may exhibit 
local sizing inaccuracy. 

For example: Assume that a standard fragment is close in molecular 
length to an unknown sample fragment. Assume further that the 
standard fragment runs anomalously. The Cubic Spline method assigns 
the official value to this standard fragment, even though it may be 
slightly incorrect. The size of the unknown fragment is then likely to be 
calculated incorrectly as well. 

Note This method does not determine the amount of sizing accuracy error.
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Local Southern Method

About This
Method

The Local Southern method determines the sizes of fragments by using 
the reciprocal relationship between fragment length and mobility, as 
described by E. M. Southern (1979). 

The Equation The following table describes how the equation works:

Equation Description

L = [c/(m-m0)] + L0 Attempts to describe the reciprocal 
relationship between the mobility, m, 
and the length, L0, of the standard 
fragments.



C-6 Size Calling Methods

How This Method
Works

This method, which is similar to the Cubic Spline method, uses the four 
fragments closest in size to the unknown fragment to determine a best 
fit line value. Using this method, only the region of the size ladder near 
the fragment of unknown length is analyzed. 

Note Size estimates may be off if any of the standard fragments run 
anomalously.

The following table lists how the Local Southern method works:

Step Action

1 The fitting constants of the curve are calculated for each group of 
three neighboring points on the standard. 

A separate curve is created for each set of three points.

2 A curve is then created by using three standard points (two points 
below and one point above the fragment) and a fragment size is 
determined.

3 Another curve is created by looking at an additional set of three 
points (one point below and two points above the fragment) and 
another value is assigned. 

4 The two size values are averaged to determine the unknown 
fragment length.
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Global Southern Method

About This
Method

This method is similar to the Least Squares method in that it 
compensates for standard fragments that may run anomalously. The 
method creates a best-fit line through all the available points, and then 
uses values found on that line to calculate the fragment values.

The Equations The following table describes the equations work:

Equation Description

L = [c/(m-m0)] + L0 Attempts to describe the reciprocal 
relationship between the mobility, m, 
and the length, L0, of the standard 
fragments.

Âi(Li - (c/(mi-m0) + L0))2 The fitting constants L0, m0 and c 
are calculated by a least squares fit 
to minimize the following quantity.
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How This Method
Works

All points in the standard are weighted equally and the curve is not 
constrained to go through any specific point. The software can analyze 
a large range of fragment sizes with this method.

For best results, use a standard that brackets all the fragments of 
interest.

DNA fragments that are... Are sized using...

not bracketed within the size 
standard curve

a second order least squares curve 
extrapolation.

bracketed within the size standard 
curve

the method that was chosen.
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Troubleshooting the 
GeneScan Software D
Introduction

In This Appendix The tables in this section present information about problems you might 
experience with your GeneScan® Analysis Software runs, and suggest 
possible causes and corrections.

For information on troubleshooting the BioLIMS™ database, see 
Appendix F, “Troubleshooting the BioLIMS Database.”

Topics in this appendix include the following:

Topics See page

Troubleshooting Projects and Results D-2

Troubleshooting Gel Data D-5

Troubleshooting Genotyping Results D-8

GeneScan Error Messages D-9

D
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Troubleshooting Projects and Results

Table Description The following table lists the problem, probable cause, and correction for 
troubleshooting projects and results.

Troubleshooting projects and results: 

Problem Probable Cause Correction

File name is dimmed in 
Size Standard or 
Parameters column in 
Analysis Control 
window.

The file has been 
moved from the folder 
in which it was located 
when it was first 
selected.

a. Move the file back 
to its original 
location.

b. Reset preferences 
to specify the new 
folder location.

c. Create or select a 
new file.

Peaks appear on 
display but the 
GeneScan Analysis 
Software does not 
detect them (cannot 
select them in 
electropherogram 
display).

� Peak Amplitude 
Threshold set too 
high.

� Minimum Peak 
Half Width set too 
high.

� Electrophoresis 
run too quickly 
resulting in poor 
resolution.

a. Adjust minimum 
peak height to 
include smallest 
peaks desired and 
re-analyze.

b. Reduce minimum 
peak half width 
setting and 
re-analyze.

c. Repeat 
electrophoresis at 
reduced power.

For more information, 
see “Peak Detection 
Parameter Options” on 
page 5-20.

At the position of one 
strong peak additional 
colors appear 
underneath the peak.

� Off-scale data not 
multicomponented 
correctly.

� Poor / incorrect 
matrix.

a. Repeat 
electrophoresis; 
load less sample.

b. Attach a new gel 
matrix and 
regenerate 
Sample files, or 
assign a new 
matrix to the 
Sample file and 
re-analyze.
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Peaks appearing in a 
dye color that should 
not be present.

Bleed-through from 
other colors because of 
off-scale data.

Repeat 
electrophoresis; load 
less sample.

A sample run on two 
different gels does not 
give the same 
molecular weights.

� Size standard 
peaks called 
incorrectly by 
software.

� Different sizing 
method used for 
each gel.

� Inaccuracies 
associated with 
off-scale data do 
not allow for 
identification of top 
of true peak.

a. Check size 
standard and 
sizing curve; 
Re-analyze the 
Sample file with a 
different size 
standard or create 
a new one.

b. Make sure same 
sizing method has 
been used for both 
gels.

c. Repeat 
electrophoresis; 
load less sample.

Using GS-350 
standard, size 
peaks >350 bp cannot 
be sized.

Sizing requires at least 
one standard fragment 
larger than peak to be 
sized.

For more information, 
see Appendix B, 
“GeneScan Size 
Standards.”

Repeat electrophoresis 
using GS-500.

Peak centers seem to 
be incorrect in 
electropherogram.

� Resolution of the 
gel might be 
inadequate (ABI™  
373 or ABI PRISM® 
377). 

� Signal-to-noise 
ratio might be too 
low.

Repeat electrophoresis 
at lower power or with 
longer gel.

Troubleshooting projects and results: (continued)

Problem Probable Cause Correction
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Software cannot 
display the sizing curve 
for a sample.

� Sample’s in-lane 
size standard does 
not match defined 
size standard.

� Sample file was 
not size called.

� Re-analyze the 
Sample file with a 
different size 
standard, or 
create a new one.

In the Analysis Control 
window:

d. �-click 
dye/sample that 
represents Size 
Standard for the 
Sample file.

e. Choose a size 
standard definition 
file and 
re-analyze.

Peaks disappear in the 
electropherogram.

Included the primer 
peak in the analysis.

Troubleshooting projects and results: (continued)

Problem Probable Cause Correction
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Troubleshooting Gel Data

Table Description The following table lists the problem, probable cause, and correction for 
troubleshooting gel data.

Troubleshooting gel data: 

Problem Probable Cause Correction

At the position of one 
strong peak additional 
colors appear 
underneath the peak.

� Off-scale data not 
multicomponented 
correctly.

� Poor / incorrect 
matrix.

� Gel Image not 
multicompo-
nented.

a. Repeat 
electrophoresis; 
load less sample.

b. Attach a new gel 
matrix, regenerate 
the gel image.

c. Regenerate the 
gel image with 
multicomponent-
ing selected. 

Peaks appearing in a 
dye color that should 
not be present.

Bleed-through from 
other colors because of 
off-scale data.

Repeat 
electrophoresis; load 
less sample.

TAMRA-labeled size 
standard appears 
yellow on the gel 
display.

Collected using:

� Filter set A 
(ABI 373), or

� Virtual filter A 
(ABI PRISM 377).

Repeat electrophoresis 
with:

� Filter set B 
(ABI 373), or 

� Virtual filter C 
(ABI PRISM 377).

TET-labeled products 
not seen on gel display.

Collected using:

� Filter set A 
(ABI 373), or

� Virtual filter A 
(ABI PRISM 377).

Repeat electrophoresis 
with:

� Filter set B 
(ABI 373), or 

� Virtual filter C 
(ABI PRISM 377).
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Signal showing up in 
neighboring lanes.

Leaking wells of gel. � Consider using a 
square tooth comb 
instead of a shark 
tooth comb.

� If using 96-lanes, 
then rerun gel 
using protocol in 
the ABI PRISM 377 
DNA Sequencer 
96-Lane Upgrade 
User’s Manual 
(P/N 4305423).

Signal intensity very 
high and signal is 
being detected in 
neighboring lanes due 
to closeness of 
spacing.

Move tracker lane 
position from center of 
band to edge of the 
band away from strong 
signal and extract as 
usual.

Use 1 or 2 lane 
averaging to extract 
lanes.

HEX-labeled products 
appear green on gel 
display.

Collected using:

� Filter set A 
(ABI 373), or 

� Virtual filter A 
(ABI PRISM 377).

Repeat electrophoresis 
with:

� Filter set B 
(ABI 373), or 

� Virtual filter C 
(ABI PRISM 377).

Collection time was 
sufficient, but only a 
small portion of gel 
displayed.

� Gel Image 
Processing 
preferences did 
not include 
enough scans to 
display entire gel. 

� Electrophoresis 
power too low.

a. Regenerate gel 
image with new 
scan range.

b. Adjust to correct 
settings; repeat 
electrophoresis.

Troubleshooting gel data: (continued)

Problem Probable Cause Correction
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Improper tracking 
results.

Bad matrix. Attach new matrix.

Sample Sheet not filled 
out properly.

Fill out Sample Sheet 
properly.

Comb types set 
improperly.

a. Fix and type in gel 
preferences.

b. Retrack gel.

Peak height or red 
signal too low.

Rerun gel with more 
size standard.

Troubleshooting gel data: (continued)

Problem Probable Cause Correction
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Troubleshooting Genotyping Results

Table Description The following table lists the problem, probable cause, and correction for 
troubleshooting the Genotyper® software results.

Problem Probable Cause Correction

Allele peaks seen in 
correct molecular 
weight range, with 
additional peaks seen 
outside this range.

� Bleed-through 
from other colors 
because of 
off-scale data.

� Primers not fully 
optimized.

a. Repeat 
electrophoresis; 
load/inject less 
sample.

b. Check 
optimization.

With allele peaks of 
high intensity, the 
GeneScan Analysis 
Software calls many 
small peaks.

� Background above 
minimum peak 
height.

� Too much PCR 
product loaded.

a. Adjust minimum 
peak height; 
re-analyze.

b. Repeat 
electrophoresis; 
load/inject less 
sample.

For more information, 
see “Peak Detection 
Parameter Options” on 
page 5-20.

A homozygous 
individual shows a dip 
at the top of an allele 
peak which may be 
called as two separate 
peaks.

Truncated single peak 
because of off-scale 
data can appear as two 
peaks.

Repeat 
electrophoresis; 
load/inject less sample.

Warning message: 
“Could not complete 
‘Run Macro’ command 
because the labeled 
peak could not be 
found.”

The first allele peak for 
one or more loci in the 
allelic ladder is lower 
than the preset 
minimum peak height 
specification in the 
categories list.

a. Adjust minimum 
peak height; 
re-analyze.

b. Repeat 
electrophoresis; 
load/inject less 
sample.

For more information, 
see “Peak Detection 
Parameter Options” on 
page 5-20.
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GeneScan Error Messages

Introduction This section includes three tables:

� GeneScan Analysis Software Crashes with BioLIMS.

� Analysis Log Error Messages.

� Error Messages When Defining Size Standards.

GeneScan Analysis
Software Crashes

with BioLIMS

The following table lists the error message you might encounter if the 
application crashes with BioLIMS installed:

Observation Possible Cause Recommended Action

GeneScan Analysis 
Software (with 
BioLIMS) crashes on 
launch or gives an 
error message, 
‘Could not open “ ” ’.

Insufficient memory 
to load the Oracle® 
or Sybase® libraries.

Ensure that there is at least 
2 MB of free memory in 
addition to the preferred 
memory requirements set 
on the GeneScan Analysis 
Software Info box.

To access the Info box, 
select the GeneScan 
application and choose Get 
Info from the File menu.

GeneScan Analysis 
Software (with 
BioLIMS) crashes 
when attempting to 
connect to a Sybase 
database.

SybaseConfig 
control panel or 
libtcp extension file is 
missing or disabled.

Use the Extension Manager 
to check that these files are 
present and turned on.

If either file is missing, then 
reinstall the BioLIMS Client 
software.
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Analysis Log
Error Messages

The following table lists the error messages you might encounter in the 
GeneScan Analysis Software Log.

Analysis Log error messages: 

Analysis Log Error 
Message Comment/Correction Refer To

The Analysis Range 
does not include 
enough data points. 

Check your Analysis 
Parameters.

Make sure the Analysis 
Range in your Analysis 
Parameters contains at 
least 250 data points.

“Defining Analysis 
Parameters” on 
page 5-18.

The Range of Data 
Points to analyze is too 
large. 

Check your Analysis 
Parameters.

Specify a smaller 
range in the Analysis 
Parameters.

“Defining Analysis 
Parameters” on 
page 5-18.

The Analysis 
Parameters could not 
be accessed. 

Check your Analysis 
Parameters Setting.

Make sure the Analysis 
Parameters file 
specified in the 
Analysis Control 
window is valid and 
accessible.

“Defining Analysis 
Parameters” on 
page 5-18.

The Sample File does 
not contain a valid 
matrix. 

Assign a new matrix to 
the Sample File and try 
again.

Assign a new matrix to 
the Sample file and re-
analyze.

“Installing a New Matrix 
File” on page 3-20.
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Error Messages
When Defining
Size Standards

The following table list the error messages you might encounter while 
defining size standards.

The Sample File’s 
Matrix was not found. 

Assign a new matrix to 
the Sample File and try 
again.

Assign a new matrix to 
the Sample file and re-
analyze.

Choose Preferences 
from the Settings menu 
and Folder Locations 
from the submenu. 

Check the location of 
the matrix folder.

For more information, 
see “Specifying File 
Locations” on 
page 5-42.

“Installing a New Matrix 
File” on page 3-20.

Analysis Log error messages: (continued)

Analysis Log Error 
Message Comment/Correction Refer To

Error messages when defining size standards: 

Error Message Comment/Correction Refer To

The affected Sample 
File is not available. 

Locate the Sample File 
and try again.

If the Sample file name 
is dim in the Analysis 
Control window, the 
GeneScan Analysis 
Software has not 
located the sample file. 

You can instruct the 
program to search for 
the sample file.

“Finding Missing 
Sample Files” on 
page 4-14.

A Dye Standard is not 
selected for the 
affected Sample File. 

Select a Dye Standard 
and try again.

Select the dye/sample 
that represents the 
standard by �-clicking 
the appropriate 
dye/sample field.

Callout 3 on page 5-3.
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The affected Sample 
File does not have a 
valid Analysis 
Parameters Selection. 

Select new Analysis 
Parameters and try 
again.

Select either:

� The default 
program 
parameters 
(<Analysis 
Parameter >), or

� A valid analysis 
parameters file in 
the Analysis 
Control window.

Callout 5 on page 5-3.

No peaks were found 
within the Analysis 
Range. 

Check your Analysis 
Parameters.

� Make sure the 
Peak Amplitude 
Threshold setting 
allows for 
detection of the 
peaks in your 
sample. 

� If peaks in your 
data are narrow, 
make sure the 
Minimum Peak 
Half Width is a 
small number.

“Defining Analysis 
Parameters” on 
page 5-18.

Error messages when defining size standards: (continued)

Error Message Comment/Correction Refer To



Using the BioLIMS Database E-1

Using the BioLIMS 
Database E
Introduction

In This Appendix This appendix describes how to access the BioLIMS™ database, how to 
set the preferences, and how to open or process a fragment that is 
located in the BioLIMS database.

For information on troubleshooting the BioLIMS database, see 
Appendix F, “Troubleshooting the BioLIMS Database.”

Topics in this appendix include the following:

Topic See page

About the GeneScan Analysis Software and the BioLIMS 
Database

E-2

Configuring the BioLIMS Database Server E-4

Switching Between Sample File and BioLIMS Mode E-10

How to Access the BioLIMS Database E-12

About Server Names E-17

Using the Collection Browser Window E-20

E
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About the GeneScan Analysis Software and the BioLIMS Database

What is the
BioLIMS

Database?

The GeneScan® Analysis Software 3.1 introduced support for selecting, 
viewing, editing, and processing fragments from the BioLIMS database.

The BioLIMS database provides a relational database for fragments 
created by ABI PRISM® GeneScan Analysis Software. This database 
accommodates multiple users and versions while preserving the 
original data.

Accessing the
BioLIMS Database

The GeneScan Analysis Software user interface has changed to 
accommodate accessing the BioLIMS database. 

Once you have accessed the BioLIMS database, you can display the 
Collection Browser window by choosing the Open command from the 
File menu.

Before Using the
BioLIMS Database

Before you can connect to the BioLIMS database you must have 
installed the BioLIMS 2.0 software. It is recommended that you install 
the BioLIMS software first, then install the GeneScan Analysis Software 
into the BioLIMS 2.0 software folder. 

Note This organization allows you to install the Sequencing Analysis 
software at a later time.

For more information, see “Installing the Software” on page 1-12.

Modes in
GeneScan Analysis

Software

If you are using the GeneScan Analysis Software with the BioLIMS 
database, you can use the software in either of two modes:

Mode Descriptions

Sample File mode In Sample File mode, fragment data extracted from 
gel files is written out to individual sample files.

BioLIMS mode In BioLIMS mode, fragment data extracted from gel 
files is written to a BioLIMS database that resides on 
a Oracle® Server database or Sybase SQL Server™.

Sample files that came from the ABI PRISM 310 
Genetic Analyzer can be uploaded to the BioLIMS 
database using the Sample 2DB Software.
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Comparing Modes The following table is a comparison of BioLIMS and Sample File modes.

Feature BioLIMS mode Sample File mode

data extracted from 
a gel file is written 
to

the BioLIMS 
database

sample files

fragment data is 
opened for viewing 
and for analysis 
from

the BioLIMS 
database

sample files
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Configuring the BioLIMS Database Server

Sybase or Oracle? This section gives instructions on how to configure the client computer 
(that runs the GeneScan Analysis Software) for database access.

The BioLIMS database resides on either a Sybase SQL Server or an 
Oracle Server. 

Configuring for
Sybase SQL

Server Connection

Follow the steps below to configure a Macintosh® computer for 
connection to the Sybase SQL Server.

IMPORTANT Any time the name, port number, IP address, or host and 
domain name of the BioLIMS database server is changed, you need to repeat 
this procedure.

To configure for the… See…

Sybase SQL Server “Configuring for Sybase SQL Server Connection” 
on page E-4.

Oracle Server “Configuring for Oracle Server Connection” on 
page E-7.

To configure for Sybase SQL Server connection: 

Step Action

1 Find the interfaces file in the Sybase® folder in the BioLIMS Extras 
folder. 

2 Open the file with SimpleText or a similar text editing application.
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3 Find the lines:

SYBASE
query MacTCP mac_ether neuron.apldbio.com 2500

and edit them:

� Replace SYBASE by an alias name for the database server 
(see “About Server Names” on page E-17).

� Replace neuron.apldbio.com with the IP address or host and 
domain name of the server machine.

� 2500 is the default port number for the Sybase database. If 
necessary, replace 2500 with the port number recommended 
by your BioLIMS database administrator.

You can find this information in the interfaces file on the Sybase 
Server, or your BioLIMS database administrator can provide the 
information.

4 If you have access to more than one server, duplicate the two lines 
and edit them for the other server(s). 

For example, for two servers, one called SYBASE and one called 
SERVER2, the interfaces file might look like this:

SYBASE
query MacTCP mac_ether neuron.apldbio.com 2500

SERVER2
query MacTCP mac_ether 192.135.191.128 2025

5 Save and close the interfaces file.

6 Open the SybaseConfig control panel. This control panel is found in 
the Control Panels folder in the System folder.

To configure for Sybase SQL Server connection: (continued)

Step Action
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7 The first time the SybaseConfig control panel is opened, a file 
browser opens automatically. 

If a file browser does not open immediately, click the Interfaces Files 
button to open one.

8 Use the file browser to locate and open the interfaces file edited in 
the steps above.

9 Set the Default Language pop-up menu to us_english.

10 Close the SybaseConfig control panel.

To configure for Sybase SQL Server connection: (continued)

Step Action
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Configuring for
Oracle Server

Connection

Follow the steps below to configure your Macintosh computer for 
connection to the Oracle Server.

IMPORTANT Any time you change the BioLIMS database server name or 
its IP address or host (and domain name), you need to repeat this procedure.

To configure for Oracle Server connection: 

Step Action

1 Use the program Easy Config to configure for the Oracle Server 
connection.

At installation, Easy Config is placed into the BioLIMS 2.0:BioLIMS 
Extras:Oracle:Applications:Networking folder.

Open the Easy Config program. 

The Remote Databases window appears.

2 Click New. 

The Protocol dialog box appears.
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3 Select TCP/IP and click OK. 

The TCP/IP dialog box appears.

4 Enter text in the fields as follows:

� Alias Name: Enter an alias name for the database server. (See 
“About Server Names” on page E-17.)

� Server Name: Enter the server name. This may be an IP 
address or host (and domain name) of the server machine.

Note This field does not scroll horizontally for display even 
though it accepts characters typed past the end of the field. If the 
server name is longer than 20 characters, you may want to enter 
the end characters first and go back or just use the IP address.

� Oracle SID: Enter the value of the ORACLE_SID environment 
variable.

You can find this information in the tnsnames.ora file on the Oracle 
Server, or your BioLIMS database administrator can provide you 
with the information.

5 Click OK to close the TCP/IP dialog box.

6 From the File menu, choose Save Configuration.

7 From the File menu, choose Quit to exit the Easy Config program.

To configure for Oracle Server connection: (continued)

Step Action
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8 Find the application Set Oracle Home.

The application is contained in your BioLIMS 2.0:BioLIMS 
Extras:Oracle:Applications folder.

9 Open the application Set Oracle Home.

10 Use the file browser to find the Oracle folder in the BioLIMS Extras 
folder.

Press Select Oracle button.

To configure for Oracle Server connection: (continued)

Step Action
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Switching Between Sample File and BioLIMS Mode

Introduction If the BioLIMS database is installed on your system, then the BioLIMS 
Access command is available from the Settings menu when you start 
the GeneScan Analysis Software.

Switching Modes To switch modes in the GeneScan Analysis Software:

Step Action

1 Choose Preferences from the Settings menu and BioLIMS Access 
from the submenu. 

The Preferences dialog box appears.

2 To switch modes, take the following action:

To change to... Then... Result

Sample File mode click the Sample 
Files radio button.

The Session 
Manager text is 
greyed out.

BioLIMS mode click the BioLIMS 
radio button.

The fields in the 
Session Manager 
subpanel are 
activated.
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3 You can take the following action:

Step Action

Click... To...

OK affect the changes to the Preferences dialog box 
and to close it.

Cancel close the Preferences dialog box without changing 
the mode.
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How to Access the BioLIMS Database

Introduction The following procedure describes how to access the BioLIMS 
database by completing the Preferences dialog box.

Before you can work with the GeneScan Analysis Software software, 
you must establish a connection to the BioLIMS database. This 
connection is made through the BioLIMS Access page of the 
Preferences dialog box.

Before Accessing a
Sybase Database

IMPORTANT If you try to connect to a Sybase database through the 
GeneScan Analysis Software when the network is down, the computer may 
hang. If this happens, you have to restart the Macintosh computer. Force the 
computer to restart by pressing the key combination, Command–Control–Power 
key.

Before accessing a Sybase database, you need to ping the database 
using SybPing to ensure that the database connection is working.

Step Action

1 Open the SybPing program. 

At installation this program is placed in the BioLIMS 2.0:BioLIMS 
Extras:Sybase:bin folder.

2 Select the name of the database Server that you want to use.

These Server names correspond to those listed in the interfaces 
file.

3 Click Ping.
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Accessing the
BioLIMS Database

4

5 Quit from the SybPing application. 

Step Action

If the connection 
is… Then…

working the Ping window reports that the “Ping 
was successful.”

not working � The Ping window reports that the 
“Ping Failed” or, 

� The Ping window gives no 
response.

Refer to Appendix F, “Troubleshooting 
the BioLIMS Database.”

To access the BioLIMS database: 

Step Action

1 Choose Preferences from the Edit menu and BioLIMS Access from 
the submenu. 

The Preferences dialog box appears.
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2 In the BioLIMS Access section, click the BioLIMS button. The fields 
in the Session Manager subpanel are activated.

Note The following alert appears if there are unsaved sample 
files and fragments open when you switch to BioLIMS mode. When 
you click OK, the alert is dismissed and the Preferences dialog box 
appears with the Sample Files button selected.

3 In the Session Manager section in the Preferences dialog box, 
enter:

� Your user name on the server.

� Your password for your server account.

� The name of the database on the server (You may have access 
to more than one database on the server.)

� The server name. The server name is contained in the 
interfaces file (Sybase) or in the tnsnames.ora file (Oracle).

IMPORTANT All these text boxes are case sensitive.

4 Click the check box labeled Save Password if you want to:

� Save your password so that you do not have to enter it every 
time you open the connection.

� Run AppleScripts that don’t contain password information.

� Automatically analyze the data after the Data Collection 
software has collected the data.

To access the BioLIMS database: (continued)

Step Action
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5 If you want the database to open automatically when you launch 
the GeneScan Analysis Software, click the check box labeled Open 
on Launch.

Note You must also click the check box labeled Save Password 
if you want the database to open automatically in order to 
automatically analyze data.

6 If you intend to use more than one database or user account, enter 
an alias for this BioLIMS session information. You can use an alias 
to connect to the database if no database connection is open.

Once you enter an alias, you can take the following action:

7 Use the pop-up menu to add, change, or remove aliases.

8 If you have more than one alias, click the Make Default check box to 
choose which one appears when you first open the Edit Session 
dialog box.

Note The default alias is the database that opens if you choose 
to automatically analyze data.

Note If both the Make Default and the Save Password boxes are 
checked, no dialog box will appear when a connection to the server 
is requested. Since all the information required of the user has 
been saved, the software will connect to the database 
automatically.

To access the BioLIMS database: (continued)

Step Action

If you click... Then...

Open you connect to the database.

OK the changes are saved and you are connected 
to the database if a channel is open.
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9 Take one of the following actions:

To access the BioLIMS database: (continued)

Step Action

If the login was... Then...

successful a. Choose Open from the File menu.

The Open Existing dialog box 
appears.

b. Click the Sample icon and the 
Collection Browser appears.

For more information, see “Using the 
Collection Browser Window” on 
page E-20.

unsuccessful an alert dialog box appears.

Check that:

� All the login information was entered 
correctly and in the correct case.

� Your interfaces file is correctly 
configured (page E-4).

� If the connection is still not open, 
consult Appendix F, “Troubleshooting 
the BioLIMS Database.”
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About Server Names

Sybase or Oracle? The BioLIMS Session Manager decides whether you are connected to 
Sybase SQL Server or to an Oracle Server database by looking at the 
name in the Server field in the Session Manager dialog box. 

How Names are
Recognized

The table below summarizes how names are recognized.

Sybase SQL
Server Examples

Example 1

If the interfaces file contains this:

MOZART
query MacTCP mac_ether mozart.apldbio.com 2500

MOZART is recognized as a Sybase SQL Server because the server 
name is in all uppercase letters. 

The Session Manager would look like this:

If the Session Manager sees a Server 
name… It assumes a… Example

All in uppercase letters Sybase SQL Server database 
connection.

MOZART

Suffixed by “:s” or “:S” Sybase SQL Server database 
connection.

Offenbach:S

Containing any lowercase letters Oracle Server database. Oramozart

Suffixed by “:o” or “:O” Oracle Server database. SIBELIUS:O
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Example 2

If the interfaces file contains this:

Offenbach
query MacTCP mac_ether mozart.apldbio.com 2500

The Session Manager would look like this:

In order for Offenbach to be recognized as a Sybase SQL Server, the 
name in the Server field is suffixed with “:S”.

Oracle Server
Examples

Example 1

If the tnsnames.ora file contains this:

Oramozart=(DESCRIPTION=
            (ADDRESS=
             (PROTOCOL=TCP)(host=mozart)(port=1521))
                  (CONNECT_DATA=(SID=WG733)
                 )
          )

Oramozart is recognized as an Oracle Server because the server name 
begins with “O”. 

The Session Manager would look like this:
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Example 2

If the tnsnames.ora file contains this:

SIBELIUS = (DESCRIPTION=
           (ADDRESS=
           (PROTOCOL=TCP)(host=SIBELIUS)(port=1521))
                  (CONNECT_DATA=(SID=WG733)
                 )
          )

The Session Manager would look like this:

In order for SIBELIUS to be recognized as a Oracle Server, the name in 
the Server field is suffixed with “:O”.
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Using the Collection Browser Window

Applications that
Use the Collection
Browser Window

Collection Browser window is common to the following BioLIMS-aware 
applications.

� AutoAssembler™ DNA Sequence Assembly Software.

� GeneScan® Analysis Software.

� Factura™ Feature Identification Software.

� Sample 2DB Software.

� Sequencing Analysis software.

Ways to Search the
Database

Using the Collection Browser window from within GeneScan Analysis 
Software, you can search the BioLIMS database for specific collections 
and fragments.

The following table lists ways you can search:

In This Section This section includes the following topics.

Search by... See page

up to 5 collection-specific criteria E-24

up to 14 fragment-specific criteria E-25

For this topic See page

Displaying the Collection Browser Window E-21

Collection Browser Window Example E-22

Parts of the Collection Browser Window E-22

Collection Search Criteria E-24

Fragment Search Criteria E-25

Searching the BioLIMS Database E-28
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Displaying the
Collection Browser

Window

There are two ways to display the Collection Browser window:

If you want to... Then... Result

open a fragment to 
view or edit

a. Choose Open 
from the File 
menu.

The Open Existing 
dialog box opens.

b. Click the Sample 
icon.

The Collection Browser 
window appears.

For more information, 
see “Collection 
Browser Window 
Example” on 
page E-22.

create a new project by 
adding sample files

a. Choose New from 
File menu.

The Create New 
dialog box 
appears.

b. Click the Project 
icon.

An untitled 
Analysis Control 
window appears.

c. Choose Add 
Samples Files 
from the Project 
menu.
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Collection Browser
Window Example

The following is an example of the Collection Browser window.

Parts of the
Collection Browser

Window

The table below describes the parts of the Collection Browser window 
that were labeled in the figure above. 

Status line

Search results

Split bar

Collection search
criteria pop-up menus
and text boxes

Criteria pop-up menu Search button

Fragment
search criteria
pop-up menus
and text boxes

Item Description

Criteria pop-up menu Use this pop-up menu to specify the search 
criteria visible on the Collection Browser window.

Note If you only intend to use a subset of 
criteria, setting only that subset visible helps to 
reduce clutter in the window. The search results 
are the same whether a criterion is invisible or 
blank and visible.

Search button Click this button to query the BioLIMS database. 

Note You can also press the Return key to 
begin a search. 
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Collection search 
criteria pop-up menus 
and text boxes

Use these pop-up menus and text boxes to 
define the collection criteria of the search. 

IMPORTANT Only those fragments that 
match each and every criterion you specify are 
returned. That is, search criteria are combined 
using the logical AND operation.

For more information, see “Collection Search 
Criteria” on page E-24.

Fragment search 
criteria pop-up menu 
and text boxes

Use these pop-up menus and text boxes to 
define the fragment criteria of the search.

IMPORTANT A collection is returned if one 
or more of the fragments contained in it fulfill all 
of the specified fragment criteria.

Note Only fragments meeting search criteria 
will be displayed in the Collection Browser 
window.

For more information, see “Fragment Search 
Criteria” on page E-25.

Split bar Drag this bar to alter the relative amount of space 
allocated to the top and bottom portions of the 
Collection Browser window.

Search results After a successful query, found sample files are 
listed in this area as Name, Modification date, 
type, and Creator.

Status line Search results, error messages, and other 
important information is reported here. 

For example, the Status Line lists how many 
collections were returned in a search.

Item Description
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Collection Search
Criteria

The table below shows the collection search criteria. The collections 
returned by the Collection Browser window must match all of the 
collection criteria and contain at least one fragment that matches all of 
the fragment criteria. 

Allowed Collection Search Criteria:

Criterion
Pop-up Menu 
Choices Allowed Text Description

Collection 
Creator

� is

� starts with

� ends with

� contains

up to 255 
characters

Name of the 
creator/owner of 
the collection.

Collection 
Name

� is

� starts with

� ends with

� contains

up to 31 
characters

Name of the 
collection.

Collection Type � any

� run

� project

� other

NA Collection type.

Default is any 
menu item.

Creation Date � any

� is

� before

� after

� between

date — set with 
arrow buttons 
using the format 
mm/dd/yy

Date the 
collection was 
created.

Modification 
Date

� any

� is

� before

� after

� between

date — set with 
arrow buttons 
using the format 
mm/dd/yy

Date the 
collection was 
last modified.
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Fragment Search
Criteria

The table below shows the fragment search criteria. The collections 
returned by the Collection Browser window must contain at least one 
fragment that matches all of the specified fragment criteria.

Fragment Search Criteria 

Criterion
Pop-up Menu 
Choices Allowed Text Description

Sequence-Frag 
Name

� is

� starts with

� ends with

� contains

up to 
31characters 
including letters, 
numbers, and 
punctuation

Cannot use 
colons (:).

Name of the 
fragment.

This is the file 
name entered in 
the Sample 
Sheet.

Sample Creator � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Name of the 
person 
responsible for 
the run.

Sample Name � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Sample name 
from the Sample 
Sheet.

Instrument 
Name

� is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Set in the 
General Settings 
Preferences of 
the Data 
Collection 
software.

Instrumentation � any

� gel

� capillary

NA Whether the 
sample was run 
on a gel or 
capillary 
instrument.

Start Collect 
Date

� any

� is

� before

� after

� between

date— set with 
arrow buttons 
using format 
mm/dd/yy

Date data 
collection 
began.
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End Collect 
Date

� any

� is

� before

� after

� between

date — set with 
arrow buttons 
using format 
mm/dd/yy

Date data 
collection 
ended.

Gel Path � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

The full path 
name to the 
original gel file, 
e.g., 
Hard Disk:Data:
GelRuns:L28t.

Sample Info � is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Sample 
information from 
the Sample 
Sheet.

Sample 
Comment

� is

� starts with

� ends with

� contains

up to 255 
characters 
including letters, 
numbers, and 
punctuation

Comment from 
the Sample 
Sheet.

Size Data � is present

� is not 
present

� does not 
apply

NA is present 
means that one 
or more dyes 
contain sizing 
information.

is not present 
means none of 
the dye sample 
contain sizing 
information.

Fragment Search Criteria (continued)

Criterion
Pop-up Menu 
Choices Allowed Text Description
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Size Calling � done

� not done

� does not 
apply

NA done means 
sample file has 
completed size 
calling indicated 
by a size curve.

not done 
indicated by a 
missing size 
curve.

% Matched 
Peaks

� any

� equal to

� less than

� greater than

� between

0—100 Percentage 
based on size 
standard 
matched peaks 
divided by size 
standard 
defined peaks.

Offscale Data � present

� does not 
apply

NA present means 
the analyzed 
range contains 
off-scale dye 
sample peaks.

Fragment Search Criteria (continued)

Criterion
Pop-up Menu 
Choices Allowed Text Description
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Searching the
BioLIMS Database

Follow these steps to use the Collection Browser window to search the 
BioLIMS database for specific collections and fragments.

To search the BioLIMS database: 

Step Action

1 Note From the Select Criteria pop-up menu, select the criteria 
by which you want to search

Note To list all of the items in the BioLIMS database, perform 
the search with no criteria specified. For large databases, this 
process may be slow.

2 To use the pop-up menu:

Note As you choose items from the pop-up menu, a black dot 
appears next to the item on the menu and the item is added to 
either the collection search criteria or the fragment name search 
criteria section of the window.

Choose menu items...
To define the search 
by... See page

above the horizontal line Collection Search 
Criteria

E-24

below the horizontal line Fragment Search 
Criteria

E-25
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The following is an example of the Collection Browser window showing four 
collection search criteria and five fragment search criteria.

3 Use the pop-up menus and text fields to define your search query. 

Refer to “Collection Search Criteria” on page E-24, and “Fragment 
Search Criteria” on page E-25, for details about the search criteria. 

When you are satisfied with the search, click Search.

The results of the search appear in the lower portion of the window.

Note Collections returned by the Collection Browser window 
must match all of the collection criteria and contain at least one 
fragment that matches all of the fragment criteria.

To search the BioLIMS database: (continued)

Step Action
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4 To view the fragments contained in the collections, click the small 
triangle to the left of the collection name.

5 Select fragments.

To search the BioLIMS database: (continued)

Step Action

Small
triangle
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Troubleshooting the 
BioLIMS Database F
Introduction

In This Appendix Topics in this appendix include the following:

Topic See Page

If the BioLIMS™ Preference Page Does Not Appear F-2

About Troubleshooting the Client to Sybase Connection F-3

Troubleshooting Process F-15

Procedures for Troubleshooting the Client to Sybase 
Connection

F-6

About Troubleshooting the Client to Oracle Connection F-14

Troubleshooting Process F-15

Procedures for Troubleshooting the Client to Oracle 
Connection

F-17

F
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If the BioLIMS™ Preference Page Does Not Appear

Problem If the BioLIMS™Access page is not present after “Results Display” in the 
Preferences submenu, the GeneScan® Analysis Software is unable to 
find all the database support files and system extensions required to 
access the BioLIMS database.

Solution Be sure that all the Oracle® or Sybase SQL Server™ database support 
files are installed correctly. 

If files are missing, reinstall the BioLIMS Client or Instrument package 
from the original CD-ROM disc. 

This BioLIMS Access 
menu item will not appear if certain 
database support files are missing
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About Troubleshooting the Client to Sybase Connection

Introduction A common source of difficulty using the BioLIMS System is establishing 
connection between the BioLIMS programs running on Macintosh® 
client computers and the BioLIMS database on the Sybase® Server. 

Note For information about troubleshooting an Oracle Server connection, 
see “About Troubleshooting the Client to Oracle Connection” on page F-14. 

SybPing and
Telnet

Two programs have been provided to help with troubleshooting.

Program Description

SybPing A Sybase tool for testing network connections. (Look for this 
application in the BioLIMS:BioLIMS Extras:Sybase:bin folder.)

Telnet NCSA Telnet 2.6 is a program used for interactive access from 
a Macintosh client to a telnet host on TCP/IP networks. NCSA 
Telnet was developed by the National Center for 
Supercomputing Applications at the University of Illinois in 
Urbana/Champaign.

NCSA Telnet 2.6 has been provided in the BioLIMS Extras 
folder.

If you need help, their web site address is:

http://www.ncsa.uiuc.edu/SDG/Software/Brochure/Overview/M
acTelnet.overview.html

You can also reach them at the address shown below. Applied 
Biosystems does not support NCSA Telnet.
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Troubleshooting Process

Troubleshooting
Flow Chart

On the following page is a flow chart illustrating the process for 
troubleshooting database connection between the Macintosh Client and 
the Sybase Server. The step numbers given in the flow chart refer to the 
tables on pages F-6 to F-13 where the troubleshooting procedures are 
described in detail.
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Try
NSCA Telnet (step 6 

on page F-10)
Try SybPing (step 5 

on page F-9)

Try to log in to 
the server (step 1 on 

page F-12)

Is the server 
running? (step 2 on 

page F-12)

Start the server 
(step 3 on 
page F-13)

Find interfaces 
file, charsets and 
locales (step 1 on 
page F-6)

Check libraries in 
the Extensions 
folder (step 2 on 
page F-6)

Check 
SybaseConfig 
panel (step 4 on 
page F-8)

Open and check 
interfaces file 
(step 3 on 
page F-6)

The network is not 
working (step 6 
on page F-10)

Try Macintosh 
connection (step 6 on 

page F-13)

Check theSybase 
SQL Server error 
log (step 4 on 
page F-13)

Call Customer 
Support (step 7 
on page F-13)

ping successful

ping

fails

connection

fails

successfulconnection

successfulconnection

fails

connection server

down

runningserver

Attempt to fix 
problems found in 
error log (step 5 
on page F-13)

failsconnection

Try Macintosh 
connection (step 6 on 

page F-13)fails

connection

Look up errors in 
theSybase error 
log (step 4 on 
page F-13)
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Procedures for Troubleshooting the Client to Sybase Connection

Introduction The procedure for troubleshooting the Client-Server connection is 
divided into two parts:

� Troubleshooting from the Macintosh Client (below).

� Troubleshooting from the Unix (Sybase) Server (page F-12).

Troubleshooting
from the

Macintosh Client

The step numbers in the following procedure correspond to the steps 
marked in the flow chart above.

IMPORTANT The documentation for each BioLIMS Macintosh computer 
program includes a section about setting up the database connection. Make 
sure you have followed that procedure carefully.

Troubleshooting the connection from the client 
(Macintosh computer): 

Step Action

1 Locate the interfaces file. 

Confirm that the folders charsets and locales are located in the 
same folder as the interfaces file. 

The default installation places interfaces, charsets, and locales in 
the BioLIMS:BioLIMS Extras:Sybase folder. 

2 Confirm that the Sybase library files are installed into the 
Extensions folder in the System Folder. 

For more information, see “Required Sybase Extension Files” on 
page F-11.

In particular, if the libtcp extension is missing or not turned on, the 
Sample 2DB Software crashes when connection to the database is 
attempted.

3 Open the interfaces file and confirm the server information is 
correct.

An example of the Sybase-based BioLIMS SQL Server entry is 
shown below.

Sybase
     query MacTCP mac_ether neuron.apldbio.com 2500

Note Refer to the table immediately below for an explanation of 
the BioLIMS Server entry.
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The BioLIMS Server entry:

Troubleshooting the connection from the client 
(Macintosh computer): (continued)

Step Action

Where… Represents…

SYBASE the name you chose to call the BioLIMS Server. The 
server can have any name.

For more information, see “About Server Names” on 
page E-17.

query MacTCP 
mac_ether

the part of the entry that is always the same. 

Note The tab preceding this phrase is required.

neuron.apldbio. 
com

the host and domain name of the Sybase-based 
BioLIMS SQL Server machine. 

In this example, neuron is the host name and 
apldbio.com is the domain name. 

You can also use an IP address. This information is 
available from your system administrator.

2500 the port number that the Sybase-based BioLIMS 
SQL Server is using to connect with the clients. 

This number is assigned to the server when it is 
installed. 

You can find the port number in the interfaces file, 
which is located in the home directory of the 
Sybase-based BioLIMS SQL Server. 

This is an example of the server entry in the UNIX 
server interfaces file:

## SYBASE on neuron
##       Services:
##              query   tcp     (2500)
…

The third line of this entry shows the port number 
(2500) of the BioLIMS Server. 
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4 Confirm that the SybaseConfig control panel is set up correctly:

Troubleshooting the connection from the client 
(Macintosh computer): (continued)

Step Action

Step Action

a. Open the SybaseConfig control panel. 

This control panel must be located in the Control Panels 
folder in the System folder. 

(If it is missing or disabled, the GeneScan Analysis 
Software crashes when connection to the database is 
attempted.) 

b. Click the Interfaces File button to open a browser box. 

c. Use the browser box to locate and select the interfaces 
file that you located in step 1 above.

d. Confirm that the correct default server is chosen. Use 
the Default Server pop-up menu to select the default 
server.

Note This is the same server you named for 
SYBASE in the BioLIMS Server entry table immediately 
above.

e. Confirm that the Default Language pop-up menu is set to 
us_english.
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5 Use the program SybPing to confirm communication with the 
Sybase-based BioLIMS SQL Server.

The default installation places SybPing into the BioLIMS: BioLIMS 
Extras: Sybase: bin folder. 

Troubleshooting the connection from the client 
(Macintosh computer): (continued)

Step Action

Step Action

a. Start the SybPing program.

b. Select the server from the Servers pop-up menu. 

(The servers shown in the pop-up menu are the servers 
listed in the interfaces file.)

c. Click Ping. 

The program responds with a message of whether or not 
the Ping was successful.

If the Ping is… Then…

successful skip to “Troubleshooting the client connection 
from the Sybase SQL Server:” on page F-12.

unsuccessful continue to step 6.
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6 If the Ping is unsuccessful:

Open the program NCSA Telnet. The default installation places 
NCSA Telnet into the BioLIMS: BioLIMS Extras folder. 

Troubleshooting the connection from the client 
(Macintosh computer): (continued)

Step Action

Step Action

a. Select Open Connection... from the File menu. 

b. Enter the host name (from the interfaces file) into the 
Host/Session Name text field.

c. Click Connect.

If the connection is… Then…

successful a window is displayed with a UNIX login 
prompt. 

Skip to step 2 of “Troubleshooting the 
client connection from the Sybase SQL 
Server:” on page F-12.

unsuccessful an error message is displayed. 

The network is not working. Call your 
network administrator.

Note If the host.domain name does 
not work, try the IP address of the host. 
This number can be found in the 
/etc/hosts file on the UNIX Server. 
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Required Sybase
Extension Files

The following Sybase library files are placed in the Extensions folder in 
the System folder by the BioLIMS Client and instrument installers. 
These files are required for connection to the BioLIMS database.

Required Oracle
Extension Files

The following Oracle library files are placed in the Extensions folder in 
the System folder by the BioLIMS Client and instrument installers. 
These files are required for connection to the BioLIMS database.

libblk libintl

libcomn libsybdbl

libcs libtcl

libct libtcp

libctb

OracleCore23Lib OracleOra71Lib

OracleKernel71Lib OraclePlsql21Lib

OracleNetNLLib OraclePstd21Lib

OracleNetTCPLib OracleRuntime13Lib

OracleNetTNSLib Oracle Sql16Lib

OracleNetTNSTCPLib OracleTNSATKLib

OracleNLS23Lib OracleVsoci71Lib

OracleOci71Lib
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Troubleshooting
from the Unix

(Sybase) Server

The step numbers in the following procedure correspond to the steps 
marked in the flow chart on page F-5. Step1 below corresponds to the 
diamond “Try to log in to the server” on page F-5.

You need to have the account name and password for the Sybase user 
on the UNIX system that runs the Sybase SQL Server. If you do not 
have access to the Sybase user account, you should ask your database 
administrator to carry out the following procedure

 

Troubleshooting the client connection from the Sybase SQL Server: 

Step Action

1 Log in to the Sybase user account on the UNIX Server. 

Try to connect to the Sybase SQL Server with isql. 

Use the same client user name as the one entered in the BioLIMS 
access dialog box. 

For example:

% isql -U george -P george1. -S SYBASE 
1> use sfdb
2> go
1> quit 

2 Use the show server script to find out if the Sybase SQL Server is 
running.

Where… Represents the…

george client user name.

george1 client user password.

SYBASE server name.

sfdb name of the BioLIMS database.

If the Login is… Then…

successful skip to step 6.

unsuccessful continue to step 2.

If the server is… Then…

running skip to step 4.

not running continue to step 3.
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3 Ask your database administrator to restart the Sybase SQL Server. 

After restarting the server, try to connect to the database using isql 
as in step 1 on page F-12. 

If the connection still fails, go to step 7.

4 Check the Sybase error log and make a note of any error 
messages. 

(The error log can be found in the install directory of the Sybase 
home directory and error messages are preceded by the string 
Msg.) 

5 Refer to the Sybooks documentation for an explanation of the SQL 
Server Error Messages. Attempt to fix the problem following the 
Sybook instructions. 

Try to connect to the database using isql as in step 1 on page F-12.

 

6 Try once more to connect to the BioLIMS database from the 
BioLIMS Macintosh program.

Make sure that the user name, password, database and server 
names are all typed correctly and are in the correct case. 

If the connection still fails, go to step 7.

7 Call Customer Support. See “Technical Support” on page 1-20. 

Troubleshooting the client connection from the Sybase SQL 

Step Action

If the connection is… Then…

successful continue to step 6.

unsuccessful skip to step 7.
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About Troubleshooting the Client to Oracle Connection

Introduction A common source of difficulty using the BioLIMS System is establishing 
connection between the BioLIMS programs running on Macintosh client 
computers and the BioLIMS database on an Oracle Server. 

Note For information about troubleshooting a Sybase SQL Server 
connection, see “About Troubleshooting the Client to Sybase Connection” on 
page F-3. 

Telnet To help with troubleshooting, NCSA Telnet 2.6 has been provided in the 
BioLIMS Extras folder.

NCSA Telnet 2.6 is a program used for interactive access from a 
Macintosh client to a telnet host on TCP/IP networks. NCSA Telnet was 
developed by the National Center for Supercomputing Applications at 
the University of Illinois in Urbana/Champaign.

If you need help, their web site address is:

http://www.ncsa.uiuc.edu/SDG/Software/Brochure/Overview/MacTelnet
.overview.html

You can also reach them at the address shown below.

Applied Biosystems does not support NCSA Telnet.
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Troubleshooting Process

Troubleshooting
Flow Chart

On the following page is a flow chart illustrating the process for 
troubleshooting the database connection between the Macintosh Client 
and the Oracle Server. The step numbers given in the flow chart refer to 
the tables on pages F-17 to F-22 where the troubleshooting procedures 
are described in detail.
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Try
NSCA Telnet (step 6 

on page F-21)

Try an NetTest login 
(step 5 on page F-19)

Try to log in to 
the server (step 1 on 

page F-22)

Are the 
Listener and Server 
running? (step 2 on 

page F-23)

Restart the 
Listener/Server 
(step 3 on 
page F-23 on 

Find the 
tnsnames.ora file 
(step 1 on 
page F-17)

Check Oracle 
libraries (step 4 
on page F-19)

The network is not 
working (step 6 
on page F-21)

Try Macintosh 
connection (step 6 on 

page F-24)

Check the Oracle 
Server error log 
(step 4 on 
page F-23)

Call Customer 
Support (step 7 
on page F-24)

Look up errors in 
Oracle manuals 
(step 5 on 
page F-23)

successful

fails

connection

fails

successfulconnection

successfulconnection

fails

connection server

down

runningserver

Attempt to fix 
problems listed in 
error log (step 5 
on page F-23)

failsconnection

Try Macintosh 
connection (step 6 on 

page F-24)fails

connection

 

Check the Oracle 
Home setting 
(step 3 on 
page F-18)

Open and check 
tnsnames.ora file 
(step 2 on 
page F-17)

NetTest

NetTest
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Procedures for Troubleshooting the Client to Oracle Connection

Introduction The procedure for troubleshooting the Client-Server connection is 
divided into two parts:

� Troubleshooting from the Macintosh Client (below).

� Troubleshooting from the Unix (Oracle) Server (page F-22).

Troubleshooting
from the

Macintosh Client

The step numbers in the following procedure correspond to the steps 
marked in the flow chart above.

IMPORTANT The documentation for each BioLIMS Macintosh program 
includes a section about setting up the database connection. Ensure that you 
have followed that procedure carefully.

Troubleshooting the connection from the client (Macintosh) 

Step Action

1 Locate the tnsnames.ora file. 

The default installation places the tnsnames.ora file in the BioLIMS 
2.0:BioLIMS Extras:Oracle:Network:Admin folder. 

2 Open the tnsnames.ora file and confirm that the server information 
is correct.

An example of the Oracle-based BioLIMS Server entry is shown 
below.

Oramozart =   (DESCRIPTION=
                 (ADDRESS=
                  (PROTOCOL=TCP)(host=mozart)(port=1521))
                  (CONNECT_DATA=(SID=WG733)
                 )
          )

Note Refer to the table immediately below for an explanation of the 
BioLIMS Server entry.
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The BioLIMS Server entry:

3 Confirm that the Oracle Home is set correctly:

a. Open the Set Oracle Home program. 

At installation this program is placed into the BioLIMS 
2.0:BioLIMS Extras:Oracle:Applications folder. 

b. Use the file browser to locate and select the Oracle folder.

Troubleshooting the connection from the client (Macintosh) (continued)

Step Action

Where… Represents…

Oramozart the name you chose to call the Oracle-based 
BioLIMS database connection. 

This can have any name. 

See “About Server Names” on page E-17

mozart the host of the Oracle-based BioLIMS Server. 

In this example, mozart is the host name. 

You can also use a host and domain name such as 
mozart.apldbio.com or an IP address such as 
167.116.100.61.

This information is available from your system 
administrator. The IP address can also be found in 
the /etc/hosts file on the UNIX Server.

1521 the port number that the Oracle-based BioLIMS 
Server is using to connect with the clients.

This number is assigned to the server when it is 
installed. 

You can find the port number in the tnsnames.ora 
file that is located in the 
$ORACLE_HOME/network/admin directory on the 
Oracle-based BioLIMS Server. 

WG733 the Oracle database system identifier (sid) defined 
at server installation. 

You can find the port number in the tnsnames.ora 
file that is located in the 
$ORACLE_HOME/network/admin directory on the 
Oracle-based BioLIMS Server.
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4 Confirm that the Oracle library files are installed.

See “Required Oracle Extension Files” on page F-11.

5 Use the program NetTest to confirm communication with the Oracle 
Server.

At installation, NetTest is placed into the BioLIMS 2.0:BioLIMS 
Extras:Oracle:Applications:Networking folder.

Troubleshooting the connection from the client (Macintosh) (continued)

Step Action

Step Action

a. Open the NetTest program.

Note No window appears for the NetTest program, 
but the menu bar changes.

b. From the Database menu, choose Logon. 

The Connect To Database dialog box appears.

c. d. Enter the Username and Password for the 
database.

Note These are the same Username and Password 
you use to log into BioLIMS (e.g., george/george1).

e. In the Database field, enter the alias name of the Oracle 
Server from the tnsnames.ora file (e.g., Oramozart).

f. Click Login. 

The message “Attempting Connection...” appears, then 
the Result Explanation dialog box appears.
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Troubleshooting the connection from the client (Macintosh) (continued)

Step Action

If the login is… Then…

successful the Result Explanation dialog box 
displays the following:

� Result field: “ORA-00000: 
normal, successful completion.”

� Connected To field: Oracle 
Server version information.

� Comments field: “Your SQL*Net 
setup appears to be in working 
order.”

Skip to “Troubleshooting from the 
Unix (Oracle) Server” on page F-22.

unsuccessful the Result Explanation dialog box 
displays the following:

� Result field: the Oracle error 
encountered.

� Comments field: A detailed 
explanation of the login failure.

Continue to step 6.
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6 If the NetTest login is unsuccessful:

Open the program NCSA Telnet. The default installer places NCSA 
Telnet into the BioLIMS 2.0:BioLIMS Extras folder.

Troubleshooting the connection from the client (Macintosh) (continued)

Step Action

Step Action

a. Select Open Connection... from the File menu. 

b. Enter the host name (from the tnsnames.ora file) into 
the Host/Session Name text field.

Note You can enter the host, host and domain 
name, or IP address here. See step 2, “mozart,” on 
page F-18 for more information.

c. Click Connect.

If the connection is… Then…

successful a window is displayed with a Unix login 
prompt. 

Skip to step 2 on page F-12 of 
“Troubleshooting from the Unix 
(Oracle) Server.”

unsuccessful an error message is displayed. 

The network is not working. Call your 
network administrator.

Note If you entered the host name 
in step b above and the connection 
fails, try entering the host.domain 
name or the IP address before calling 
your network administrator. See step 2, 
“mozart,” on page F-18 for more 
information. 



F-22 Troubleshooting the BioLIMS Database

Troubleshooting
from the Unix

(Oracle) Server

The step numbers in the following procedure correspond to the steps 
marked in the flow chart on page F-16.

You need to have the account name and password for the Oracle user 
on the UNIX system that runs the Oracle Server. If you do not have 
access to the Oracle user account, you should ask your database 
administrator to carry out the following procedure.  

Troubleshooting the client connection from the Oracle Server: 

Step Action

1 Log in to the Oracle user account on the UNIX Server. 

Try to connect to the Oracle Server with SQL*Plus. 

Use the same client user name and password as the one entered in 
the BioLIMS access dialog box. For example:

% sqlplus  george/george1
SQL>exit

Where… Represents the…

george client user name.

george1 client user password.

If the Login is… Then…

successful skip to step 6.

unsuccessful continue to step 2.
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2 Find out if the Listener Process is running. 

As the Oracle user, type:

% lsnrctl status

3 See your system administrator for help restarting the Listener 
Process or Server.

After restarting, try to connect to the database using SQL*Plus as 
in step 1 on page F-22. 

If the connection still fails, go to step 7.

4 Check the Oracle error log and make a note of any error messages. 

(The error log can be found in the install directory of the Oracle 
home directory and error messages are preceded by the string 
Msg.) 

Note Refer to the Oracle documentation for an explanation of 
the error messages.

5 Attempt to fix the problem following the documentation instructions. 

Try to connect to the database using SQL*Plus as in step 1 on 
page F-22. 

If the connection still fails, go to step 7.

Troubleshooting the client connection from the Oracle Server: (continued)

Step Action

If the Listener 
Process is… Then…

not running continue to step 3.

running check that the server is running. 

Type:

% ps -ef | grep ora_

If server processes 
are… Then…

displayed server is running. 
Skip to step 4.

not displayed continue to step 3.
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6 Try once more to connect to the BioLIMS database from the 
BioLIMS Macintosh program. 

Ensure that the user name, password, database, and server names 
are all typed correctly and are in the correct case. 

If the connection still fails, go to step 7.

7 Call Customer Support. See “Technical Support” on page 1-20.

Troubleshooting the client connection from the Oracle Server: (continued)

Step Action
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License and WarrantyG

Software License and Warranty

Applied
Biosystems

Software License
and Limited

Product Warranty

PURCHASER, CAREFULLY READ THE FOLLOWING TERMS AND 
CONDITIONS (THE “AGREEMENT”), WHICH APPLY TO THE 
SOFTWARE ENCLOSED (THE “SOFTWARE”). 

YOUR OPENING OF THIS PACKAGE INDICATES YOUR 
ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO 
NOT ACCEPT THEM, PROMPTLY RETURN THE COMPLETE 
PACKAGE AND YOUR MONEY WILL BE RETURNED. THE LAW 
PROVIDES FOR CIVIL AND CRIMINAL PENALTIES FOR ANYONE 
WHO VIOLATES THE LAWS OF COPYRIGHT.

Copyright The SOFTWARE, including its structure, organization, code, user 
interface, and associated documentation, is a proprietary product of 
The PE Corporation and is protected by international laws of copyright. 
Title to the SOFTWARE, and to any and all portion(s) of the 
SOFTWARE shall at all times remain with Applied Biosystems.

License 1. You may use the SOFTWARE on a single computer (or on a single 
network, if your software is designated as a network version). You may 
transfer the SOFTWARE to another single computer (or network, if a 
network version), so long as you first delete the SOFTWARE from the 
previous computer or network. You may never have operational 
SOFTWARE on more than one computer (or more than one network, if 
a network version) per original copy of the SOFTWARE at any time.

2. You may make one copy of the SOFTWARE for backup purposes.

3. You may transfer the SOFTWARE to another party, but only if the 
other party agrees in writing with Applied Biosystems to accept the 
terms and conditions of this Agreement. If you transfer the SOFTWARE 
to another party, you must immediately transfer all copies to that party, 

G
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or destroy those not transferred. Any such transfer terminates your 
license.

Restrictions 1. You may not copy, transfer, rent, modify, use, or merge the 
SOFTWARE, or the associated documentation, in whole or in part, 
except as expressly permitted in this Agreement.

2. You may not reverse assemble, decompile, or otherwise reverse 
engineer the SOFTWARE.

Limited Warranty For a period of 90 days after purchase of the SOFTWARE, Applied 
Biosystems warrants that the SOFTWARE will function substantially as 
described in the documentation supplied by Applied Biosystems with 
the SOFTWARE. If you discover an error which causes substantial 
deviation from that documentation, send a written notification to Applied 
Biosystems. Upon receiving such notification, if Applied Biosystems is 
able to reliably reproduce that error at its facility, then Applied 
Biosystems will do one of the following at its sole option: (i) correct the 
error in a subsequent release of the SOFTWARE, which shall be 
supplied to you free of charge, or (ii) accept a return of the SOFTWARE 
from you, and refund the purchase price received for the SOFTWARE. 
Applied Biosystems does not warrant that the SOFTWARE will meet 
your requirements, will be error-free, or will conform exactly to the 
documentation. Any sample or model used in connection with this 
Agreement is for illustrative purposes only, is not part of the basis of the 
bargain, and is not to be construed as a warranty that the SOFTWARE 
will conform to the sample or model.

Limitation Of
Liability

EXCEPT AS SPECIFICALLY STATED IN THIS AGREEMENT, THE 
SOFTWARE IS PROVIDED AND LICENSED “AS IS”. THE ABOVE 
WARRANTY IS GIVEN IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESSED OR IMPLIED, INCLUDING THOSE OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
NOTWITHSTANDING ANY FAILURE OF THE CENTRAL PURPOSE 
OF ANY LIMITED REMEDY, Applied Biosystems LIABILITY FOR 
BREACH OF WARRANTY SHALL BE LIMITED TO A REFUND OF 
THE PURCHASE PRICE FOR SUCH PRODUCT. IN NO EVENT WILL 
Applied Biosystems BE LIABLE FOR ANY OTHER DAMAGES, 
INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN 
IF Applied Biosystems HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.
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Term You may terminate this Agreement by destroying all copies of the 
SOFTWARE and documentation. Applied Biosystems may terminate 
this Agreement if you fail to comply with any or all of its terms, in which 
case you agree to return to Applied Biosystems all copies of the 
SOFTWARE and associated documentation.

Miscellaneous 1. Failure to enforce any of the terms and conditions of this Agreement 
by either party shall not be deemed a waiver of any rights and privileges 
under this Agreement.

2. In case any one or more of the provisions of this Agreement for any 
reason shall be held to be invalid, illegal, or unenforceable in any 
respect, such invalidity, illegality, or unenforceability shall not affect any 
other provisions of this Agreement, and this Agreement shall be 
construed as if such invalid, illegal, or unenforceable provisions had 
never been contained herein.

3. This Agreement shall be construed and governed by the laws of the 
State of California.

4. This Agreement and the Applied Biosystems Sales Quotation 
constitute the entire agreement between Applied Biosystems and you 
concerning the SOFTWARE.
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Glossary

This glossary defines special terminology used in the GeneScan Analysis Software User’s 
Manual. The terms are listed in alphabetical order. Many terms are defined in the text of the 
manual, so if you do not find a term here, check the index to see if you can locate it in the 
manual.

align-by-size curve Curve created by the GeneScan® Analysis Software for aligning data by size. The 
software calculates a best-fit, least-squares curve for all samples. This is a third-order curve when 
you use the Third Order Least Squares size calling method; for all other size calling methods it is a 
second-order curve. This curve is black in the Standard Sizing Curve window, although when the 
sizing curve and this curve match, they overlap so you see only the sizing curve. See also “size 
calling curve,” and “size standard spline interpolation curve.”

analysis parameters Options that specify certain ranges and methods used during analysis using the 
GeneScan Analysis Software. The software has default analysis parameters that are stored in the 
project itself. These parameters apply globally, unless you create your own parameters files for use 
with specific protocols. See “Defining Analysis Parameters” on page 5-18.

baselining Adjusting the baselines of detected dye colors to the same level for a better comparison of 
relative signal intensity.

channels (ABI™ 373 and ABI PRISM® 377 instruments) Theoretical divisions across the read region of a 
gel where the Data Collection software software samples the data. The number of wells in the 
loading comb used determines the approximate number of channels assigned per lane of the gel (for 
instance, with a 36-well comb, one lane is approximately five channels). When the GeneScan 
Analysis Software tracks a gel, it places the tracker line for each lane in the channel showing the 
strongest fluorescent signal. The data from that channel and the adjacent channels on each side are 
averaged to determine the raw data for the Sample file. You set the number of channels to be 
averaged in the Gel Processing Parameters.

data point The ABI 373 and ABI PRISM 377 Data Collection software samples data 194 times as it 
scans across the gel (194 or 388 times for the XL upgrades). The ABI PRISM® 310 Data Collection 
software samples data as it passes by the detector. Each “sampling” is stored as a data point. In 
ABI 373 and ABI PRISM 377 data, the scan number describes the location of the data point.

dye/sample Individual sample labeled with a single dye within a Sample file. Sample files normally 
contain up to four dye/samples, depending on how many labeled samples you included in each lane 
or injection of your data collection run.
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dye color indicator Left color box in the Results Control window and the legend of the Results Display. 
In the Results Display, click this box to move the associated electropherogram to the front. In the 
Results Control and the Results Display windows, double-click this box to change the dye scale, or 
�–double-click it to reset the dye scale to the default.

electropherogram Four-color picture of a sequence, showing peaks that represent the bases. The 
term is used interchangeably with chromatogram in this manual.

grid Spreadsheet-like display used for entering data in tabular format. The Analysis Control and 
Results Control windows display grids for entering sample information.

internal size standard Also called internal lane or injection size standard, DNA fragment of known size 
that you include with your run. On the ABI 373 or ABI PRISM 377, you include the size standard with 
the samples in each lane. On the ABI PRISM 310 you include the size standard with each injection.

Running an internal lane standard results in particularly accurate and precise molecular length 
determination because the internal lane standard and the unknown fragments undergo exactly the 
same electrophoretic forces. The software can then compensate for band-shift artifacts caused by 
variations in the gel and in the run. See “About Size Standards” on page 5-29 and “Using Size 
Standards” on page 5-36.

legend Informational text that appears beneath electropherogram panels in the results displays. You 
can show or hide legends (see “Using Legends to Change the Display” on page 7-30), and you can 
use the color boxes displayed in them to bring specified electropherograms to the front of the panel 
(“Moving the Electropherogram” on page 7-28) or customize the colors (“How to Define Custom 
Colors” on page 7-40).

matrix file/multicomponent matrix File used to adjust for the spectral overlap between the fluorescent 
dyes used on the ABI PRISM® instruments. A mathematical matrix of the spectral overlaps is created 
and the inverse matrix is used to correct the data during analysis. Matrix files are stored in the ABI 
folder inside the Macintosh® computer System folder, or in the matrix folder in the GeneScan 
Analysis Software folder. The values of the matrix are stored in the gel file (ABI 373 and 
ABI PRISM 377) and in the Sample files.

For more information, see Chapter 6, “Making a Matrix File.”

module A file that provides instructions about conditions of operation to the ABI PRISM genetic analysis 
instrument. Refer to your instrument manual.

multicomponenting Adjusting for spectral overlap of the fluorescent dyes.

overlaid Displayed together so they overlap. In the GeneScan Analysis Software Results Display 
window, all electropherograms in a single panel are overlaid. You can bring a specific one to the front 
by clicking the color box that represents it in the legend (See “Using Legends to Change the Display” 
on page 7-30).

plot color indicator Right color box in the Results Control window and the legend of the Results Display. 
In the Results Display window, click this box to move the associated electropherogram to the front. In 
the Results Control and the Results Display windows, double-click this box to change the plot color, 
or �–double-click it to reset the plot color to the default.
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preferences Defaults you can set so that certain parameters are automatically applied when you are 
working with a project. The GeneScan Analysis Software remembers preferences and applies them 
globally to all new projects. 

For a brief description of each preference you can set, see “Changing How the Results are 
Displayed and Printed” on page 7-13.

project File containing links to a set of Sample files that you want to analyze and display together. A 
project can contain Sample files from multiple runs. Adding a Sample file to a project creates a 
reference to the file. It does not copy the file into the project. 

For more information, see “Using a Project to Manage Sample Files” on page 4-8.

project options Formatting information you can set for the current project. Project options are 
remembered by the project when you open it again. 

For a brief description of each project option, see “Changing How the Results are Displayed and 
Printed” on page 7-13.

sample files Computer files that contain raw and analyzed data. Sample files are created directly by the 
ABI PRISM 310 and by the GeneScan Analysis Software for the ABI 373 and ABI PRISM 377. Sample 
files contain data such as peak locations, size calling values, and a record of analysis settings. 

scan number (ABI 373 and ABI PRISM 377 instruments) Data Collection software samples data 194 
times (194 or 388 times for XL instruments) as it scans across the gel. Each “sampling” is stored as 
a data point. The scan number describes the location of the data point.

separation distance Length from the wells of the gel to the read region of the gel. Also called the “WTR 
(well-to-read).”

shark’s-tooth comb Piece of mylar inserted into a gel, typically used for a sequencing run. The flat edge 
of the comb is used to form a well during gel polymerization. The toothed edge is inserted to form 
wells into which samples are loaded. For GeneScan Analysis Software applications, a square-tooth 
comb is recommended to lessen the chance of sample spillage from lane to lane.

size calling curve Curve created by the GeneScan Analysis Software for size calling. The software 
calculates this curve based on the size calling method you specify for data analysis. This curve is red 
in the Standard Sizing Curve window. When it matches the align-by-size curve, the two overlap so 
you see only this curve. See also “align-by-size curve” and “size standard spline interpolation curve.”

size standard Specific DNA fragments of known sizes. After you define the peaks of a size standard, the 
GeneScan Analysis Software matches this definition to the internal lane or injection standard that 
you include with your run. The software assigns the defined size values to the appropriate peaks of 
the internal lane or injection standard, and uses this information with the selected size calling 
method to size all unknown fragments. 

For more information, see “About Size Standards” on page 5-29 and “Using Size Standards” on 
page 5-36.
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size standard spline interpolation curve Curve created by the GeneScan Analysis Software for aligning 
data by size. The software creates this curve if you use the Local Southern or Cubic Spline 
Interpolation size calling method and the size standard data does not match the best-fit curve, which 
is normally used for aligning the data by size. This curve is blue in the Sizing Curve window. See 
also “align-by-size curve” and “size calling curve.”

square-tooth comb Piece of mylar inserted into a gel to form wells for sample loading. You remove a 
square-tooth comb prior to sample loading. For GeneScan Analysis Software applications, a 
square-tooth comb is recommended to minimize the chance of lane-to-lane leakage, which can 
occur more often with a shark’s-tooth comb.

tiled Displayed so they do not overlap. The GeneScan Analysis Software displays tiled 
electropherogram panels in the Results Display. If you display more than one electropherogram in 
each panel, all electropherograms in the panel are overlaid.

tracker line Marks the channel exhibiting the strongest fluorescent signal in a lane. For each lane, the 
raw data extracted for the sample file is an average of the data in several channels. You set the 
number of channels averaged in the Gel Processing Parameters.

WTR (well-to-read)  Length from the wells of the gel to the read region of the gel. See also “separation 
distance.” 
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Index

A
ABI 373

automatic analysis diagram 4-3
Collection file, opening A-7 to A-8
gel processing parameters, setting A-5 to 

A-6
generating sample files

procedure 6-27 to 6-28
when to generate new files A-12

how GeneScan works with 1-5
loading and running dye standards 6-20 to 

6-23
matrix standards, preparing 6-12
processing using ABI 373 A-2 to A-4
sample sheet, completing A-9 to A-10
tracking lanes A-11

ABI 373 (XL), loading and running dye 
standards 6-24 to 6-26

ABI folder, files installed in 6-6
ABI PRISM 310

automatic analysis diagram 4-2
automatically printing run results 9-3
loading and running dye standards 6-13 to 

6-16
matrix standards, preparing 6-9 to 6-11

ABI PRISM 377
automatic analysis diagram 4-3
automatically printing run results 9-3
generating sample files 6-27 to 6-28
loading and running dye standards 6-17 to 

6-19
matrix standards, preparing 6-12

Analysis Control window
using to analyze project files 5-2 to 5-5
using to analyze sample file 5-6 to 5-16

Analysis Log, using 7-51 to 7-52
analysis parameters

about 5-17 to 5-23
defined Glossary-1
using 5-24 to 5-28

analysis results
changing how displayed and printed 7-13 to 

7-15
Results Display window

about 7-4 to 7-6
using 7-7 to 7-12

steps to evaluating
evaluating results 7-2

updating the results 7-16
using the Analysis Log 7-51 to 7-52
ways to display 7-3
See Also Sample Results View

analyzing
project files 5-2 to 5-5
sample files 5-6 to 5-16

archiving 8-6
automatic analysis, setting up 4-4 to 4-7

B
band-shift artifacts, compensating 

for Glossary-2
baselining defined Glossary-1
BioLIMS

about server names E-17 to E-19
accessing the database E-13 to E-16
configuring the server E-4 to E-9
GeneScan and BioLIMS, about E-2 to E-3
switching between Sample file and BioLIMS 

mode E-10 to E-11
testing network connection

using tool E-12
troubleshooting

client to Oracle connection F-14 to F-24
client to Sybase connection F-3 to F-13
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GeneScan crashes with BioLIMS D-9
if BioLIMS Preference page does not 

appear F-2
using the BioLIMS Chooser E-20 to E-30

C
channels defined Glossary-1
colors

assigning to electropherograms 7-39
defining in electropherograms 7-40 to 7-43

computer, using the Macintosh 1-7 to 1-10
configuring the BioLIMS server E-4 to E-9
copying data to other applications 8-7 to 8-8
crashes, GeneScan crashes with BioLIMS D-9
Cubic Spline method C-4
customer support

e-mail address 1-24
help 1-20 to 1-26
internet address 1-20
regional sales offices 1-24 to 1-26
telephone/fax (U.S) 1-20

D
Data Collection software

automatically printing results from 9-3
Gel File window, how differs from GeneScan 

Gel File window 2-12
data point defined Glossary-1
Deionizing formamide, procedure 6-9
Documents on Demand 1-23
dye color, changing in electropherograms 7-28
Dye Matrix Standards kits 6-8
dye scale, changing 7-44 to 7-45

E
electropherograms

about 7-20 to 7-21
changing dye scale 7-44 to 7-45
defining custom colors 7-40 to 7-43
displaying electropherogram data 7-25 to 

7-26
displaying electropherograms and tabular 

data 7-22 to 7-24
using to verify peak detection 7-53
using to verify results 7-46 to 7-47
verifying size calculations 7-48 to 7-50

working with electropherogram data 7-27 to 
7-39

assigning standard colors 7-39
changing horizontal scale 7-37
changing the dye color 7-28
changing vertical scale 7-38 to 7-39

for all electropherograms 7-38
for single electropherograms 7-39

displaying peak positions 7-29
displaying x-and y-axis positions 7-27
highlighting peaks 7-29
making active window 7-28
scrolling the display 7-30
showing data by fragment size 7-35 to 

7-36
about 7-35
procedure 7-36

showing off-scale data 7-32
using legends to change the 

display 7-30
zooming in and out 7-31

e-mail, address for technical support 1-24
EPT Data View 3-17 to 3-18

displaying the view 3-17
example 3-18
what it displays 3-17

error messages D-9 to D-12
extracting data, and tracking 2-59 to 2-66

extracting without changing tracking 2-64 to 
2-66

saving after tracking 2-68
specifying Run folder 2-59
tracking and extracting 2-61 to 2-63
tracking without extracting 2-60 to 2-61
ways to track and extract 2-59

F
files, software files, table of 1-16 to 1-18
folders

ABI folder, files installed in 6-6
defining locations 5-41 to 5-43

formamide
how to deionize, procedure 6-9
size standard mix, preparing 6-10



Index-3

G
Gel File window

diagram 2-13
optimizing tracker lines 2-54
window callouts

call outs described 2-15 to 2-17
window buttons 2-14 to 2-15

gel files
about the gel files 2-2
archiving 8-6
displaying the gel file 2-11
Gel File window

diagram 2-13
differences between windows 2-12
window callouts

call outs described 2-15 to 2-17
window buttons 2-14 to 2-15

gel image, adjusting 2-18 to 2-25
adjusting the contrast 2-20 to 2-22
changing dye indicators 2-19 to 2-20
displaying/hiding a dye color 2-18
displaying/hiding dye color 2-18
installing new matrix file 2-24 to 2-25
regenerating the gel image 2-23 to 2-24
removing contrast changes 2-22

Gel Processing preferences, setting 2-3 to 
2-10

Auto-Launch processing 2-4
comb type 2-10
displaying the Gel preferences 2-3
Image Generation Defaults 2-4 to 2-6
lane extraction 2-7 to 2-10

interpolating data 2-57 to 2-58
lane markers, working with 2-43 to 2-52
off-scale data, displaying 2-38 to 2-41
sample sheet, about 2-29 to 2-37
saving

after editing tracking 2-68
procedure 8-4

tracker lines, working with 2-53 to 2-56
tracking and extracting data 2-59 to 2-66

extracting without changing 
tracking 2-64 to 2-66

saving after tracking 2-68
specifying Run folder 2-59
tracking and extracting 2-61 to 2-63
tracking without extracting 2-60 to 2-61

ways to track and extract 2-59
troubleshooting gel data D-5 to D-6
verifying gel information 2-26 to 2-28
why save 8-2

gel image
adjusting 2-18 to 2-25

adjusting the contrast 2-20 to 2-22
changing dye indicators 2-19 to 2-20
displaying/hiding a dye color 2-18
displaying/hiding gel color 2-18
regenerating the gel image 2-23 to 2-24
removing contrast changes 2-22

printing 9-4
GeneScan

about this manual 1-5 to 1-6
archiving 8-6
copying, data to other applications 8-7 to 

8-8
crashes with BioLIMS D-9
license and warranty G-1 to G-3
preparing matrix standard samples 6-10
registering 1-11
saving

gel files 8-4
projects 8-3
Results Displays 8-5
sample files 8-3
why save 8-2

size standard
GeneScan 1000 B-8 to B-9
GeneScan 2500 B-10 to B-11
GeneScan 350 B-2 to B-3
GeneScan 400HD B-4 to B-5
GeneScan 500 B-6 to B-7

software files, table of 1-16 to 1-18
what new in this release 1-2 to 1-3

GeneScan 100 standard B-8 to B-9
GeneScan 2500 standard B-10 to B-11
GeneScan 350 size standard B-2 to B-3
GeneScan 500 size standard B-6 to B-7
GeneScan-400 HD size standard B-4 to B-5
Genotyper

copying GeneScan data to 8-7
troubleshooting software results D-8

Global Southern method C-7 to C-8
glossary Glossary-1 to Glossary-4
grid defined Glossary-2
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H
help

e-mail address 1-24
internet address 1-20
regional sales offices 1-24 to 1-26
telephone hours 1-20
telephone/fax (U.S.) 1-20

horizontal scale, changing in 
electropherograms 7-37

I
IMPORTANT, definition 1-6
installing 1-12 to 1-15

folder contents 1-15
procedure 1-14
program files installed, diagram 1-15
RAM required 1-14
system specifications 1-12

instrument, manual text related to 1-5
internal size standard

compensating for band-shift 
artifacts Glossary-2

defined Glossary-2
internet address

Applied Biosystems 1-20
Documents -on-Demand 1-23

interpolating data 2-57 to 2-58

L
lane markers, working with 2-43 to 2-52
Least Square size calling method C-2 to C-3
legends

defined Glossary-2
using to change display in 

electropherograms 7-30
license and warranty G-1 to G-3
Local Southern method C-5 to C-6

M
Macintosh, using the computer 1-7 to 1-10
manual, text for specific instruments 1-5
matrix files

about 6-2 to 6-6
assigning to sample files 6-35 to 6-36
bad matrix files, causes 6-38 to 6-39
choosing a scan range 6-29 to 6-31

defined Glossary-2
Dye Matrix Standard kits 6-8
evaluating the matrix file 6-37
generating files (ABI 373 and ABI PRISM 

377) 6-27 to 6-28
installing new file

gel file 2-24 to 2-25
sample file 3-20

loading and running dye standards
ABI 373 6-20 to 6-23
ABI 373 (XL) 6-24 to 6-26
ABI PRISM 310 6-13 to 6-16
ABI PRISM 377 6-17 to 6-19

new matrix file, generating 6-32 to 6-33
preparing matrix standards

ABI PRISM 310 6-9 to 6-11
ABI Prism 377 and ABI 373 6-12

process of creating new file 6-7 to 6-8
saving and naming 6-34

matrix standards, preparing standard samples
GeneScan 6-10

module defined Glossary-2
multicomponent matrix defined Glossary-2
multicomponenting defined Glossary-2

N
network, using SybPing program E-12
note, definition 1-6

O
off-scale data

showing in electropherograms 7-32
showing in gel files 2-38 to 2-41

optimizing tracker lines 2-54
Oracle server

configuring the server E-4 to E-9
how server names are recognized E-17 to 

E-19
troubleshooting connection F-14 to F-24

overlaid defined Glossary-2

P
PCR Single-stranded Conformation 

Polymorphism (SSCP)
Minimum Peak Half width setting 5-21

peak detection, verifying 7-53
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peak positions, displaying in 
electropherograms 7-29

peaks, highlighting in electropherograms 7-29
preferences, defined Glossary-3
printing

about printing 9-2
automatically printing run results 9-3
gel image 9-4
sample files 9-5 to 9-6
supporting information 9-6

program files, installed (diagram) 1-15
project options, defined Glossary-3
projects

analyzing project files 5-2 to 5-5
creating

finding missing sample files 4-14 to 
4-15

process diagrams 4-2 to 4-3
using ABI 373 and ABI PRISM 

377 4-3
using the ABI PRISM 310 4-2

using to manage sample files 4-8 to 4-9
working with 4-10 to 4-13

creating a new project 4-10 to 4-12
opening an existing project 4-10
removing samples from a 

project 4-13
defined Glossary-3
defining folder locations 5-41 to 5-43
saving, procedure 8-3
troubleshooting D-2 to D-4
why save 8-2

R
RAM required 1-14
Raw Data View 3-15 to 3-16

displaying the view 3-15
example 3-16
what it displays 3-15
what to evaluate 3-16

registering the software 1-11
restarting Macintosh, key commands for E-12
Results Control window

saving and renaming 7-17 to 7-19
important considerations 7-17
renaming current display 7-19
saving the format 7-17

using previously saved formats 7-18
working with previously saved displays 7-18

Results Display window
about 7-4 to 7-6
using 7-7 to 7-12

Results Displays
saving, procedure 8-5
why save 8-2

S
Sample File window

about 3-5
EPT Data View 3-17 to 3-18

displaying the view 3-17
example 3-18
what it displays 3-17

Raw Data View 3-15 to 3-16
displaying the view 3-15
example 3-16
what it displays 3-15
what to evaluate 3-16

Sample Info View 3-8 to 3-12
description of view 3-9 to 3-12
displaying the view 3-8
example 3-9
what it displays 3-8

Sample Results View 3-6 to 3-7
description of view 3-7
differences from Results Display 3-7
displaying the view 3-6
example 3-6
what it displays 3-6

Size Curve View 3-13 to 3-14
displaying the view 3-13
size curve described 3-14
what is the size curve 3-13
what the size curve displays 3-14

sample files
about 3-2 to 3-3

how GeneScan analyzes sample 
files 3-3

how they are generated 3-2
ways to generate sample files 3-3
what sample files contain 3-2

analyzing 3-19 to 3-20
installing new matrix file 3-20
procedure 3-19 to 3-20
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using Analysis Control window 5-6 to 
5-16

archiving 8-6
defined Glossary-3
finding missing sample files 4-14 to 4-15
how GeneScan names files 2-67
matrix file, assigning to sample files 6-35 to 

6-36
opening, procedure 3-4
printing 9-5 to 9-6
removing from a project 4-13
Sample File window

about 3-5
EPT Data view 3-17 to 3-18
Raw Data View 3-15 to 3-16
Sample Info View 3-8 to 3-12
Sample Results View 3-6 to 3-7
Size Curve View 3-13 to 3-14

saving, procedure 8-3
switching between Sample file and BioLIMS 

mode E-10 to E-11
unlocking sample files 4-12
using project to manage files 4-8 to 4-9
why save 8-2

Sample Info View 3-8 to 3-12
description of view 3-9 to 3-12
displaying the view 3-8
example 3-9
what it displays 3-8

Sample Results View 3-6 to 3-7
description of view 3-7
differences from Results Display 3-7
displaying the view 3-6
example 3-6
what it displays 3-6

sample sheet
about 2-29 to 2-37
completing for the ABI 373 A-9 to A-10

saving
after tracking 2-68
gel files 8-4
matrix file 6-34
projects 8-3
Results Control format 7-17 to 7-19

important considerations 7-17
renaming current display 7-19
renaming current Results Display 7-19

saving 7-17
saving the format 7-17
using previously saved formats 7-18
working with previously saved 

displays 7-18
Results Displays 8-5
sample files 8-3
why save 8-2

scan numbers, defined Glossary-3
separation distance, defined Glossary-3
server names, about E-17 to E-19
sharks-tooth comb, defined Glossary-3
size calling methods

Cubic Spine method C-4
Global Southern method C-7 to C-8
Least Square method C-2 to C-3
Local Southern method C-5 to C-6

Size Curve View 3-13 to 3-14
displaying the view 3-13
size curve described 3-14
what is the size curve 3-13
what the size curve displays 3-14

size standard
about 5-29 to 5-30
defining, how to 5-31 to 5-35
GeneScan 1000 B-8 to B-9
GeneScan 2500 B-10 to B-11
GeneScan 350 B-2 to B-3
GeneScan 400HD B-4 to B-5
GeneScan 500 B-6 to B-7
using 5-36 to 5-40

Slice view, how to determine the scale of the 
peaks in view 2-6

software
files, table of 1-16 to 1-18
license G-1 to G-3
registering 1-11

SSCP, Minimum Peak Half width setting 5-21
Sybase SQL server

configuring the BioLIMS server E-4 to E-9
how server names are recognized E-17 to 

E-19
troubleshooting connection F-3 to F-13

SybPing, using E-12
system specifications 1-12
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T
tabular data displays

about 7-20 to 7-21
displaying electropherogram and tabular 

data 7-22 to 7-24
using to verify peak detection 7-53
using to verify results 7-46 to 7-47

technical support 1-20 to 1-26
e-mail address 1-24
internet address 1-20
regional sales offices 1-24 to 1-26
telephone/fax (U.S.) 1-20

text in manual, noted for specific 
instruments 1-5

tracking, and extracting data
extracting without changing tracking 2-64 to 

2-66
saving after tracking 2-68
specifying Run folder 2-59
tracker lines

defined Glossary-4
working with 2-53 to 2-56

tracking and extracting 2-61 to 2-63
tracking without extracting 2-60 to 2-61
ways to track and extract 2-59

troubleshooting
bad matrix files, causes 6-38 to 6-39
BioLIMS

client to Oracle connection F-14 to F-24
client to Sybase connection F-3 to F-13
GeneScan crashes with BioLIMS D-9
if BioLIMS Preference page does not 

appear F-2
error messages D-9 to D-12
gel data D-5 to D-6
Genotyping software results D-8
projects and results D-2 to D-4

U
unlocking sample files 4-12

V
vertical scale, changing 7-38 to 7-39

for all electropherograms 7-38
for single electropherograms 7-39

viewing scale, changing for 
electropherograms 7-31

W
warranty G-1 to G-3
well-to-read (WTR), defined Glossary-4
www address

Documents-on-Demand 1-23
Applied Biosystems 1-20

X
x-axis positions, displaying in 

electropherograms 7-27

Y
y-axis positions, displaying in 

electropherograms 7-27

Z
zooming, electropherograms 7-31







Worldwide Sales Offices
Applied Biosystems vast distribution and 
service network, composed of highly trained 
support and applications personnel, reaches 
into 150 countries on six continents. For 
international office locations, please call our 
local office or refer to our web site at 
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Phone: +1 650.638.5800
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